
 (Windows 2000/NT/XP/Vista)
Closed Captioning/Subtitling Software

[Includes patented [#6,895,166] software engine}

CaptionMaker-Live, WebPlus, Classic, DV, NLE & HD
The complete closed captioning and subtitling

preparation & encoding software

CaptionMaker Encoder-DV, Classic, NLE, DTV & HD
The closed captioning and subtitling encoding software

User’s Guide
Version 5

July 2009

CaptionMaker does the entire captioning and subtitling processes, from text entry, 
positioning and time coding to encoding DV, NLE, MPEG-2, HD and video residing on 
the hard drive without using a closed caption encoder.
This manual covers all features of all versions of CaptionMaker. Please check the feature 
comparison chart for the features available in the version you are licensed to use. You can 
always upgrade your software to a higher version by paying the difference in the price of 
the software you are licensed to and the price of the software you like to upgrade to. 

Computer Prompting & Captioning Co.
The Industry Leader Since 1985

1010 Rockville Pike, Suite 306 info@cpcweb.com voice (301) 738-8487 
Rockville, MD 20852 www.cpcweb.com fax (301) 738-8488 
USA TTY (301) 738-8489



Overview

Information in this document is subject to change without notice. Copyrighted names 
used herein are the property of their respective owners. No part of this document may be 
reproduced or transmitted in any form or by any means for any purpose, without the 
express written consent of CPC.

Copyright ©1985-2009 by CPC.

CaptionMaker® is a registered trademark of CPC.

2



Overview

Table of Contents
Table of Contents
OVERVIEW.....................................................................................................................16

CAPABILITIES AT A GLANCE.................................................................................................16
VIDEO TUTORIALS AND SUPPORT .........................................................................................16

Knowledge base documents, Updates and Upgrades................................................16
WEBEX TRAINING.............................................................................................................17

Telephone Support Contract .....................................................................................17
ONE PRICE - BOTH PLATFORMS (MAC AND WIN)..................................................................17
CAPTIONMAKER SOFTWARE - MANY FLAVORS   ...................................................................17
CAPTIONING PROCESS AT A GLANCE.....................................................................................20
CAPTIONING DIGITAL VIDEOS .............................................................................................20

Captioning DV Video................................................................................................20
Captioning MPEG-2 (SD & DVD) Video ................................................................21
Captioning MPEG-2 (HD) Video .............................................................................21
Captioning NLE Video..............................................................................................21
Captioning Webcasts.................................................................................................22

SUBTITLING DIGITAL VIDEOS ..............................................................................................22
Adding Subtitles to DV..............................................................................................22
Adding Subtitles to DVD...........................................................................................22
Adding Subtitles to 720x486 NLE Video..................................................................22
Adding Subtitles to DV-2000 and DV-3000.............................................................22
Adding Subtitles to Digital Video..............................................................................22
Feature Comparison...................................................................................................23

HOW CAPTIONMAKER WORKS............................................................................................24
Formatting the Text....................................................................................................25
Generating Captions...................................................................................................25

CaptionMaker-Live ...............................................................................................25
CaptionMaker-Classic ...........................................................................................25
CaptionMaker-Classic Encoder ............................................................................26
DVD Captioning and Subtitling.............................................................................26
Webcast Captioning...............................................................................................26

Captioning a DV Video.............................................................................................26
Captioning a Video with NLE...................................................................................27
Captioning a SD and HD Mpeg-2 Video...................................................................27

CHAPTER 1
HARDWARE INSTALLATION....................................................................................28

SYSTEM REQUIREMENTS......................................................................................................28
Computer....................................................................................................................28

CPC PROTECTION KEY (KEY) ...........................................................................................28
COMPATIBLE DV DECKS & NLE SYSTEMS..........................................................................29

3



Overview

CaptionMaker-DV.....................................................................................................29
CaptionMaker-NLE ..................................................................................................31

NLE Hardware ......................................................................................................32
NLE Compatibility Check 2..............................................................................33

NLE Systems Not Listed Above............................................................................33

CHAPTER 2
SOFTWARE INSTALLATION ....................................................................................35

INSTALLING THE SOFTWARE.................................................................................................35
UPGRADING CPC SOFTWARE..............................................................................................35
COMPUTER SCREEN RESOLUTION..........................................................................................36
TIME CODE READER...........................................................................................................37
VIDEO CAPTURE DEVICE.....................................................................................................37
CAPTION/SUBTITLE DEVICE.................................................................................................37
DVD/DV2000 SUBTITLING DEVICE...................................................................................38
MAGNICODER PRO.............................................................................................................38
CHOOSING KEYBOARDS.......................................................................................................38

Multiple Keystroke Method.......................................................................................38
Character Map Method..............................................................................................41
Single Keystroke Method..........................................................................................41
Available Subtitling and Captioning Characters .......................................................41

CHAPTER 3
 IMPORTING AND EXPORTING FILES...................................................................42

IMPORT/EXPORT CAPABILITIES.............................................................................................42
Word Processor Group...............................................................................................43
ASCII Text Files (Tab Delimited).............................................................................44

Text Only (Must Be Separated by Tab) ................................................................44
Time Code In and Text (Must Be Separated by Tab) ...........................................44
Time Code In, Out and Text (Must Be Separated by Tab) ...................................45

Caption Center Files (*.tds).......................................................................................46
Captions, Inc. Files (*.cin).........................................................................................47
Cheetah Caption Files (*.asc)....................................................................................48
Softni Files (*.sub).....................................................................................................49
CPC-600/CPC-700 DOS Files...................................................................................49
CPC-715 DOS Online Files.......................................................................................50
DVD Caption Files....................................................................................................50
Power Pixel Format Files...........................................................................................51
Windows CaptionMaker File ....................................................................................51

IMPORT/EXPORT TO MERGE FILES FOR SUBTITLING/CAPTIONING A VIDEO IN A 2ND LANGUAGE....52
Step I......................................................................................................................53
Step II.....................................................................................................................53
Step III...................................................................................................................54
Step IV...................................................................................................................54
Step V.....................................................................................................................55

INSTRUCTIONS TO THE TRANSLATOR .....................................................................................55

4



Overview

How to Translate CPC Subtitle/Caption Files into 
Another Language......................................................................................................55

General Guidelines.................................................................................................57

CHAPTER 4
CAPTION/SUBTITLE PREPARATION......................................................................59

NOTE TO SUBTITLING USERS................................................................................................59
SCREEN LAYOUT................................................................................................................59

Visible Columns.........................................................................................................59
Computer Display Screen Resolution........................................................................60

FULL VIEW OR VIEW WITH PREVIEW WINDOW.......................................................................60
THE CAPTIONING PROCESS..................................................................................................61

Video Tutorials..........................................................................................................61
Caption Display Modes..............................................................................................62
Transcribing Digital Video .......................................................................................62

Transcribe using VPedal with Windows Media Player.........................................63
Configuring vPedal Media Player Plug-In.........................................................63
Transcribing in your Word Processor................................................................64
QuickTime, RealOne Videos.............................................................................64

Playing Video.............................................................................................................64
Reading Timcode.......................................................................................................64

ROLL-UP CAPTIONING NOT USING TIME CODE.....................................................................65
Method I: Manual Captioning....................................................................................65
Transcribing the video...............................................................................................65
Notes on Roll-Up Captioning....................................................................................70

POP-ON, PAINT-ON AND BLOCK-ROLL-UP CAPTIONING..........................................................72
Method II: Manual Captioning..................................................................................72
Method III: AutoSync Captioning with Time Code..................................................72
Method IV: AutoSync Captioning with PC System Timer.......................................72

STEP 1: TRANSCRIBING AND IMPORTING SCRIPT......................................................................73
Import Dialog Box.....................................................................................................73
The Demo.txt File......................................................................................................75
The Demo1.cap File...................................................................................................75

STEP 2: REFINING TEXT INTO CAPTIONS...............................................................................77
General Guidelines.....................................................................................................77
Operations Center: Row Operations..........................................................................77

   Insert Row...........................................................................................................77
   Delete Row..........................................................................................................78
   Merge Cells.........................................................................................................78
   Split Cell.............................................................................................................78
Highlighting Multiple Rows and Cells .................................................................78

Work Area Icons........................................................................................................79
    Pull First Word (U)............................................................................................79
    Push Last Word (D)...........................................................................................79
 Compress Text (C)................................................................................................80
   Expand Text (E)..................................................................................................80

5



Overview

   Alternate Break (A).............................................................................................81
Working with the File Demo1.cap:............................................................................81
The Demo2.cap File...................................................................................................82

STEP 3: CAPTION POSITION AND ATTRIBUTES.........................................................................83
Positioning of Captions on the Screen.......................................................................83

       Justification ....................................................................................................84
Vertical Position:...................................................................................................85
Attributes: Choosing Italics, Underline and Color................................................85

Working with Demo2.cap..........................................................................................86
Lines 1-3: Left Position.........................................................................................86
Lines 4 and 5: Right Position.................................................................................86
Lines 6-8: Italics ...................................................................................................87
Lines 9-11: Top Positioning ..................................................................................87
Lines 12-13: No Need to Do Anything..................................................................87
Lines 14-16: Paint-On Mode ................................................................................88

Lines 17-22: Roll-Up Mode...............................................................................88
Lines 23 and 24: No Need to Do Anything.......................................................89
Lines 25 to the End: Multiple Captions on the Same Screen............................89

The Demo3.cap File...................................................................................................89
Clearing Captions.......................................................................................................90

STEP 4: MANUAL CAPTIONING WITH AND 
WITHOUT TIME STAMPS......................................................................................................91

Step 4a: Manual Captioning ......................................................................................91
Step 4b: Captioning with Time Code Reader ...........................................................92

Step-by-Step Procedure to Capture Time Codes...................................................93
Correcting Time Code Mistakes............................................................................93

Step 4c: Captioning with PC System Timer .............................................................94
Step-by-Step Procedure to Capture PC System Time............................................95
Correcting Time Code Mistakes............................................................................96

STEP 5: AUTOSYNC CAPTIONING WITH TIME STAMP ..............................................................96
Step 5a: AutoSync Captioning with Time Code........................................................97
Step 5b: AutoSync Captioning with PC System Timer 
....................................................................................................................................97
Two Captions Appearing Simultaneously.................................................................98
Captioning Two Languages on the Same Video........................................................98

With ITV-Injector/DV-2000/DV-3000..................................................................98
With Other Encoders..............................................................................................99

Using one computer ..........................................................................................99
Using two computers.........................................................................................99

AutoSync Error Checking........................................................................................100
ERROR CHECKING ...........................................................................................................101

Final Checking.........................................................................................................101
Timing Errors Settings.............................................................................................101

FIND SHOT CHANGES........................................................................................................102
DIGITAL VIDEO: CAPTIONMAKER-DV, NLE & HD...........................................................102

Open Video File in CaptionMaker-DV, NLE & HD...............................................103

6



Overview

Digital Video Time Code.........................................................................................105
Video File Automatic Shuttling...............................................................................105

Drop Frame vs. Non-Drop Frame Time Code.....................................................106
Video File Time Code Offset...................................................................................106
Going Back to Videotape Format for Reference.....................................................106

Matching A/V Time Code to Videotape Time Code...........................................107
Drop Frame vs. Non-Drop Frame........................................................................108

The Final Step .........................................................................................................108
Captioning a Videotape with Drop-Frame Time Code .......................................108
Captioning a Videotape with Non Drop-Frame Time Code................................108
Encoding Videotape Using a Time Code Reader and an Encoder......................108

Caption/Subtitle a DVD...........................................................................................109
Caption a Video Using an NLE System With CCaption.........................................109
Caption a Video Using an NLE System With CaptionMaker-NLE/HD.................110
Caption a Video for Webcast...................................................................................110

CAPTION TIPS .................................................................................................................110
Suggestions for Breaking Lines...............................................................................110

SUGGESTED STYLES AND CONVENTIONS ..............................................................................112

CHAPTER 5
SUBTITLING.................................................................................................................113

OVERVIEW......................................................................................................................113
SUBTITLING DEVICES........................................................................................................114
INTERNATIONAL LANGUAGES AND FONTS ............................................................................114
KEYBOARDS FOR INTERNATIONAL LANGUAGES......................................................................116
CHYRON CODI AND PC CODI CARD...................................................................................116
CODI AND PC-CODI.........................................................................................................118

Upload and Assign Subtitle Font Type....................................................................118
Codi Default Fonts...............................................................................................120
Choosing the Default Fonts.................................................................................120
Changing the Fonts..............................................................................................121
Selecting Colors...................................................................................................121

Specifying User-Defined Colors..............................................................................122
Changing the Default Output...............................................................................122

Chyron Codi Windows Font Create Software.........................................................122
DVD CAPTIONING AND SUBTITLING OVERVIEW...................................................................122

DVD Multiple Language Capability........................................................................123
Create a CPC Time-Stamped File First ..................................................................123

DVD CAPTIONING...........................................................................................................123
DVD SUBTITLING............................................................................................................124

Export DVD Subtitle Files.......................................................................................125
Choose DVD Subtitle Device..............................................................................125
Create a Time-Stamped File................................................................................126
Adobe Encore.......................................................................................................126

Export DVD Subtitle Text Files..............................................................................127
Export DVD Subtitle Picture Files..........................................................................129

Font Style and Size .............................................................................................129

7



Overview

Bold Text.............................................................................................................130
Color Adjustment ................................................................................................131
Margin Adjustment .............................................................................................132
Full Screen View..................................................................................................132
Export DVD Subtitle Picture File........................................................................132

Script Name.....................................................................................................133
Image Prefix.....................................................................................................133
Description.......................................................................................................133
Graphic File Size..............................................................................................133
Verify Subtitle Rendering................................................................................134
Final Step: Export the File...............................................................................135

Examples of Navigation (Text) Files.......................................................................135
Importing DVD files................................................................................................137

Foreign Language Subtitles.................................................................................138
Group 1 Languages..............................................................................................138
Group 2 Languages..............................................................................................138
Group 3 Languages..............................................................................................139
Group 4 Languages..............................................................................................139
Choosing the Right Script Font............................................................................139

DV2000/ITV-INJECTOR TUTORIAL...................................................................................141
Placing Subtitles on the Video.................................................................................141
Simultaneous Captioning and Subtitling.................................................................142

MAGNICODER PRO...........................................................................................................143
Installing MagniCoder Pro Software.......................................................................143
Setting Up MagniCoder Pro Software.....................................................................143
Running the CPC CaptionMaker Software..............................................................144

WEBCAST CAPTIONING AND SUBTITLING..............................................................................145
Captioning Realtime Webcasts................................................................................145
Captioning Video on Demand.................................................................................145
Captioning or Subtitling?.........................................................................................146
Creating a Time-Stamped File.................................................................................146

Windows Media Player .......................................................................................147
Windows Media Player – Embedded Text..........................................................147
Windows Media Player - ASX Format................................................................147
Windows Media Player – Html Format...............................................................147
Windows Media Player – Html Book Format.....................................................148

Additional Notes on Windows Media Player .................................................149
RealPlayer ...........................................................................................................150

Additional Notes on RealPlayer.......................................................................151
QuickTime...........................................................................................................152

Additional Notes on QuickTime .....................................................................153
Flash  Player.........................................................................................................153

Sample XML file.............................................................................................155

CHAPTER 6
CAPTION/SUBTITLE WITH 
CAPTIONMAKER-DV/NLE/HD................................................................................157

8



Overview

FULL BLOWN AND ENCODER FLAVORS OF CAPTIONMAKER.....................................................157
CAPTION/SUBTITLE DIGITAL VIDEO ON YOUR HARD DRIVE.......................................................158

Retrieve Captions.............................................................................................158
Encode Captions/Subtitles...............................................................................158
Print DV Video to Tape...................................................................................158
Capture DV Video...........................................................................................158

CAPTION ENCODING (NO GENERATION LOSS) ........................................................................159
DV Caption Encoding..............................................................................................159
Inserting Captions to a 720x480 DV25/DV50 Video..............................................159
Compatible DV Decks.............................................................................................160

Compatibility Check 1.........................................................................................161
Compatibility Check 2.........................................................................................161

INSERTING CAPTIONS TO MPEG2 FOR DVD.........................................................................162
INSERTING CAPTIONS TO MPEG2 (DTV/ATSC) ................................................................162

Mpeg2 Video Codecs...........................................................................................163
Non-Linear caption encoding..................................................................................163

Compatible NLE Systems....................................................................................163
Compatibility Check 1.........................................................................................165
Compatibility Check 2.........................................................................................165
NLE System Not Listed Above...........................................................................165

ADDING CLOSED CAPTIONS TO VIDEO USING AN NLE..........................................................166
Inserting captions to 720x486 video with an NLE System......................................167
Video Compressors..................................................................................................170
Compression Options...............................................................................................171
Adding closed captions using Avid ABVB hardware.............................................173
Adding Closed Captions using Avid Express Pro...................................................173
Adding closed captions using Avid Meridien hardware..........................................174
Adding closed captions using the Media 100..........................................................175
Adding closed captions using Pinnacle Systems  ...................................................175
Adding closed captions using Blackmagic DeckLink Extreme...............................176
Adding closed captions using AJA Io Hardware.....................................................176

RETRIEVE CAPTIONS..........................................................................................................177
ADDING SUBTITLES TO DIGITAL VIDEO..................................................................................177

Burning subtitles to a video file...............................................................................178
Subtitle quality vs. video dimensions......................................................................179
Time code restrictions..............................................................................................179

CHAPTER 7
LIVE CAPTIONING.....................................................................................................180

OVERVIEW......................................................................................................................180
Realtime Captioning Using a Steno Machine..........................................................180

Preparation and Fixes...........................................................................................180
Captioning at the Top of the Screen....................................................................181
Do Not Blame the Captioners for All Errors.......................................................181
The Ultimate Solution..........................................................................................181
Realtime Captioning and Steno Writing..............................................................181

Realtime Captioning Not Using a Steno Machine...................................................182

9



Overview

REALTIME CAPTIONING SETUP...........................................................................................182
Open Ancillary Toolbar...........................................................................................183
Invoke Full Screen Spreadsheet View.....................................................................183
Invoke Live Caption Mode......................................................................................183
Set the Desired Choices to Display Captions..........................................................183

Number of Lines in Roll-Up Mode......................................................................184
Caption Length.....................................................................................................184
Indentation...........................................................................................................184
Fast Indentation....................................................................................................184
Roll-Up One Blank Line......................................................................................184
Font Height… .....................................................................................................184
Send Option….....................................................................................................185

Line/Word Sending..........................................................................................185
Highlight Sent Live Caption Words/Lines......................................................185
Timer Settings..................................................................................................186

Vertical Position...................................................................................................186
Clear Caption.......................................................................................................187
Convert to uppercase............................................................................................187
Status Window.....................................................................................................187

Configure Encoder/Decoder....................................................................................187
Modem Setup ..........................................................................................................187
Install Software for Text Entry ...............................................................................187

REALTIME CAPTIONING USING A STENO MACHINE................................................................188
Live Captioning in Action.......................................................................................188
Assigning Shortcut Keys from the Steno Machine..................................................189
Live Mode Encoder Transparency...........................................................................189
Instantly Switching Between Realtime and Live Display Captioning.....................189

REALTIME CAPTIONING NOT USING A STENO MACHINE........................................................191
Budget Realtime Captioning with Speed Typing Software ....................................191
Budget Realtime Captioning with Speech Recognition Software...........................191

Languages supported...........................................................................................192
Realtime Captioning with Naturally Speaking....................................................192
Accuracy & delay................................................................................................192

CAPTIONING VIDEO FROM REMOTE LOCATION......................................................................193
Modem.............................................................................................................193
LAN and Internet.............................................................................................193

CHAPTER 8
MENUS...........................................................................................................................194

FILE MENU.....................................................................................................................194
New..........................................................................................................................194
Open/Save/Save As .................................................................................................194
Insert File.................................................................................................................194
Import/Export Files..................................................................................................194
Auto Save.................................................................................................................195
Merge Import ..........................................................................................................195
Merge Export...........................................................................................................195

10



Overview

Default File Folder...................................................................................................196
Print..........................................................................................................................196
Print Preview............................................................................................................196
Print Setup................................................................................................................196
Page Setup................................................................................................................196
Exit...........................................................................................................................196

EDIT MENU.....................................................................................................................197
Undo.........................................................................................................................197
Redo.........................................................................................................................197
Cut............................................................................................................................197
Copy.........................................................................................................................197
Paste.........................................................................................................................197

VIEW MENU....................................................................................................................197
Visible Columns.......................................................................................................197
Full Screen Spreadsheet...........................................................................................198
Pop-Up Preview Window........................................................................................198
Anchor Current Row................................................................................................198

Anchor in Edit mode............................................................................................198
Anchor on Send Caption/Subtitle........................................................................198
Anchor in AutoSync/AutoPreviewSync..............................................................198
Anchor in Live Mode...........................................................................................198

Main Toolbar...........................................................................................................199
Ancillary Toolbar.....................................................................................................199
VTR Toolbar............................................................................................................199
Status Bar.................................................................................................................199

ATTRIBUTE MENU............................................................................................................199
Display Mode...........................................................................................................199

Pop-On.................................................................................................................200
Paint-On...............................................................................................................200
Roll-Up................................................................................................................200
Block Roll-Up......................................................................................................200
Pass Through Captioning.....................................................................................200

Text Color................................................................................................................201
Background Color....................................................................................................201
Background Translucency.......................................................................................201
Background Type.....................................................................................................201
Bold/Flash  ..............................................................................................................201
Italic.........................................................................................................................201
Underline..................................................................................................................202
Position and Justification.........................................................................................202

Horizontal Justification........................................................................................202
Horizontal Position..............................................................................................202
Vertical Position...................................................................................................203
       Justification ..................................................................................................203

Insert Music Symbol................................................................................................203
FORMAT MENU................................................................................................................203

11



Overview

Select Row...............................................................................................................203
Insert Row(s) ...........................................................................................................204
Delete Row(s) .........................................................................................................204
Split Row(s).............................................................................................................204
Merge Rows.............................................................................................................204
Erase Blank Rows....................................................................................................204
Reformat Rows........................................................................................................204
Reformat Caption(s) to Roll-up...............................................................................205
Reformat Caption(s) to Pop-on................................................................................205
Square Up Text Block..............................................................................................205
Compress Text (C)...................................................................................................205
Expand Text (E) ......................................................................................................206
Alternate Break (A) .................................................................................................206
Upper/Lower Case...................................................................................................206
Pull First Word.........................................................................................................207
Push Last Word .......................................................................................................207

CAPTION.........................................................................................................................208
Send Lines................................................................................................................208
Clear Caption ..........................................................................................................208
AutoSync .................................................................................................................208
AutoPreviewSync ...................................................................................................209
AutoSync Error Checking........................................................................................209
Final Checking ........................................................................................................210
Timing Errors Settings.............................................................................................210
Preview Options.......................................................................................................210

Display Preview Image........................................................................................210
Highlight Rows During AutoSync.......................................................................210
Blinking AutoSync Status....................................................................................210
Preview Image Matches Line Sent......................................................................211

Live Caption.............................................................................................................211
Live Caption Properties ..........................................................................................212

Roll-Up Mode......................................................................................................212
Vertical Position: Top Caption............................................................................212
Vertical Position: Bottom Caption.......................................................................212
Caption Length.....................................................................................................212
Left Indentation ...................................................................................................212
Fast Indent............................................................................................................212
Roll Up 1 Line ....................................................................................................213
Send Options…....................................................................................................213

WebTV Crossover Link ..........................................................................................213
V-Chip Ratings .......................................................................................................213
Wink Trigger ...........................................................................................................213
Profiles.....................................................................................................................214
Device .....................................................................................................................214

Captioning Video On-Site....................................................................................214
Captioning Video from Remote Location............................................................214

12



Overview

Captioning Via LAN............................................................................................215
Caption Properties....................................................................................................216

Control Tab..........................................................................................................216
Channel/Field.......................................................................................................216
General Tab..........................................................................................................217
Color Tab.............................................................................................................217

Initialize Device ......................................................................................................217
Close Device............................................................................................................217
Set Caption Margins................................................................................................218
Retrieve Captions.....................................................................................................218
Dial Modem.............................................................................................................218
Hang up Modem......................................................................................................219

SUBTITLE........................................................................................................................219
Send Lines................................................................................................................220
Clear Subtitle ..........................................................................................................220
AutoSync .................................................................................................................220
AutoPreviewSync ...................................................................................................220
AutoSync Properties................................................................................................221

Display Preview Image........................................................................................221
Highlight Rows During AutoSync.......................................................................221
Blinking AutoSync Status....................................................................................221

Final Checking ........................................................................................................221
Device......................................................................................................................221
Initialize Device ......................................................................................................222
Subtitle Properties....................................................................................................222

General Tab..........................................................................................................222
Control Tab..........................................................................................................222
Fonts Tab.............................................................................................................222
Colors Tab............................................................................................................222

Set Codi Font...........................................................................................................223
TIME CODE.....................................................................................................................223

Start Time Code Reader ..........................................................................................223
Pause Time Code Reader.........................................................................................223
Time Code/Video Mode..........................................................................................223
Mark In Time Code..................................................................................................223
Auto Advance on Mark In ......................................................................................223
System Timer Start Time.........................................................................................224
Set System Timer to Start Time...............................................................................224
Blank Frames...........................................................................................................224
Ripple Time Code ...................................................................................................224
Convert Time Code .................................................................................................225
Stretch/Shrink Time Code........................................................................................226
Reading Speed.........................................................................................................226
Fill-In Time Code....................................................................................................227
Time Code Reader Properties..................................................................................228

Reader Tab...........................................................................................................228

13



Overview

Color Tab.............................................................................................................228
VTR CONTROL ..............................................................................................................229

Play..........................................................................................................................229
Stop..........................................................................................................................229
Pause........................................................................................................................229
Rewind.....................................................................................................................229
Fast Forward............................................................................................................229
Variable Fast Forward/Rewind................................................................................229
Properties.................................................................................................................230

DV MENU......................................................................................................................230
Encode Captions/Subtitles.......................................................................................230
Retrieve Captions.....................................................................................................230
Print DV Video to Tape...........................................................................................230
Capture DV Video...................................................................................................230

NLE MENU....................................................................................................................231
Encode Captions/Subtitles.......................................................................................231
Retrieve Captions.....................................................................................................231

HD MENU......................................................................................................................231
Encode Captions/Subtitles.......................................................................................231

TOOLS ...........................................................................................................................232
Spelling....................................................................................................................232

Not in Dictionary ................................................................................................232
Change ................................................................................................................232
Language..............................................................................................................232
Suggestions..........................................................................................................232

Automatic Match Text with Audio .........................................................................233
Find Shot Changes...................................................................................................233
Customize Key Strokes............................................................................................234

HELP..............................................................................................................................236
Help Topics..............................................................................................................236
About CaptionMaker ..............................................................................................236
Version Information ................................................................................................236
Upgrade License......................................................................................................236

CHAPTER 9
ICONS AND BUTTONS...............................................................................................237

MAIN TOOLBAR BUTTONS.................................................................................................237
 Full Screen Spreadsheet..........................................................................................237
 AutoSync.................................................................................................................237
 AutoPreviewSync...................................................................................................237
 Final Checking........................................................................................................238
 Customize Key Strokes ..........................................................................................238

ANCILLARY TOOLBAR BUTTONS.........................................................................................238
 Live Caption............................................................................................................238
 Roll-Up 1 Blank Line..............................................................................................238
 Indentation..............................................................................................................238

14



Overview

 Vertical Position - Top............................................................................................239
 Vertical Position - Bottom......................................................................................239
 Move Up 1 Line......................................................................................................239
 Move Down 1 Line.................................................................................................239

VTR TOOLBAR BUTTONS.................................................................................................239
OPERATIONS CENTER BUTTONS..........................................................................................239

    Image Font Button...............................................................................................240
Image Font Button General..................................................................................240
Character Kerning................................................................................................240
Character Scaling.................................................................................................240
Line Pixel Spacing...............................................................................................240
Space (Blank) Character Width...........................................................................241

    Image Colors........................................................................................................241
Video Preview Background.................................................................................241
Background Type ................................................................................................241
Default Caption/Subtitle Color............................................................................241

    Margins/Padding..................................................................................................241
    Pop-Up Preview Window....................................................................................241
    Video Control.......................................................................................................242
Edit/AutoSync/AutoPreviewSync/Live Mode.........................................................242

ROW OPERATIONS BUTTONS..............................................................................................242
    Insert Row(s)........................................................................................................242
     Delete Row(s).....................................................................................................242
    Split Row.............................................................................................................242
    Merge Rows.........................................................................................................242
    Select Row...........................................................................................................243

VTR CONTROL ..............................................................................................................243
Foot Pedal Controller...............................................................................................243

MISC CONTROL................................................................................................................243
TIME CODE BUTTONS.......................................................................................................244

 Time Code Display.................................................................................................244
 In and Out Buttons..................................................................................................244
   Mark Time Code on Send Caption.......................................................................244
   Time Code Properties...........................................................................................244

INDEX.............................................................................................................................245

15



Overview

O v e r v i e w

CaptionMaker  software  is  designed  to  run  on  an  IBM compatible  computer  running 
Windows 2000/NT/XP/Vista. 

Capabilities at a Glance
Post-Production (Off-line) Captioning using CPC's patented engine to caption videos 
directly on the hard drive without using traditional closed caption encoder. (DV, NLE, 
HD)
Traditional Post-Production (Off-line) Captioning using traditional closed caption 
encoder. (Classic)
DVD Post-Production (Off-line) Captioning & Subtitling (WebPlus)
Retrieve Caption Data from a Captioned Video 
Realtime (On-line) Captioning (Live)
Webcast (Off-line) Captioning (WebPlus)
Traditional Post-Production (Off-line) Subtitling (Classic)

Video Tutorials and Support 

Knowledge base documents, Updates and Upgrades

• Video Tutorials: www.cpcweb.com/tutorial 
• Tutorials: http://www.cpcweb.com/TechSupport/CapMaker
• Forum: www.cpcweb.com/forums 
• Updates and Upgrades: www.cpcweb.com/free_updates 

16

For most up-to-date manual, please check the software downloads page: 
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WebEx Training
CPC conducts training sessions for both CaptionMaker and CaptionMaker on a regular 
basis. There are separate training sessions for beginning, intermediate and advanced 
users... For more information, check the page: www.cpcweb.com/training.  

Telephone Support Contract 

Free five (5) hours of support following three (3) months from date of purchase of CPC 
software. Free two (2) hours of support following one (1) month from the date of 
purchase of a CPC software update. 

You can buy additional support from the following plan. If you sign up for additional 
software support at the time of purchase of the software, pay only 50% of standard 
support fees listed at www.cpcweb.com/support/support-costs.pdf 

One Price - Both Platforms (Mac and Win)
Whether you work with Mac or Windows, we have a solution for you. When you 
purchase CaptionMaker, you will receive a USB key that will work with both Windows 
and Mac captioning software.
  
If you decide to work on Windows, you can easily download and install the Windows 
software by clicking on our downloads page: www.cpcweb.com/download. 

CaptionMaker Software - Many Flavors   
CPC offers a complete line of captioning/subtitling CaptionMaker software packages. 
CaptionMaker- Live
CaptionMaker- WebPlus
CaptionMaker- Classic
CaptionMaker- DV
CaptionMaker- NLE
CaptionMaker- HD Enterprise

In July 2009, CPC added and rearranged a few new flavors of CaptionMaker. To see a 
complete list of software, check the link:  
www.cpcweb.com/products/product_summary.htm  
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Two flavors – Complete and Encoding only
CaptionMaker comes in two flavors, CaptionMaker and CaptionMaker Encoder, and they 
are available for most versions of CaptionMaker. 

CaptionMaker is a caption/subtitle editor and closed caption/subtitle encoder. It allows 
you to do a complete captioning/subtitling job from start to finish. It accepts text from a 
variety of sources. CaptionMaker lets you edit, position, and synchronize the 
captions/subtitles with video using time code. It then combines the captions/subtitles with 
the video as open captions, closed captions or subtitles, and allows you to save them in a 
number of different formats. CaptionMaker supports drop frame as well as non-drop 
frame NTSC/PAL video.

CaptionMaker Encoder does not have caption/subtitle preparation and editing 
capabilities. It is closed caption/subtitle encoding software only. It requires a prepared 
caption/subtitle file from a different source such as CPC CaptionMaker (full version), 
CaptionMaker (full version) or other caption preparation software. After you import a 
prepared file, you can encode captions/subtitles to a video as open captions, closed 
captions or subtitles, and it allows you to save the file in a number of different formats. 
CaptionMaker Encoder supports drop frame as well as non-drop frame NTSC/PAL video.

Complete Preparation and Encoding Software
You can enter/import raw text, format and timecode captions, and encode captions to 
multiple formats and multiple media – with each of the below software packages. 

Live (Realtime captioning, Live text streaming)  
Caption live video using speech recognition software or a steno machine. Also stream 
text on the web for live events. 

WebPlus (Caption preparation, Web video-on-demand, Live text streaming, DVD, 
Realtime captioning)  
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CPC-600 is discontinued

CaptionMaker-Web is enhanced to CaptionMaker-Web (Webcast and DVD)
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If webcast (QT, WMP, Flash, YouTube, Real) and DVD captioning are your main needs, 
WebPlus is your solution. It lets you prepare captions for web video-on-demand. You can 
also use it for live text streaming and live broadcast captioning, with your choice of 
caption inputs, including: speech recognition, steno, pre-scripted text, and traditional 
keyboard text entry. 

Classic (WebPlus + Post caption using CC hardware interface) 
Do you own a hardware closed caption encoder? If so, the Classic version is designed for 
you. It lets you enter, position and time-stamp captions, and it encodes captions with a 
hardware encoder. The Classic is compatible with every manufacturer’s hardware closed 
caption encoder. 

DV (Classic + Caption/subtitle for DV video) 
If you work with DV 720x480 video and use FireWire to transfer the video in and out of 
the computer, DV is for you.  

NLE (DV + Caption/subtitle 720x486 NLE video)
If you edit with uncompressed 720x486 video with FCP, Avid, Adobe Premier, etc. and 
use AJA, Blackmagic or other NLE hardware to transfer uncompressed video in and out 
of the computer, choose NLE. 

HD Enterprise (All features included)
Are you a major captioning provider? If so, HD Enterprise is your designated software. It 
contains every captioning feature CPC offers, allowing you to meet virtually any 
captioning requirement today and in the future. 

Encoding Only Software
Do you already have a formatted and timecoded caption file from a caption service 
provider? If so, our encoder only software is the right choice for you.  

Classic Encoder (Classic without caption preparation option) [formerly CPC-710] 
If clients provide you with time-stamped caption files, and you just need to encode 
captions with a hardware encoder, Classic Encoder is your economical caption software 
solution.

DV Encoder (DV but no caption preparation option)
If you only need to do caption encoding because your clients provide a time-stamped 
caption file, and you go in and out of your NLE with FireWire, then DV Encoder will 
encode your captions with software only – no hardware encoder required.

NLE Encoder (NLE but no caption preparation option)
Same as DV encoder, plus encodes uncompressed 720x486 video. 
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HD Enterprise Encoder (HD but no caption preparation option)
Same as NLE encoder, plus captions HD materials.

Note: Encoder versions allow 40 changes (key strokes & a limited number 
of other things) to an imported file.

Captioning Process at a Glance
To caption a video, you need to go through the following steps:

Captioning is a three-step process.
• Transcribe the video.
• Caption file creation; this is when the timing and placement of the captions are 

done.
• Encoding process; the caption data is encoded on to the video for display on TV 

sets with built-in closed caption decoder, or using an external decoder.

Captioning Digital Videos 
(No generation loss)

If you are dealing with digital videos, once the caption file has been created, you have 
three  distinct  options for  creating  your  captioned  master  directly  on  the  hard  drive 
without using a closed caption encoder hardware. 

If you are dealing with 720x480 DV25 or DV50 (compressed) video, or MPEG-2 video, 
you choose the DV and MPEG-2 route. No need for any Non-Linear system. On the other 
hand  if  you  are  using  a  Non-Linear  system  and  want  to  work  with  720x486 
uncompressed video,  then you choose the NLE route.  For HD video,  there are a few 
options.

Captioning DV Video
If your original digital  video is a DV video, and you transfer the video to a tape via 
FireWire, then the DV function will work well.  CaptionMaker can create a copy of your 
720 x 480 DV video file with the caption data in the VAUX data area. You would need a 
caption compatible DV deck or a Sony DVMC-DA2 digital to analog (in case you want a 
BetaSP or Digibeta) converter to dump the DV video on a tape.

For details on compatible hardware for DV video, visit 
www.cpcweb.com/dv/dv-hardware.htm#Sony_DVMC-DA2 
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You can then use the CaptionMaker’s “print to video” function to get a closed captioned 
version of the video out to tape.

Captioning MPEG-2 (SD & DVD) Video 
You can also add captions to the data area of all SD (720x480 or so) and DVD MPEG-2 
video directly, without using an NLE system. After adding captions to a DVD MPEG-2 
video you can burn a DVD. 

After adding captions to a SD MPEG-2 video, you can store the video on your video data 
server, and transmit the video to a different location. Captions are going to stay in the 
data area of the video.

Captioning MPEG-2 (HD) Video 
CaptionMaker (including the demo version) can decode/retrieve both 708 and 608 
captions from MPEG-2 transport streams, including ATSC DTV broadcast streams. You 
can verify that your stream is compliant with FCC regulations and that the 708 captions 
are encoded properly.

CaptionMaker-HD ties into Manzanita’s multiplexing software to generate 708/608 
closed captions in CableLabs-compliant HD MPEG-2 transport streams (requires 
Manzanita software to be installed separately) for tapeless delivery to networks and 
VOD.

Users without Manzanita software can add captions to generic MPEG-2 Elementary and 
Program streams. The MPEG-2 can be SD or HD. Captions can be formatted in any one 
of the following styles: ATSC DTV 608/708, DVD, CCube/LSI DVx 608 Linear or 
CCube/LSI DVx 608 Temporal. SCTE20-style 608 captions can also be decoded.

Captioning NLE Video
The  advantage  of  a  non-linear  solution  is  that  you  can  work  with  your  720x486 
uncompressed video and add captions without losing any quality. 

The editing software package that you use to create the video is not as big of a concern as 
the hardware path used to get the video off of your system and onto the tape.  Some 
hardware  boards  /  break-out  boxes  will  ignore  the  caption  data.   See  the  link  
www.cpcweb.com/nle/nle-hardware.htm for a list of compatible NLE systems.
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Captioning Webcasts
CaptionMaker can generate captions for video on the web for players like QuickTime, 
Podcast, iTune, Flash, Google, YouTube, RealVideo and Windows Media. For sample 
webcasts with captions, check the link: 
www.cpcweb.com/webcasts/webcast_samples.htm. 

Subtitling Digital Videos 

Adding Subtitles to DV
CaptionMaker can add subtitle to a DV video and print the video to a tape via FireWire.

Adding Subtitles to DVD
CaptionMaker can generate subtitle files for use with DVD Studio Pro and Spruce, Sonic 
and Scenarist DVD authoring systems.

Adding Subtitles to 720x486 NLE Video
CaptionMaker can add subtitles directly to a 720x486 NLE video, or transfer subtitles to 
a 720x486 NLE video using a 720x486 black video with subtitles.

Adding Subtitles to DV-2000 and DV-3000
CaptionMaker can generate subtitle files for use with Ultech DV-2000 (SD) and DV-
3000 (HD).

Adding Subtitles to Digital Video
With CaptionMaker-NLE you can add subtitles to a digital video. You can add subtitles 
to  most  movies  that  can  be  displayed  by  CaptionMaker.  Video  can  be of  any  size 
320x240  to  720x480.  Features  include  multi-language  capability,  border  around 
characters,  translucent  backgrounds,  proportionally  spaced  fonts,  kerning,  and  line 
spacing. 
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Feature Comparison

 Live Web 
Plus

Classic DV NLE HD 
Enterprise

Import:       
Plain Text files √ √ √ √ √ √
Industry standard caption files  √ √ √ √ √
Retrieve captions from existing video  √ √ √ √ √
       
Caption Preparation*:       
Transcribe & Time Stamp videos  √ √ √ √ √
Formatting & Editing √ √ √ √ √ √
       
Export Captions:       
Plain Text files √ √ √ √ √ √
All caption formatted files  √ √ √ √ √
DVD closed captions (.scc)  √ √ √ √ √
DV (720x480) video (for DVCAM, miniDV, etc.)    √ √ √
MPEG-2 608 captions     √ √
Line 21 CC ("Black Movie") for SD 720x486     √ √
       
Export for Web:       
Flash  √ √ √ √ √
QuickTime  √ √ √ √ √
YouTube  √ √ √ √ √
Windows Media  √ √ √ √ √
RealPlayer  √ √ √ √ √
       
Export Subtitles:       
DVD subtitles (DVDSP, Encore, etc.)  √ √ √ √ √
Advanced subtitles (Scenarist, Blu-ray BDN)    √ √ √
Subtitles with Alpha channel     √ √
       
Hardware Encoder Support:       
Live Captioning for broadcast √ √ √ √ √ √
Post Captioning w/SMPTE timecode from tape   √ √ √ √
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How CaptionMaker Works
If you can use a word processor and a VCR, you can caption with the CaptionMaker 
software. Video can be seen in a video window of the CaptionMaker software using an 
inexpensive video display device. Captions can be dragged and dropped to any position 
in the video window.

CaptionMaker Screen

The lower part of the CaptionMaker screen is the Work Area. This area holds all the 
information  on  the  individual  captions:  text,  formatting,  positioning  and  timing.  The 
software offers a number of toolbar icons at the top of the screen that let you perform the 
most frequently used functions with a simple mouse click.

The  software  also  has  toolbar  icons  that  are  geared  towards  specific  tasks,  such  as 
machine (VTR) control,  time code options, and preview window options. In addition, 
most icons can be accessed via keystrokes, which can be assigned by the user. 

Entering the Script  
If you do not have a script of the video, you can get the script in many ways, such as: 

If you use a digital video, you can use foot pedal controller to transcribe the video. Foot 
pedal control vPedal which costs less than $100. For details, check the page: 
http://www.cpcweb.com/caption_common/VPedal-AllAbout.pdf 
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Train a speech recognition software such as Naturally Speaking or ViaVoice 
(www.nuance.com) for a few hours. Then listen to the videotape and repeat the dialogue 
into the microphone. At the beginning, you are going to get lot of errors. But you can 
teach the software to fix the errors and down the road you can expect to get about 95% 
accuracy. 
Use a professional transcription service. This is the most expensive way to generate the 
script.

The CaptionMaker can import scripts from a text file and most word processors (such as 
WordPerfect and Microsoft Word) files.

Formatting the Text
When you import a raw text file into the CaptionMaker software, the software breaks the 
script into captions according to your specifications (e.g., number of characters per line 
and number of lines per caption). Using the five icons ( ) on the left side of 
the text area, you can fine-tune the text in each caption in an efficient way. For example, 
the icon is used to push the last word from one caption to the beginning of the next 
caption with just one mouse click. Highlighting is not needed. The  icon is used to 
square up a multiple line caption. The formatting of text is done taking into consideration 
the readability and the aesthetic appearance of the captions.

Generating Captions

CaptionMaker-Live 
Start  the  playback  and record  VCRs.  When you  hear  the  first  word  of  each  caption 
spoken, press the (+) key. Pressing the (+) key outputs the caption the cursor is on to both 
the record tape and the CaptionMaker screen. The captions are recorded onto the video in 
real time.

CaptionMaker-Classic 
Start the playback VCR. When you hear the first word of each caption spoken, press the 
(+) key. When you press the (+) key CaptionMaker-Classic reads the time code via the 
time code reader and also outputs the caption the cursor is on to the encoder. The time 
code is automatically captured and displayed on the far left side of the CaptionMaker 
screen. After assigning time codes to each caption, you are ready to AutoSync. 

When  all  the  captions  have  time  codes,  rewind  the  tape  to  the  beginning.  Start  the 
playback and record machines and click on the icon for AutoSync. As each time code is 
read, the caption associated with it will be output automatically at precisely the correct 
time. The result is perfect synchronization between dialogue and captions. The video with 
the  captions  is  sent  to  the  record  machine.  The  CaptionMaker  minimizes  the  use  of 
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expensive VCRs by allowing you to perform every-thing but the final AutoSync process 
off-line on inexpensive VCRs (e.g., a VHS deck with two linear audio channels). You 
only need the higher-level VCRs (e.g., Betacam SP, Digital decks) for the final AutoSync 
process.

CaptionMaker-Classic Encoder 
The vast majority of CaptionMaker-Classic users do not need the CaptionMaker-Classic 
Encoder because the CaptionMaker-Classic has all the AutoSync encoding capabilities of 
CaptionMaker-Classic Encoder. It only lets you do AutoSync and make minor changes in 
the  file;  it  cannot  be  used  to  prepare  captions.  It  is  ideal  for  those  who need to  do 
encoding  of  captions  only.  For  example,  suppose  the  video  to  be  captioned  is  on 
professional BetaSP tape. However, the caption script preparation, formatting, and time 
coding are done at  a facility that  does not have professional BetaSP tape decks. The 
formatted text with time code could then be e-mailed to a facility that does have BetaSP 
decks,  and  using  CaptionMaker-Classic  Encoder  that  facility  can  easily  and  quickly 
encode the captions onto a BetaSP tape.

DVD Captioning and Subtitling
To caption  or  subtitle  a DVD, you need a  DVD authoring system in addition  to  the 
CaptionMaker-Classic  software.  The process  is  the  same as  that  described  earlier  for 
CaptionMaker-Classic users up to the point of AutoSync. Instead of AutoSync, the file is 
exported to your DVD authoring system, which then inserts captions or subtitles onto the 
DVD. The CaptionMaker-Classic supports all major DVD authoring systems. You do not 
need a closed caption encoder or a character generator.

Webcast Captioning
You can caption both existing videos and live productions on the Web with both the 
CaptionMaker-Live and CaptionMaker-Classic. To caption an existing video, which is 
known as a Video-on-Demand Webcast, the process is the same as that described earlier 
up to the point of AutoSync. Instead of AutoSync, the CaptionMaker exports a caption 
file for your  Webcast.  The CaptionMaker can create  files for all  three video players: 
Windows Media Player, RealPlayer and QuickTime. 

Captioning a live production, which is known as a Live Webcast, requires none of the 
formatting, positioning or timing processes described earlier. Simply broadcast the live 
video  using  Windows  Media  Encoder,  RealPlayer  Server,  or  QuickTime  Streaming 
Server,  and  start  entering  the  dialogue  using  either  a  steno  machine  or  Speech 
Recognition software.

Captioning a DV Video
Create a time-stamped caption file using the CaptionMaker software exactly the same 
way you would when captioning a videotape. If you have CaptionMaker-DV, you can 
caption a DV (*.mov or *.avi) video directly on your hard drive. 
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Captioning a Video with NLE
Create a time-stamped caption file using the CaptionMaker software exactly the same 
way you would when captioning a videotape. If you have CaptionMaker-NLE, you can 
add captions directly to the video residing on the computer running your NLE system 
(Avid, Media-100, etc.), without the need for a closed caption encoder.

Captioning a SD and HD Mpeg-2 Video
Create a time-stamped caption file using the CaptionMaker software exactly the same 
way you would when captioning a videotape. If you have CaptionMaker-HD Enterprise, 
you can caption a MPEG-2 SD and HD video on your hard drive directly. If you have 
lower version of CaptionMaker-HD Enterprise, you can use CaptionMaker-HD Encoder 
software to insert the captions onto the MPEG-2 digital video directly, without the need 
for a closed caption encoder.
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C h a p t e r  1
H a r d w a r e  I n s ta l l a t i o n

System Requirements

Computer
The CaptionMaker works with IBM PC compatible computers (Pentium recommended) 
with:

Windows 2000/XP/Vista
At least a 500 MHz, 512MB of RAM (off-line captioning/ subtitling or,
at least a 1 GHz, 1 GB RAM (on-line captioning), or,
at least 2 GHz, 1 GB RAM (caption/subtitle digital video with 
CaptionMaker-DVE/HD)
At least 40 GB of hard drive space
If using videotape source, an internal video capture card such as ATI All-In-Wonder, or 
an external video capture device (e.g., Pinnacle DVC-80). (This allows you to display the 
video on your VGA monitor so that you can drag and drop captions or subtitles onto the 
video.)
A sound card and speakers supported by Windows
A Parallel printer or USB port  (for software security key)
If using an external CC encoder, a Serial port (also known as a COM port or RS 232 port)

CPC Protection Key (Key) 

A CPC Protection Key (USB type) is supplied with CaptionMaker software. The Key 
must  be  attached  to  a  USB  port  on  the  computer  for  CaptionMaker  to  work. 
CaptionMaker is protected by this hardware.

For most up-to-date manual, please check the software downloads page: 
www.cpcweb.com/download/cmplete_software_downloads.htm 
Also check http://www.cpcweb.com/TechSupport/CapMaker
for CPC knowledge based documents for different topics.
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Warning:   If you lose the CPC Protection Key, you will not be able to run 
the software! You will  have to pay a hefty price to replace it.  You may 
move the Protection Key from computer to computer,  allowing different 
users to operate the CaptionMaker software on different computers, but 
only one user may run the software at a time.

Compatible DV Decks & NLE Systems

CaptionMaker-DV
CaptionMaker-DV works with both DV25 and DV50 video. You can create your DV 
video in any NLE system or simply import from a video tape format. 

Up-to-date List: For most recent list of caption compatible DV decks, please check 
www.cpcweb.com/dv/dv-hardware.htm  .   

After you caption a 720x480 DV video sitting on your hard drive, using Windows or Mac 
CPC software, you need to dump the video to a tape format via FireWire using any DV or 
mini-DV deck. 

Caption data sits in the VAUX Data area of a 720x480 DV video. On the other hand, 
caption data sits in Line 21 of NTSC (525 lines) video.  When you transfer the DV video 
to NTSC, you must use a deck which can transfer the caption data from the DV VAUX 
data area to the NTSC Line 21. 

We have tested the following decks and media converters, which do the job successfully. 
If your deck is not listed below, you can use the compatibility check below to test your 
deck. 

DV Decks - Caption Compatible (partial list)

• Panasonic AJ-D650, AJ-D455
• SONY DHR-1000
• SONY DSR-11, DSR-20, DSR-30, DSR-40, DSR-80
• SONY GV-D300 portable
• SONY DCR-TRV110, TRV720, TRV820 Digital8 camcorder
• JVC DV-3000
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Sony DVMC-DA2 Media Converter - Caption Compatible 

Converts Analog Video to Digital Video, or Digital Video to Analog with timecode 
information. Sony brings a new media converter that allows to convert analog signal, 
such as 8mm or VHS to a digital video signal that is output to i.LINK/FireWire interface.

DV Decks  - Not Caption Compatible (partial list)
The following video decks and video cameras do not do the proper transfer of caption 
data onto NTSC video. But you can still record closed captioned DV video using any DV 
video deck, including the ones below, even though you cannot play back the video with 
captions from these decks. This is a subtle, but important distinction. 

• CANON XL-1 camcorder 

• SONY DSR-PD100 

• SONY DSR-85 

• Panasonic AG-DV1000 

Note from a Sony Rep. on DSR 45, 50 and 85:
The DSR-45 does output Closed Captions only in NTSC and only on the monitor out 
connector. Not the component, main video or S-Video outputs. There is no
magic mod to my knowledge to turn this on and it has been asked for previously to my 
recollection. 
By the way, among the DVCAM products, CC only exists in NTSC machines or NTSC 
mode. The DSR-85 never supported Closed Captioning, the DSR-45 as you now know 
only outputs CC on the monitor output and the DSR-50 only outputs CC on the video 
output. All the other DVCAM machines basically output Closed Captioning. The POSC 
Group at 800-883-6817 has this information in their FAQ database. 
Please refer the customer to the Sales brochure and maybe give a heads-up to
the other Sales people who may need to know this gotcha. Sorry again for
the bad news.

The Sony Business Solutions & Systems Product Operations Support Center: 
http://bssc.sel.sony.com/BroadcastandBusiness/minisites/HDV/support.shtml  
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DV Compatibility Check 1
There are many other DV hardware devices which work with CPC CaptionMaker. To 
check whether your specific hardware is caption compatible or not, you can do the 
following test.

Take a commercial video with closed captions and save it via FireWire on your hard 
drive. Now print the video out of your computer via FireWire to your DV hardware and 
then finally to a TV with its closed caption decoder turned on. If you see captions, your 
hardware is caption compatible. 
  
DV Compatibility Check 2
Download one of the following videos (295 MB) which are already captioned using CPC 
software
Demo_DV_720x480_CC.mov  (QT mov)
CPCDemo_DV_720x480_CC.avi (avi)
and open the video in your NLE system or any software which allows you to dump the 
video via FireWire to your deck. Now connect the deck to a TV with its closed caption 
decoder turned on and output the video. If you see captions, your hardware is caption 
compatible.

CaptionMaker-NLE 
CaptionMaker  can  add  captions  directly  to  video  using  NLE  systems.  After  adding 
captions to a 720x486 video with an NLE system you typically write the final video to 
video tape. You output the 720x486 video from your NLE system to NTSC videotape 
using the hardware associated with your NLE system.

Up-to-date List: For most recent list of caption compatible NLE Systems, please check 
www.cpcweb.com/nle/nle-hardware.htm  .  
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NLE Hardware 
Caption data sits in 720x486 video in Row 0 or Row 1 depending on the NLE system. In 
NTSC (525 line) video caption data  sits  in Line 21.  When you transfer the video to 
NTSC, you must use an NLE system that can transfer the caption data from Row 0 or 
Row 1 of 720x486 video to NTSC video Line 21. The following NLE systems can do 
this, which makes them caption compatible. Caption data for use with NLE systems is 
stored in the following locations: 

NLE Systems Primary 
Row 

Starting Column 

AJA Io LA * 1 24 
AJA KONA * 2 24 
AJA KONA (alternate) * 1 24 
AJA KONA LH/Lhe, LS/LSe * 2 24 
AJA KONA LH/Lhe, LS/LSe (alternate)* 1 24 
Avid ABVB 0 35 
Avid ABVB (alternate) 480 35 
Avid Adrenaline 0 22 
Avid Adrenaline (alternate) 1 35 
Avid DS Equinox 1 26 
Avid Express Pro 1 26 
Avid Meridien 1 26 
Blackmagic DeckLink # 1 26 
Blackmagic DeckLink (alternate) * 2 26
Leitch DPS Velocity 1 26 
Matrox DigiSuite# 1 30 
Media 100 1 26 
NewTek Video Toaster 3 & 4 # 1 19 
Sony XPRI 1 26 
TARGA 1000-3000 1 26 

* Works with Mac Final Cut Pro
# Works with Windows Adobe Premier

The Primary Row is the row number, 0 – 484, where caption data is placed in a 720x486 
video for use within an NLE system. The Starting Column is the middle pixel number, 14 
– 40, of the first caption run-in white small dashed line of the caption placed onto the 
Primary Row. 
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NLE Compatibility Check 1
There may be other NLE hardware devices which work with CPC CaptionMaker and 
CaptionMaker software. To check whether the CPC software works with your specific 
hardware, you can do the following test. 
Take a commercial video with closed captions and save it uncompressed via your video 
input/output device (not FireWire) on your hard drive. Now send the uncompressed video 
out of your computer to a TV with its closed caption decoder turned on. If you see 
captions, your hardware is most likely compatible.
 
NLE Compatibility Check 2
You can download one of the two sample NLE 720x486 black videos containing closed 
captions which were created with CPC software: 
MOV files for a number of NLE systems:
http://www.cpc-usa.com/1ccaption/NLE_MOV_Exports.zip
AVI files for a number of NLE systems:
http://www.cpc-usa.com/1ccaption/NLE_AVI_Exports.zip 
Chose either the mov or the avi zip file, unzip it and choose the appropriate mov or avi 
file for your system. Open the video in your NLE software and output the video via your 
video input/output device (not FireWire) to your video deck. For details, click here. To 
see the captions, you would need a TV with its closed caption decoder turned on. If you 
see captions, your NLE hardware is compatible.

NLE Systems Not Listed Above
Closed Caption data sits on Line 21 in NTSC (525 line) video. Captions sits on 720x486 
NLE video somewhere on row 0 through  Row 2 depending on the NLE system. When 
you transfer the 720x486 video to NTSC, you must use an NLE system which can map 
the caption data from Row 0, 1 or 2 of 720x486 video to Line 21 of NTSC video. 
CPC created a calibration video (7:30 minutes). The closed caption content of the first 5 
seconds of the calibration movie is "Row 0, Col 14" and it is generated with primary row 
set to 0 and starting column set to 14; the next 5 seconds of the movie has the CC content 
of "Row 0, Col 15" and is generated with primary row set to 0 and Starting Column set to 
15. This shifting continues through Row 0 and Column 40 at which time it shifts to Row 
1 Column 15. The last movie segment is Row 4 Column 40. 

Please  download  and  play  one  of  the  following  caption  encoded  calibration  videos 
(created with different codecs) from www.cpcweb.com/blackmovie on your NLE system 
and print the video through your NLE hardware (not FireWire), you would be able to 
determine the preset values (row/column) for your NLE system. 

• Avid Meridian Codec (Adrenaline, Symphony)   

• Uncompressed 8 bit 422 (AJA, Blackmagic, Premiere, Final Cut)  

• QuickTime Animation (Generic Codec)  
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• Apple ProRes 422 (Final Cut Studio 2)  

Finding row/column 
Download and unzip the Caption Encoded Calibration QuickTime movie that 
corresponds with your NLE sequence codec settings. (A matching codec can cut down or 
avoid render time)

Import the caption encoded calibration movie into your NLE system. For Avid, import 
720x486/Non-Squared/Upper Field First)

For details on how to find the row and column for your NLE system, please check the 
page www.cpcweb.com/blackmovie

If do not see any captions at all, your NLE system is not caption compatible. And if you 
do see captions, you need to pick a row and column value pair from the numbers you see. 
To avoid errors, you pick the mid-value of all visible column numbers. In this example it 
is C 25. So the preset NLE values for your NLE system is Primary Row: 0 and Starting 
Column: 25. Once you have determined these values, you can use these values in the 
CPC software and caption your videos using your NLE system.
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C h a p t e r  2
S o f t w a r e  I n s t a l l a t i o n  

Installing the Software
The CPC CD-ROM disk is designed to automatically execute a setup program that will 
install the CPC CaptionMaker onto your hard disk. You can choose the directory where 
you want the program to reside.

It is important to run the installation routine, rather than just copying the files from a 
previous installation, because the installation routine creates registry keys and makes sure 
all of the appropriate DLLs are installed in the computer.

New  updates are  released  regularly.  For  the  latest  version  of  the  program,  go  to 
www.cpcweb.com and choose “Downloads” near the top right hand corner.

Upgrading CPC Software
(This will only work if your received the software key after 1/1/2002)

1.  You  can  upgrade  your  CPC  software  from  any  level  to  a  higher  level  (i.e., 
CaptionMaker-Classic to CaptionMaker-NLE) via email.  You do not need to send the 
USB or the parallel hardware key via mail to be replaced. We will upgrade the key via 
internet.

2.  Run  the  CPC  software.  Go  to  the  Help  menu  and  click  on  Upgrade  License
(If you do not find the menu item Upgrade License, follow the step below to install the 
most recent version of your level of software. Now you will see the Upgrade License 
Screen under the Help menu.)

For most up-to-date manual, please check the software downloads page: 
http://www.cpcweb.com/TechSupport/CapMaker/CaptionMakerManual.
pdf   Also check http://www.cpcweb.com/TechSupport/CapMaker
for CPC knowledge based documents for different topics.
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3. Now click on Display License ID.

4. Copy and paste the string of characters to info@cpcweb.com

We will email you  a *.dat file. 

Now you need to follow step 3 inside the Upgrade License screen to upgrade your 
software to a higher level.

Install most recent version of software: 
You can download the most recent version of the software from our Software Downloads 
page: www.cpcweb.com/download/cmplete_software_downloads.htm 

Now follow the steps:
1. Uninstall the old version of the software. (Keep note of your caption and TC devices)
2. Disconnect the USB or Parallel hardware key from the computer.
3. Install the new upgraded version of the software. 
4. Connect the USB or Parallel hardware key to the computer.

Computer Screen Resolution
CaptionMaker  works  at  a  screen resolution  of  800 x 600 or  more.  If  your  computer 
monitor display is below that, go to Start  →  Setting  →  Control Panel  →  Display and 
change the screen resolution to at least 800 x 600. 
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Time Code Reader
If  you haven’t  already installed  the driver  for  the time code reader  card or the USB 
module,  read the section in Chapter 1 entitled “Time Code Readers”.  Once you have 
installed the card, you must select it in the CaptionMaker software. Go to Time Code → 
Time Code Reader properties menu, and select your specific time code reader.  

If you use an Adrienne PCI-TC or USB-TC, choose AEC PCI-TC/USB-TC from the 
menu. Make sure you set it to the correct IO port. See Chapter 1 for more information.

Video Capture Device
If you are using video from a videotape, you must have a video capture device (like ATI 
card or USB Pinnacle) installed in the computer. Make sure the device works with the 
appropriate  software  that  comes  with  the  device  first  as  described  in  “Chapter  1: 
Hardware Installation”.

Click on the  icon (located at the top right corner of the Operations Area) to invoke 
this option. This button  brings up a dialog box to configure the video on the Preview 
Window. You must check the box to enable the video, and also check the box to render 
text. 

Click on the Source button and make sure the video source (Composite or Component) 
you feed into the device is right.

Caption/Subtitle Device
You will probably need to select a caption/subtitle device such as InsertaCap or Codi. 
The computer will remember one captioning and one subtitle setup at any given time. 
The menu bar will show a menu named either Caption or Subtitle. 

In the Current Settings area of the Caption/Subtitle →  Device dialog box, there is a pull-
down box that will let you select a caption/subtitle device. Note that some manufacturers, 
such as Link, have a standard for talking to their devices, so you do not have to choose 
the individual model, only the manufacturer. 

After you have selected a device, click on the Configure button. It will open a  Device 
Settings dialog box that will display the COM Port settings for the device, as well as 
several other settings. It is highly unlikely that you will ever need to adjust any setting 
but  the  COM  port  setting,  unless  you  have  changed  dip  switches  or  otherwise 
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reconfigured your device. Your caption/subtitle device communicates with the computer 
through a serial or COM port. A computer can have up to 8 COM ports, called COM1 
through COM8.

The Restore Defaults button is very useful. It will restore every one of the settings to the 
device’s factory defaults. It is highly unlikely that the factory defaults will be incorrect 
for your configuration, except for the choice of COM port. The best way to test your 
device is to send a few characters to it.

DVD/DV2000 Subtitling Device
There  are  several  DVD Subtitling  Systems supported  by the CaptionMaker  software. 
Choose the appropriate system for which you are going to create the files for. You do not 
need to  configure the COM port  or associated  parameters,  because no DVD/DV2000
subtitling  device  is  going  to  be  attached  to  the  computer.  See  the  discussions  under 
Ultech DV2000 and DVD Interface in “Chapter 5: Subtitling” for details.

MagniCoder Pro
Select Subtitle Device →  MagniCoder Pro →  Configure. Select the COM Port that will 
be used to interface the MagniCoder Pro. See “Chapter 5: Subtitling” for more details.

Choosing Keyboards
The CaptionMaker is designed to be completely compatible with Windows conventions 
for International Language Fonts and Keyboards. You can type the accented and special 
characters using any one of the following methods.

Multiple Keystroke Method
If you do not know how to use a keyboard for characters used in a particular foreign 
language,  you  can  install  your  keyboard  to  type  those  characters  with  multiple 
keystrokes.

RS232 Settings
• Connect via RS232 serial port

Port:  COM1_ Parity:  Odd_
Baud rate:  1200_ Stop bits:  1_
Data bits:  7_ Restore Defaults
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1. To install the keyboard to type accented characters, go to Start  → 
Settings  →  Control Panel  →  Keyboard, and click on the 
Language/Input Locales tab. 

2. Click on the Properties button. On a Standard United States version of 
Windows, a pull-down box will appear containing many keyboard layouts.

3. Select the keyboard layout United States - International. Then click OK.

This keyboard will allow you to type accented English characters used in most European 
languages,  including  French,  German,  Spanish,  Danish,  Italian,  Dutch,  Finnish, 
Portuguese, Norwegian and Swedish. 

To type the following characters on the left side of the table below, type two characters 
on the same row one after another. When you type the first character you will not see 
anything appearing on the screen. As soon as you type the next character, you will see the 
accented character. It is very simple to type the accented characters this way. You do not 
have  to  know  the  keyboard  used  for  the  associated  language  or  any  character  code 
number associated with that character.

Character First Key Second Key

á ' (under the ") a
à `(under the ~) a
ä " a
ã ~ a
â ^ (under the 6) a
ç ' (under the ") c
é '(under the ") e
è `(under the ~) e
ë " e
ê ^ e
í '(under the ") i
ì `(under the ~) i
ï " i
î ^ i
ñ ~ n
ó '(under the ") o

ò `(under the ~) o
õ ~ o
ô ^ o

ú '(under ") u
ù `(under ~) u
ü " u
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û ^ u
ý '(under ") y
ÿ " y

Any of the above characters can be typed in uppercase, simply by pressing the [Shift] key 
while you type the second character. 

The following characters can also be typed by a combination of keystrokes. 

Character Combination
Å Shift-Control-Alt-W
Å Control-Alt-W
Æ Shift-Control-Alt-Z
Æ Control-Alt-Z
Ð Shift-Control-Alt-D
Ð Control-Alt-D
Ø Shift-Control-Alt-L
Ø Control-Alt-L
Þ Shift-Control-Alt-T
Þ Control-Alt-T
¡ Control-Alt-1 (!)
¿ Control-Alt-/ (?)
ß Control-Alt-S
§ (Music) Shift-Control-Alt-S
© Control-Alt-C
® Control-Alt-R
¥ Control-Alt-(-)
× Control-Alt-[+]
¾ Control-Alt-8
½ Control-Alt-7
¼ Control-Alt-6
€ Control-Alt-5
¤ Control-Alt-4
³ Control-Alt-3
² Control-Alt-2
¬ Control-Alt-\(|)
¶ Control-Alt-;
° Shift-Control-Alt-;
« Control-Alt-[
» Control-Alt-]
¹ Shift-Control-Alt-1
£ Shift-Control-Alt-4
¢ Shift-Control-Alt-C
µ Control-Alt-M
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Character Map Method
To find out how to type any given character on the keyboard, go to Start → Programs → 
Accessories → System Tools → Character Map. This will show the entire character set. 
To insert a certain character at the cursor location, simply double-click on the character in 
the character map table.

Single Keystroke Method
If you know how to use a keyboard for characters used in a particular language, you can 
install your keyboard to type those characters with a single keystroke.

1. To install more languages, go to Start →  Settings → Control Panel → Keyboard, 
and click on the Language/Input Locales tab. 

2. Click on the Add button. On a Standard United States version of Windows, a pull-
down box will appear containing many languages. 

3. Select the language you would like to use. Then click on OK.

An indicator will appear in the lower right corner of your screen (Task Bar) next to the 
clock. By clicking on this, you can select any of the keyboards that you have installed, or 
you may press [Alt]+[Left Shift] to cycle through the keyboards. 

Now you have set your keyboard the same way as the characters are accessed in the 
language  in  the  associated  country.  For  example,  if  you  choose  Portuguese,  a  single 
keystroke will give the following result:

If you type You will get
; ç
: Ç
= «
Shift = »

Available Subtitling and Captioning Characters 
If you are subtitling, you can generate any character or symbol that you can generate on 
the computer’s screen, though you may have to download a font into the memory of your 
external device depending on which one you are using. 

However, captioning is a different case. The closed caption encoder does not actually 
draw the characters, but tells the closed caption decoder which characters to display. The 
languages supported by the closed caption decoders include the following:
Dutch, English, French, German, Portuguese and Spanish
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C h a p t e r  3
 I m p o r t i n g  a n d  E x p o r t i n g  F i l e s

Import/Export Capabilities
CaptionMaker can import from and export to the following three groups of file types:

Word Processor Group (including text file)
Caption Formatted Group 
DVD/DV2000/Webcast Subtitle Group
DV (Export only)
NLE (Export only)
HD (Export only)

Word Processor Group
1. ASCII Text File (*.txt)
2. Word Document (*.doc)
3. WordPerfect Document (*.wpd, *.doc)
4. Rich Text Edit File (*.rtf)

Caption Formatted Group
1. Caption Center File (*.tds)
2. Captions Inc. File (*.cin)
3. Cheetah Caption File (*.asc & *.cap) (Export to *.cap not available)
4. DOS CPC CaptionMaker File (*.*)
5. DVD Caption File (*.cc, *.scc) 
6. CCaption (*.onl)
7. Power Pixel Format File (*.txt)
8. Softni (*.sub)
9. Ultech DV-2000 (*.onl, *.ult)
10. Windows CaptionMaker File (*.cap)
11. Windows CaptionMaker File ver 1.xx (*.cap)

DVD/DV2000/Webcast Subtitle Group (TIF file formats cannot be imported)
1. Adobe Encore (*.txt)
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2. Daikin Scenerist TIF (*.zip) 
3. Daikin Scenarist Text (*.txt)
4. DV2000 USF/UYC (*.zip) 
5. Sonic Solutions TIF (*.zip)
6. Sonic Solutions Text (*.txt)
7. Spruce DVDMaestro TIF (*.zip)
8. Spruce STL Script File (*.stl)
9. Webcast SMI/RT (*.zip)

DV Group
1. DV 720x480 AVI/MOV

NLE Group
2. NLE 720x486 AVI/MOV

HD Group
3. MPEG-2

Note    You  can  import  files  from the  Word  Processor  &  Caption 
Formatted Groups and you can import the text/script files from the 
DVD/DV2000/Webcast  Subtitle  Group.   But  you  cannot  import  the 
DVD/DV2000 picture files.

Word Processor Group
If you have any file containing just the text (no time code or formatting) in Microsoft 
Word  Document  (*.doc),  Rich  Text  Edit  File  (*.rtf),  and  Word  Perfect  File  (*.wpd, 
*.doc), you may import the file into CaptionMaker using the File → Import option and 
choosing the appropriate file format.

Note     Microsoft Word version 97 or higher must be installed in the 
computer, but does not have to be running. CaptionMaker uses the 
Word engine to import and export Word, WordPerfect and Rich Text 
files.
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ASCII Text Files (Tab Delimited)
Text broken up into individual caption/subtitles
Text with In time code (Tab delimited)
Text with In and Out time codes (Tab delimited)

Text Only (Must Be Separated by Tab) 
You can import text files with text separated by Tab characters.

When you click on the  File → Import options, the  Import File dialog box will appear. 
Make sure to choose File Type as ASCII Text File (*.txt) and click on the Browse button 
to  import  the  file.  An  example  file  Text-tab-delimited.txt is  included  in  the 
C:\ProgramFiles\CPC\ CaptionMaker\Samples folder.

1. To import this file, press the Next button for the Import Format dialog box 
to appear which gives you several options.

2. Then select the Tab Delimited option and choose Text Only and text option 
from the fields of import files.

3. Now click on the Next button for the Import Options dialog box to appear. 
All options must be unchecked and clear.

4. Press the Finish button to import the file.

Here is a short example of the file with text only and the individual captions separated by 
a Tab character.  The Tab inside each line will separate the text into two lines of caption.

NOW MY NAME APPEARS AT THE BOTTOM OF THE SCREEN,
WE PUT CAPTIONS OF WHAT I SAY AT THE TOP,
SO THAT MY NAME IS NOT  COVERED BY CAPTIONS.

After opening the file in the CaptionMaker software, it will look like the following. The 
lines within each caption are broken at the Tab position.

NOW MY NAME APPEARS
AT THE BOTTOM OF THE SCREEN,

WE PUT CAPTIONS
OF WHAT I SAY AT THE TOP,
SO THAT MY NAME IS NOT
COVERED BY CAPTIONS.

Note: If you do not have a Tab character inside the text line, the line would break into 
multiple lines according to the choice of Max characters per line.

Time Code In and Text (Must Be Separated by Tab) 
Import text files with time code in and text separated by Tab characters.
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When you click on the  File → Import options, the  Import File dialog box will appear. 
Make sure to choose File Type as ASCII Text File (*.txt) and click on the Browse button 
to import the file.

An  example  file,  Tc-in-and-text-tab-delimited.txt, is  included  in  the  C:\ProgramFiles  
\CPC\ CaptionMaker\Samples folder. To import this file,

Press the Next button for the Import Format dialog box to appear.
Select the Tab Delimited option and choose Time Code in and text option from the fields 
of import files.
Click on the Next button for the Import Options dialog box to appear.  All options must 
be unchecked and clear.
Press the Finish button to import the file.

Here is a short example of the file with time code in and the individual caption separated 
by a Tab character.  The tab still marks the desired line breaks.

01:03:31:08 NOW I'M AT THE RIGHT OF THE SCREEN,
01:03:33:07 SO MY CAPTIONS APPEAR AT THE RIGHT.
01:03:35:13
01:03:36:13 NOW I AM GOING OFF-SCREEN.

After opening the file in the CaptionMaker software, it will look like the following. 

01:03:31:08 NOW I'M AT THE
RIGHT OF THE SCREEN,

01:03:33:07 SO MY CAPTIONS
APPEAR AT THE RIGHT.

01:03:35:13
01:03:36:13 NOW I AM GOING OFF-SCREEN.

Time Code In, Out and Text (Must Be Separated by Tab) 
You can also import a text file with time code in, time code out and text separated by Tab 
characters.  

When you click on the  File → Import  option, the  Import File dialog box will appear. 
Make sure to choose File Type as ASCII Text File (*.txt) and click on the Browse button 
to import the file.  

There is an example file  Tc-in-out-and-text-tab-delimited.txt that is included under the 
C:\ProgramFiles\CPC\CaptionMaker\Samples folder. To import this file, 

Press the Next button for the Import Format dialog box to appear which gives you 
several options. 
Select the Tab Delimited option and choose Time code in, out, and text option from the 
fields of import files.  
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Click on the Next button for the Import Options dialog box to appear.  All options must 
be unchecked and clear. 
Press the Finish button to import the file.  

Here is a short  example of the file with time code in, out and the individual  caption 
separated by a Tab character. The Tab character separates lines of caption.

01:03:31:08 01:03:33:05 NOW I'M AT THE RIGHT OF THE SCREEN,
01:03:33:07 01:03:35:15 SO MY CAPTIONS APPEAR AT THE RIGHT.
01:03:35:17 01:03:36:11
01:03:36:13 01:03:38:06 NOW I AM GOING OFF-SCREEN.

After opening the file in the CaptionMaker software, it will look like the following. 

01:03:31:08 NOW I'M AT THE
RIGHT OF THE SCREEN,

01:03:33:07 SO MY CAPTIONS
APPEAR AT THE RIGHT.

01:03:35:17
01:03:36:13 NOW I AM GOING

OFF-SCREEN.

Note: In the original text file, the difference between time-out of one caption and the 
time-in of the next caption is two frames. But in the file imported to the CaptionMaker, 
the time-out information seems to be lost. CaptionMaker ignores the difference of time-
out of one caption and the time-in of the next caption if it is less than 6 frames. If the 
difference is more than five frames, then and only then it adds a new row with the proper 
time code.

In the Caption  Maker  software,  we have an option to  add blank frames  between the 
captions. It is available under the option 

Caption  → Properties  → General, or
Subtitle  → Properties  → Options

You may add a number of blank frames here to have the same effect as you had in the 
original text file.

Caption Center Files (*.tds)
You can import or export Caption Center files from the Import/Export menu

There  is  a  sample  Caption  Center  file  in  ASCII  format  Caption-center.tds in  the 
C:\Program Files\CPC\CaptionMaker\Samples folder. Here is a sample example of the 
file:

Timecoded Data Services
øBeginHeaders
Title =title: RADIO ACTIVE #1018 "Radio Activist"
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CreationDate = 1999 09 22 21:22:02
Creator = The Caption Center, WGBH, Boston, MA
Contact = +1 617 492-9225
FramesPerSecond = 30d
L21F1Stm = F
L21F1Chn = CC1
L21F1APD = YES
L21F1XparBreaks = NO
L21F1Lev = FCC/TC2
L21F1TakeOnStartup = YES

Authorization = uqmlgtpjlsgmrsph

øBeginMessages
øBeginComments

øBeginData
ù00593825
úFû14 û14Rû11.RADIO ACTIVEû11 #RAD-1018û14tCLOSED 
CAPTIONEDû14,û14/
ù00594925
úFû14,
ù01000004
úFû14.û14,
ù01000109
úFû14 û11Rû17#û11.YOU'RE LISTENINGû11rû17#û11.TO RADIO 
ACTIVE.û14,û14/
ù01000418
úFû14,
ù01000826
úFû14 û11Tû117 RADIO ACTIVE û117û14,û14/

     When the file is imported in the CaptionMaker software, it will look like this:

Start H V J Display Caption/Subtitle
00:59:38:25 5 B C Pop-On RADIO ACTIVE #RAD-1018

CLOSED CAPTIONED
00:59:49:25 5 B C Pop-On
01:00:00:04 5 B C Pop-On
01:00:01:09 8 T C Pop-On YOU'RE LISTENING

TO RADIO ACTIVE.
01:00:04:18 8 T C Pop-On
01:00:08:26 C T L Pop-On § RADIO ACTIVE §

Captions, Inc. Files (*.cin)
There is a sample Captions, Inc. file in ASCII format Cap-inc.cin in the C:\Program 
Files\CPC\CaptionMaker\Samples folder. Here is a sample example of the file:

AIRP75CC0058012602532828AIRP75CC  "Airport 1975"  (DF)  Closed-Captioned  MCA 
Fil2Cn10 V1.10 970928D
þ00201000008
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,
þ04801025107
 THOW WAS EUROPE ?VOH,vIT'S STILL THERE.,/
þ05801025326
 vEXCEPT FOR FRANCE.VSHE'S NOT SOREvAT US ANYMORE.,/

When this file is imported in the CaptionMaker software, it will look like:

Start H V J Display Caption/Subtitle
01:00:00:08 C B C Pop-On
01:02:51:07 C 12 L Pop-On HOW WAS EUROPE ?
01:02:51:07 12 B L Pop-On OH,

IT'S STILL THERE.
01:02:53:26 13 B L Pop-On EXCEPT FOR FRANCE.

SHE'S NOT SORE
AT US ANYMORE.

Cheetah Caption Files (*.asc)
You can import/export Cheetah ASCII files from the Import/Export menu. You can also 
import Cheetah .cap binary file.

There is a sample Cheetah file in ASCII format  Cheetah.asc in the  C:\Program Files\  
CPC\ CaptionMaker\Samples folder. Here is a sample example of the file:

** Caption Number 2
*T 01:00:06:06
*TopDown
*C116
The Office of the Ombudsperson
exists\E

** Caption Number 3
*T 01:00:07:28
\AI\solely\AW\ to provide service
to American Express people.\E

** Caption Number 4
*T 01:00:12:22
*BottomUp
*Cb16
We have no agenda of our own.\E

When this file is imported in the CaptionMaker software, it will look like:

Start H V J Display Caption/Subtitle
01:00:06:06 C T C  Pop-On The Office of the Ombudsperson
01:00:07:28 C B C  Pop-On exists solely to provide service

to American Express people.
01:00:12:22 C 11 C  Pop-On We have no agenda of our own.
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Softni Files (*.sub)
You can  import/export  Softni  files  from the  Import/Export  menu.  There  is  a  sample 
Softni file Softni.sub in the C:\Program Files\CPC\CaptionMaker\Samples folder. Here 
is a sample of the file:

*PART 1*
01:00:00.00\00:00:00.00
{{MELBOURNE
01:01:04.27\01:01:07.25
[Y ahora: ¿"Qué se cocina
esta noche?",
01:01:07.25\01:01:10.01
[con sus anfitriones,
los cocineros Baffio y Jackie.
01:01:10.01\01:01:14.20
Gracias. Gracias.

When this file is imported in the CaptionMaker software, it will look like:

Start H V J Display Caption/Subtitle
01:00:00:00 C T C Pop-On MELBOURNE
01:01:04.27 C B C Pop-On Y ahora: ¿"Qué se cocina

esta noche?",
01:01:07:25 C B C Pop-On con sus anfitriones,

los cocineros Baffio y Jackie.
01:01:10.01 C B C Pop-On Gracias. Gracias.

CPC-600/CPC-700 DOS Files
A sample file in ASCII format  CPC 600-700 DOS.txt resides in the C:\Program Files\  
CPC\ CaptionMaker\ Samples folder. Here is an example of the file:

~CPCC6.70~;UpperLower;Paint-On;01;
           |         |^ This text is to practice captioning with CaptionMaker
           |         |^ Use the video segment approximately 4 minutes
           |         |^ into the CPC training video.
  01:03:24:04|0NEN|I'M AT THE LEFT\OF THE SCREEN.
  01:03:26:10|0NEN|SO CAPTIONS\OF WHAT I SAY
  01:03:27:26|0NEN|APPEAR AT THE LEFT\OF THE SCREEN, TOO.

When this file is imported in the CaptionMaker software, it will look like:

Start H V J Display Caption/Subtitle
01:03:24:04 L B L Pop-On I'M AT THE LEFT

OF THE SCREEN.
01:03:26:10 L B L Pop-On SO CAPTIONS
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OF WHAT I SAY
01:03:27:26 L B L Pop-On APPEAR AT THE LEFT

OF THE SCREEN, TOO.

CPC-715 DOS Online Files

Same as CPC/Leapfrog CCaption Files.

These files can be used with: 

1. CCaption software to add captions directly to videos coming out of the Media-
100,  Avid  and  several  other  non-linear  editing  systems  without  losing  a 
generation  of  video.  You  would  not  need  closed  caption  encoder  hardware. 
CCaption software encodes the captions on line 21 of the video.

2. DV2000 to add captions. There is no need to use CPC software to do the final 
encoding. DV2000 can read the CPC-715 online file format and add the captions 
to the video at the appropriate time.

There is a sample CPC-715 online file CPC-715 online file.txt in the C:\Program Files\  
CPC\CaptionMaker\Sample folder. The CPC-715 file looks like the following. This file 
was  generated  for Pop-On captions.  It  is  a  binary file.  It  is  actually  a  long string of 
characters that is broken up here into different lines.

CPC-715 Online CaptionMaker Datafile →☻ ♠☺ ♥☺3 2 F1♪
9 01:03:24:22¶.¶ ¶PI'M AT THE LEFT¶pOF THE SCREEN.|¶,  ¶/
4 01:03:26:21¶.¶ ¶PSO CAPTIONS¶pOF WHAT I SAY|¶,  ¶/ 
A 01:03:28:01¶.¶ ¶PAPPEAR AT THE LEFT¶pOF THE SCREEN, TOO.|¶,  ¶/

Note   When exporting to a CPC-715 online file, you must choose a 
caption  encoder  device.  If  you  don’t,  the  file  won’t  work  with 
CCaption software or DV2000.

DVD Caption Files
You can caption DVD videos using Sonic Solutions, Daikin, Spruce and most other DVD 
authoring systems. 

The DVD Caption file format is universal for all DVD authoring systems. To create a 
DVD caption file,  caption the video exactly  the same way as if  you were creating a 
caption file for conventional  video. Then go to  File →  Export menu and choose the 
group Caption Formatted File and export to DVD Caption file format.
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There  is  a  sample  file  DVD-caption.scc in  the  C:\Program Files\CPC\CaptionMaker  
\Samples  folder. The basic information for all DVD authoring systems is the same. A 
typical DVD caption file looks like this.

01:03:24:22 94AE 9420 945E 97A2 49A7 CD20 C154 2054 C845 204C 
4546 5494 FE97 A24F 4620 54C8 4520 D343 5245 45CE 
AE94 2C00 0000 0094 2F00

01:03:26:21 94AE 9420 945E 97A2 D34F 2043 C1D0 5449 4FCE D394 FE97 A24F 4620 
57C8 C154 2049 20D3 C1D9 942C 0000 0000 942F

01:03:28:01 94AE 9420 945E 97A2 C1D0 D045 C152 20C1 5420 54C8 
4520 4C45 4654 94FE 97A2 4F46 2054 C845 20D3 4352 
4545 CE2C 2054 4F4F AE94 2C00 0000 0094 2F00

Power Pixel Format Files
A sample  Power Pixel  file,  pixel-power.txt, is  included in  the  C:\ProgramFiles\CPC\  
CaptionMaker\ Samples folder. Here is an example of the file:

01:03:24:04 01:03:27:02
I'M AT THE LEFT
OF THE SCREEN.

01:03:27:02 01:03:29:18
SO CAPTIONS
OF WHAT I SAY

01:03:29:18 01:03:32:29
APPEAR AT THE LEFT
OF THE SCREEN, TOO.

When this file is imported in the CaptionMaker software, it will look like:

Start H V J Display Caption/Subtitle
01:03:24:04 C B C Pop-On I'M AT THE LEFT

          OF THE SCREEN.
01:03:27:02 C B C Pop-On SO CAPTIONS

OF WHAT I SAY
01:03:29:18 C B C Pop-On APPEAR AT THE LEFT

       OF THE SCREEN, TOO.

Windows CaptionMaker File 
Import/Export from and to Windows CaptionMaker File (*.cap) are the same as the Open 
and Save options. For the sake of continuity they are added to this heading. 
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Import/Export to Merge Files for 
Subtitling/Captioning a Video in a 2nd 
Language

After you have created a file to subtitle or caption in one language, you can use that file 
to simplify the process of subtitling or captioning the video in additional languages. 

The basic premise is that there are certain key points (typically words, but sometimes 
pauses  or  visual  information),  which  must  appear  at  the same  time code  in  both the 
original language and in any translated language. 

In actual use you assign time codes to key words of a language that you understand, and 
your translator will be able to assign corresponding time codes to a language that you 
don’t understand.

For instance, the beginning of a person’s dialog will be a key point, a pause will be a key 
point, expressions that are visually tied up with the audio such as a person pointing and 
saying, “Look at this!” cannot afford to fall before or after it happens visually on the 
screen so it also must be a key point.

Another example is found when there is a dialog between two people. The word at which 
person #1 begins speaking is a key point. Similarly, the word at which person #2 begins 
to speak is a key point. Also, if there is a long segment of the video without dialog, the 
word at which the dialog begins again is a key point.  

The words that fall between these key points are then automatically distributed evenly by 
the software. This way the translation will fall almost precisely where it should in relation 
to timing. Care must be taken to choose these key points frequently enough to keep the 
software’s automatic pacing to a minimum.  

Put  another  way,  if  the  key  points  are  perfectly  synchronized,  then  the  rest  of  the 
subtitles/captions, which fall between the key points, will be closely synchronized with 
the dialog. This is accomplished by the CaptionMaker software automatically counting 
the words in each subtitle/caption between the key points, and assigning time codes based 
on the number  of words in  each subtitle/caption.  The greater  the number  of words a 
subtitle/caption has, the more time it will be given.

ONLY THE FIRST WORD OF A SUBTITLE/CAPTION CAN BE A KEY POINT.

THE ONLY TIME CODES THAT YOU SHOULD ENTER IN THE FILE, ARE TIME CODES FOR 
SUBTITLES/CAPTIONS THAT BEGIN WITH KEY POINTS.
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Here is an example of timing three key points in an English file (two words and one 
pause), and using that file to time a translation in French.

# Start Caption/Subtitle
1 01:00:28:28 We’ve talked about

passion for the business.
2 Passion is not something you

can teach people necessarily,
3 but you can

certainly recognize it
4 when you see it.
5 01:00:39:26
6 01:00:50:03 You’re excited to come

to work, to see everyone.

There are four steps to merge a translated file with the original file. We will describe the 
process using an English file as the original file and a French file as the merge file.

Step I
Create the English file with time code as explained in the previous section, and illustrated 
above with time codes at three key points. Inside the C:/Program Files/CPC/  
CaptionMaker/ Samples folder there is a file named Translation-English-with-tc.cap. The 
above few lines are from this file.

Step II
After  creating the English subtitle/caption file,  you need to export  the file for Merge 
option. This is done so that you can give the file to the translator, so that the translator 
will have a copy of the file with the key points. The file will have the time codes of the 
key points replaced by sequential numbers as shown in the file below. 

For example, the first key point above, 01:00:28:28 will become key point #1. The key 
point at 1:00:39:26 will become key point #2, and so on.

1. To export the file, use File → Merge Export option. 
2. Choose  the  file  type  Word  Processor [ASCII  text  file  (*.txt)  or  any  Word 

Processor type] and 
3. Press the Browse button. Choose the folder you want to save the document into 

and click on the Save button and click on Next.  

The file you just created should look like the following. Since it is a text file, you may 
open the file in Notepad and check it out.
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For your convenience, we have provided a copy of the file you just created inside the C:/
Program files/CPC/CaptionMaker/Samples folder. The file name is Translation-English-
tagged-text.txt. The following few lines are from this file.

1 We've talked about passion for the business.
Passion is not something you can teach people necessarily,
but you can certainly recognize it
when you see it.
2
3 You're excited to come to work, to see everyone.

Step III
This is the file you must provide to the translator.  The translator should give you the 
translated file in French as shown below, following the guidelines in the next section, 
“Instructions to the Translator”.

An example of the translator’s completed file is also provided for your convenience. It is 
inside  the  C:/Program  files/CPC/CaptionMaker/Samples  folder.  The  file  name  is 
Translation-French-tagged-text.txt. The following few lines are from this file. 

1 On parle souvent de la passion pour son travail.
La passion ne s'apprend pas,
mais on la ressent immédiatement chez les autres.
2
3 Il est stimulant de se rendre au travail
et de revoir tout le monde.

Note    This file could be in a Word, WordPerfect or text file. If it is a 
text file created from Word, save it using the MS DOS Text with Line 
Break option under File → Save As. If the language used is anything 
other  than  a  Western  European  language,  you  must  import  and 
export the files for Merge option in Word. (Word is the best choice, 
but WordPerfect files also work in most languages.) The translator 
must use the same program and preferably the same Windows font 
to avoid conflict with character positions.

Step IV
Now  you  must  merge  the  Translation-French-tagged-text.txt with  the  Translation-
English-with-tc.cap to combine the time codes from the English file with the text from 
the French file according to the tagged numbers associated with the French file.

1. Go to File → Open and open the file Translation-English-with-tc.cap
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2. Go to File → Merge Import option and choose Word Processor [ASCII text file 
(*.txt) or any Word Processor type] and click on the Browse button. 

3. Select the file Translation-French-tagged-text.txt and click on Open. 
4. Click on Finish.

The end result would look something like the image below. Now the French file has all 
the time codes from the English file at the appropriate places.

# Start Caption/Subtitle
1 01:00:28:28 On parle souvent

de la passion pour son travail.
2 La passion ne s’apprend pas,
3 Mais on la resent

immédiatement chez les autres.
4 01:00:39:26
5 01:00:50:03 Il est stimulant

de se render au travail

Step V
Here is the final step. To fill in the blank time codes between the existing time codes at 
the key points, click on the header Start above the time code area to highlight the time 
code column. Right-click on anywhere on the highlighted area and choose  Fill-in time 
code. Inside the Fill-in time code dialog box choose the second radio button to fill in time 
codes for the blank time codes only.

You will see the all the blank time codes are filled with appropriate time codes giving the 
same reading speed for all captions/subtitles between two key points.

You should AutoSync the whole file with the video and make sure the timing is all right. 
You may have to alter some time codes for caption/subtitles that consist of one or two 
words. 

Instructions to the Translator 

How to Translate CPC Subtitle/Caption Files into 
Another Language

Here  is  an  example  of  a  translation  of  an  English  subtitle  file  to  French  using  the 
CaptionMaker software. You (the translator) should receive an English file with numbers 
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(corresponding to key points) interspersed at the left margin as shown below. Notice that 
each number is followed by a tab.

ORIGINAL CPC FILE IN ENGLISH
1 We've talked about passion for the business.
Passion is not something you can teach people necessarily,
but you can certainly recognize it
when you see it.
2
3 You're excited to come to work, to see everyone.
4 Not only do we have our regular customers
but I get excited when they walk in the door.
It's nice to see them all the time
and we have people that come in every day.
5
6 When I interviewed with Pier 1 I had that sense
that this was a company with destiny.
There were about 70 people
who applied for a manager in training position
and I banged on the door every morning for about two weeks
to sign up with the company.
7
8 My first paycheck said this is brought to you
by your customers.
It really said this is what this company is about.
9
10 You have to have a passion for this business.
I think that most managers do have a passion
for this business.
The desire to make the most of it
and take every opportunity.
11
12 I love this company and I tell everybody
if we could hire so many people to work for Pier 1
I would completely suggest that you put
in your application and try to get a job there.
13 It's so awesome they treat you like
you're their own kids and it's just an amazing feeling.
14

You (the translator) should:

1. Freely translate the English into French. Ignore the numbers in the left margin.
2. Find the locations in the French file that correspond to the location of the numbers 

at the left margin of the English file, and enter the numbers in the French file. 
After you enter each number, place a tab.  Notice that the English file has some 
blank lines. You must add blank lines in your translated file too, and add the 
correct number next to it.
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WARNING   YOU MUST NOT MISS ANY NUMBER, AND YOU MUST 
PRESS TAB AFTER EACH NUMBER, OR THE SOFTWARE WILL NOT 
BE ABLE TO SUBTITLE THE VIDEO.

3. (Optional Step – Ask your contact if this is necessary): Break the text between 
numbers into individual subtitles. To indicate a new subtitle, place the first word 
of the subtitle at the left margin.

4. (Optional  Step – Ask your contact if this is necessary):  Break each individual 
subtitle into one, two or if absolutely necessary, three lines. To indicate a new line 
within a subtitle, place a tab within the line at the place where you want the new 
line to begin.

General Guidelines
Subtitles are not to be translated verbatim. They should be edited to make the text as 
compact  as possible  without  losing the essence of the dialog.  Remember,  the viewer 
reads subtitles while watching the video. Brief, concise subtitles are easier to read. 

As you see in the English files, the text is broken into different lines. Each line is a 
subtitle. No lines should be more than 40 characters. 

The number of text lines between two key numbers on the left of the page in the English 
file and the French file need not be the same.  For example, you could have 3 lines in 
English and 5 lines in French.  But if you edit the text to make it as compact as possible, 
in most cases you will have fewer lines than the English file. That’s even better for the 
viewers. They can read the subtitles more easily, since there is less to read.

The amount of text between two numbers can vary, but the key numbering on the files 
must be the same.  For example, please check the English file on the previous page.  On 
that page, there are 14 key numbers, and 35 lines (including blank lines).  If you turn to 
the next page you will see an example of the same file translated to French.  In the French 
file, there are 14 key numbers, and 38 lines (including blank lines). The fact that there are 
more  lines  of  text  does  not  matter;  what  is  important  is  that  the  key  numbers  are 
preserved.

Also notice that sometimes there is a tab inside a line in the English file. The tab indicates 
where the subtitle is eventually going to be broken up into a two-line subtitle. (e.g., My 
house is very beautiful.) Do not worry about the tab in the English file. 

After you are done translating, compare your file with the English file and simply add 
numbers  in  the French file  at  the corresponding points  where numbers  appear  in  the 
English file.
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WARNING  AGAIN, IT IS  CRITICAL THAT THE NUMBERING IN THE 
TRANSLATION  FILE  IS  THE  SAME  AS  THE  NUMBERING  IN  THE 
ORIGINAL FILE. 

IN  THIS  EXAMPLE,  THE ENGLISH FILE HAS  14 NUMBERS,  EACH 
FOLLOWED BY A TAB. THEREFORE THERE SHOULD BE EXACTLY 
14  NUMBERS  IN  THE  FRENCH  FILE  IN  CORRESPONDING 
LOCATIONS, EACH FOLLOWED BY A TAB.

PLEASE TAKE WHATEVER EXTRA TIME IS NEEDED TO DO THIS! IT 
IS THAT IMPORTANT!

The  translated  French  file  you  would  provide,  with  numbers  corresponding  to  the 
previous English file, is shown below.

TRANSLATED FRENCH FILE
1 On parle souvent de la passion pour son travail.
La passion ne s'apprend pas,
mais on la ressent immédiatement chez les autres.
2
3 Il est stimulant de se rendre au travail
et de revoir tout le monde.
4 Nous avons des clients réguliers
et nous éprouvons toujours le même plaisir,
lorsqu'ils reviennent magasiner chez nous.
5
6 Lors de mon entrevue chez Pier 1,
j'ai compris que mon avenir était ici.
Près de 70 personnes avaient postulé
pour le poste de directeur de la formation.
J'ai frappé à la porte,
presqu'à tous les matins pendant deux semaines,
pour obtenir ce poste.
7
8 Lorsque j'ai reçu mon premier chèque,
j'ai eu l'impression qu'il me disait:
"Ce sont tes clients qui te paient."
Cela reflète exactement la philosophie de la compagnie.
9
10 Il faut vraiment que ce travail
soit une passion et je crois que les directeurs
éprouvent ce sentiment pour leur travail.
Ils désirent en retirer le maximum et saisir
toutes les opportunités qui s'offrent à eux.
11
12 J'adore cette compagnie et comme je le dis toujours:
"Si Pier 1 pouvait engager tout le monde, il le ferait.
Entre-temps, je vous recommande fortement de soumettre
une demande d'emploi et peut-être aurez-vous
la chance de faire partie de notre grande famille.
13 C'est une merveilleuse expérience croyez-moi,
la compagnie traite ses employés
comme s'ils étaient ses enfants.
14



C h a p t e r  4
Ca p t i o n / S u b t i t l e  P r e p a r a t i o n

Note to Subtitling Users
In the interest of efficiency, we have combined the captioning and subtitling tutorials into  
a  single  chapter  because  they  share  many  common  procedures.  When  we  refer  to 
captioning, we mean captioning and subtitling unless otherwise noted. 

If you are planning to subtitle (where positioning is normally only at the bottom of the 
screen), you need to go through the tutorial in this chapter only in order to understand 
the basics of formatting, positioning and time coding. For features associated with the  
specific subtitling devices (Chyron Codi, DVD, DV2000, or MagniCoder Pro),  please  
consult the relevant sections of Chapter 5.

Screen Layout
There are five major regions of the CaptionMaker screen. (See screenshot on next page.)

1. At the top of the screen, there is a menu bar (File, Edit, View, and so on). 
2. Below the menu bar is the optional edit toolbar (with buttons for file operations, 

text positioning, justification, attributes, and so forth). 
3. At the top left side of the screen is a window that is initially (before a video signal 

is sent to the computer) a blue rectangle. This is called the Video Preview 
Window, or simply the Preview Window. 

4. In the top right corner, the Operations Center, there are four rows of buttons, 
subdivided into regions for Preview Window Operations, Row Operations, VTR 
Control, Miscellaneous Controls and Time code.

5. At the bottom of the screen is a section called the Work Area. You can navigate 
through this as you would in a spreadsheet, using the mouse and arrow keys.

Visible Columns
Make sure that all the columns shown on the following screen are visible on your 
computer screen. If they are not all visible, click on the View menu and check the 
appropriate boxes. You can add additional columns like
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• Stop time
• Time code Duration
• Words per minute

etc. to suit your needs.

Computer Display Screen Resolution
The CaptionMaker works at screen resolutions of 800 x 600 or higher. If your computer 
monitor display is below that, go to Start → Settings → Control Panel → Display and 
change the screen resolution under the Settings tab to at least 800 x 600.

CaptionMaker Screen

Full View or View with Preview Window
You may switch between two different views of the CaptionMaker screen:

Preview video screen with a few lines of caption/subtitle text, or 
Full view of Caption/Subtitle text with no video screen.

To access these two views, click on the View → Full Screen Spreadsheet from the View 

menu, or you may click on the Preview Window Switch icon: 

Edit
Toolbar

Video
Preview
Window

Work 
Area

Menu 
Bar

Operations 
Center
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When you need to watch the video on the computer screen and place the caption/subtitle 
at  the appropriate  position  on the video,  use the option  Preview Window.  When you 
would like to do a large amount of editing and need to see as much text as possible, turn 
off the Preview Window option.

Repositioning Preview Window   If  you would like to see the full-
screen text view and the video at the same time, you may click on the 
Pop-Up Preview Window icon  to open up the Preview Window on 
top of the full screen view and position the video screen anywhere 
you like by simply dragging the window with the mouse.

The Captioning Process
This chapter concentrates on formatting, positioning and associating time codes with text 
in  the  context  of  captioning  a  video.  We  also  discuss  the  four  display  modes  for 
captioning: Pop-On, Paint-On, Roll-Up, and Block Roll-Up. 

An exhaustive, detailed explanation of all captioning and subtitling capabilities plus an 
explanation of all the menu items and toolbar icons can be found in Chapters 8 and 9.

Video Tutorials
Please check the video tutorial page at http://www.cpcweb.com/tutorial/mac_index.htm 
for tutorials on many topics such as
Importing Text (1:16)
Importing Video (0:48)
Formatting Text Basic Tools (2:27)
Formatting Text Advanced Tools (1:31)
Synchronizing Captions (Timing) (3:17)
Checking your Timing (1:22)

http://www.cpcweb.com/tutorial/windows/CheckTiming.wmv
http://www.cpcweb.com/tutorial/windows/timing.wmv
http://www.cpcweb.com/tutorial/windows/Formattingtextadvanced.wmv
http://www.cpcweb.com/tutorial/windows/Formattingtextbasic.wmv
http://www.cpcweb.com/tutorial/windows/ImportingVideo.wmv
http://www.cpcweb.com/tutorial/windows/ImportingText.wmv
http://www.cpcweb.com/tutorial/mac_index.htm
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Caption Display Modes
There are four display modes for closed captions: Pop-On, Paint-On, Roll-Up, and Block 
Roll-Up.  The  first  tutorial  in  this  chapter  will  concentrate  exclusively  on  Roll-Up 
captioning, which is the easiest to learn. Plus it takes less time to caption a video in the 
Roll-Up mode than in the Pop-On or Paint-On modes. You can choose one or multiple 
cell under the Display column, and right click to change the display mode to your choice.

Roll-Up captions are typically used for television news, live events and videos involving 
one person on the screen – typically a classroom lecture or training video. The Pop-On 
mode is normally used for movies and sit-coms. The Paint-On mode is rarely used. It is 
similar to the Roll-Up mode. Block Roll-Up is a style coined by CPC. All four styles can 
be used within the same captioning job. (See details in this chapter.)

The captioning process can be described in a few steps. Note that the CaptionMaker-Live 
does not use time code, and the CaptionMaker-Classic or higher versions do. When time 
code is discussed in this manual, we are referring to use of the CaptionMaker-Classic or 
higher versions.

Entering the Script  
If you do not have a script of the video, you can get the script in many ways, such as: 

If you use a digital video, you can use foot pedal controller vPedal to transcribe the video. 
For details check the page: http://www.cpcweb.com/caption_common/VPedal-
AllAbout.pdf 
Train a speech recognition software such as Naturally Speaking or ViaVoice 
(www.nuance.com) for a few hours. Then listen to the videotape and repeat the dialogue 
into the microphone. At the beginning, you are going to get lot of errors. But you can 
teach the software to fix the errors and down the road you can expect to get about 95% 
accuracy. For details check this page: 
www.cpcweb.com/caption_common/cap_via_voice.htm 
Dubbing the audio onto a tape and use a Dictaphone® machine can speed up this process. 
Use a professional transcription service. This is the most expensive way to generate the 
script.

The CaptionMaker can import scripts from a text file and most word processors (such as 
WordPerfect and Microsoft Word) files.

Transcribing Digital Video 
We do not recommend transcribing your videos from within CaptionMaker. It is much 
better  to transcribe the video using WMP with your  Word Processor or with the free 
shareware software Express Scribe.

http://www.cpcweb.com/caption_common/cap_via_voice.htm
http://www.nuance.com/
http://www.cpcweb.com/caption_common/VPedal-AllAbout.pdf%20
http://www.cpcweb.com/caption_common/VPedal-AllAbout.pdf%20
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We designed CaptionMaker in a way to make it most efficient to import a free form text 
file and break them into individual captions using some simple conditions like:
1. Maximum caption length (like 28 characters)
2. Maximum number of lines in each caption (like 2 lines)
3. Break at punctuation points.

With these types of conditions,  CaptionMaker can break a transcript for an hour-long 
video into nice looking captions in a few seconds.

We do not recommend breaking the text into individual captions while you transcribe. 
Let CaptionMaker handle this for you to save you a lot of time.

Transcription  Mode  If  you  must  transcribe  the  video  within 
CaptionMaker, there is a transcription mode under File menu. Also 
added an indicator in the status bar to indicate when transcription 
mode is  enabled.  Transcription  mode can be enabled/disabled  by 
clicking on this indicator with the mouse. 

When transcription mode is enabled, pressing “Enter” will cause the 
cursor to move down to the next caption cell. If you have the time 
code stamp active,  time code is  automatically  read as the cursor 
moves to the next cell.

Transcribe using VPedal with Windows Media Player
Download and install the Windows Media Player plug-in (free) at: 
http://www.vPedal.com/wmp9.php

Configuring vPedal Media Player Plug-In
• After you’ve installed it, go to Start >> Programs >>vPedal Media Player Plug-

In >> Direct Launch Plug-In
• It will open up a tiny Windows Media Player window
• To begin playing the video simply go to  Options >> Open File and change the 

pull-down tab to “All Files” to play the video you wish to transcribe
• There are no settings or configurations you need to setup. The vPedal will operate 

the play, pause, forward, and rewind functions of the video
• When you hit pause, and then resume again, the video will skip back 1 second so 

you do not have to rewind
• To change this skip time to something longer than the 1 second default,  go to 

Options >> Settings and change the value in the Release Back Seconds field
• To change how fast the video plays, go to  Options >> Settings and adjust the 

percentage in the Speed field
•

http://www.vpedal.com/wmp9.php
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Transcribing in your Word Processor
• To begin transcribing, simply open your Word Processor and begin typing. The 

vPedal will still control the video even if it is not on top.

• If you want to see the video while transcribing, re-size your word processor to 
give the video enough space to stay on screen while you type.

QuickTime, RealOne Videos
vPedal cannot control the Quicktime or RealOne videos in Windows. To use VPedal with 
Quicktime or RealOne videos, you need to download the codecs that allow you to play 
Quicktime and RealOne videos in Windows Media Player. 
RealPlayer: http://www.free-codecs.com/download/Real_Alternative.htm 
Quicktime: http://www.free-codecs.com/download/QuickTime_Alternative.htm     

VPedal has plug-ins to work with iTunes, RealOne, Winamp, and FTR player. To view a 
full list of the plug-ins available for use with VPedal visit 
http://www.vPedal.com/support.htm

Working  with  Digital  Videos  If  you  are  using  CaptionMaker-DV or 
CaptionMaker-NLE or  CaptionMaker-HD Enterprise,  please  refer  to 
the section Working with Digital Videos near the end of this chapter on 
how to handle a digital  video. The following section describes the 
complete captioning process using a videotape as opposed to digital 
video. All processes are exactly the same except handling the digital 
video and video from a videotape is slightly different. 

Playing Video
You can play video coming from a digital  video (like avi,  qt,  mpeg,  wmv etc.)  or a 
videotape.  To  play  video  coming  from a  videotape  you  would  need  a  video  display 
device like Pinnacle DVC-80. If you use DVC-80, connect the video from the VCR to the 
yellow jack  of  DVC-80.  Connect  audio  to  the  sound card,  not  to  the  white  and red 
connector on the DVC-80. 

Click on the camcorder icon  on the right side of the preview window. Check the box 
Enable External video from a tape.

Reading Timcode
If you are using a digital video, choose Video Playback. 

http://www.vPedal.com/support.htm
http://www.free-codecs.com/download/QuickTime_Alternative.htm
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If you are using a videotape, and like to read timecode (not available with CaptionMaker-
Live) from the videotape, you need to select the proper timecode option. Click on the 
Timecode >> Timecode Reader Properties or, click on the   button and choose the 
appropriate option. 

Roll-Up Captioning Not Using Time Code
We will start with Roll-Up captioning without time code. Roll-Up captioning is a good 
starting point because it is the easiest method to learn and use. Because you do not need 
time code, you can even use a VHS tape without time code to caption. In other words, 
with minimal time, effort and equipment, you can get your feet wet and actually do some 
real captioning. 

Method I: Manual Captioning
1. Transcribe the text from the video.
2. Import a raw text file. The Import menu offers many formatting features to 

help you break raw text into individual captions.
3. Manually further refine the imported text into individual captions
4. Place the captions at a desired screen location and decide if the text is to be 

italicized, underlined or otherwise formatted (requires viewing the video).
5. Manually send captions to the caption device (Step 4a later in this chapter).

Transcribing the video
If you do not have a script of the video, you can get the script in many ways, see the 
section Entering the Script above.

We do not recommend transcribing your videos within CaptionMaker. It is much better to 
transcribe the video first and then import the script into CaptionMaker.

We designed CaptionMaker in a way to make it most efficient to import a free form text 
file and break them into individual captions using some simple conditions like:
1. Maximum caption length 
2. Maximum number of lines in each caption 
3. Break at punctuation points.

With these types of conditions,  CaptionMaker can break a transcript for an hour-long 
video into nice looking captions in a few seconds. We do not recommend breaking the 
text into individual captions while you transcribe. Let CaptionMaker handle this for you 
to save you a lot of time.
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The CaptionMaker can import scripts from a text file and most word processors (such as 
WordPerfect and Microsoft Word) files.

In Roll-Up captioning, each row in the Work Area equals one caption line of up to 32 
characters. The easiest and most efficient way to begin the process of Roll-Up captioning 
is  to  enter  the  dialogue  that  is  on  the  video  into  Word  (or  almost  any  other  word 
processor), and let the computer automatically format each line as you import your script.

See the beginning of the section, “Transcribing and Importing Script” under the “Pop-On, 
Paint-On and Block-Roll-Up Captioning” section later in this chapter to find out how to 
transcribe your text.

Assume that you initially entered the text to be captioned into any word processor like 
MS Word. To speed the text entry into Word, the only formatting you need to do in Word 
is to enter periods, commas, semicolons, etc. You do not need to break the text up into 
paragraphs, and certainly do not need to break the text up into individual captions. After 
entering all of the text, you would end up with one giant paragraph, with the text broken 
up into sentences within that paragraph. 

Next we will  show how the CaptionMaker breaks the text into individual  captions at 
sentence punctuations (.?!) automatically.

To illustrate this, we will start with our demo.txt file, which is found on the C:\Program 
Files\CPC\CaptionMaker\Samples folder. After you select the option File → Import and 
choose the file type ASCII text file from the  Samples folder and click on the  Browse 
button, the computer will prompt you to choose the import file format. Choose the Free 
Form format as shown below and then click on Next.

The following dialog box will open.

Free Form

• Import file where caption/subtitle rows are composed by breaking the text 
into sections based on punctuation (“end-of-sentence”) markers or 
paragraph breaks.
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Check the appropriate boxes as shown below and fill-in the necessary boxes.
Start a row with is a custom character function. This allows you to let CaptionMaker 
start a new row whenever it encounters a particular character while importing text. Note 
that CaptionMaker also properly handles multiple consecutive instances of the character. 
For example, if you select the “>” character, CaptionMaker will start a new row when it 
sees “>”, or “>>”, or “>>>”, etc.

Make sure you break the script into individual captions with the following conditions:

1. Each row made of: 1 line of text
2. Start of new record: End of sentence punctuation points
3. Max characters per line: 29

Note on “Each row made of”  The selection of  Each Row made of [1]  
line(s) of text is extremely important. You must always select 1 line 
per  row  (cell)  when  captioning  in  the  Roll-Up  mode,  or  else  the 
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captions  will  not  roll  up  properly.  (The  other  selections  can  be 
changed to meet your specific formatting needs.)

The above choices will result in:

1. Each row of text will contain only one line.
2. Put  as  many  words  as  possible  into  each  caption  cell,  until  the  number  of 

characters in the words reaches a maximum of 28. Once that limit is reached, the 
next word becomes the first word of the following caption.

3. The only exception to the above occurs at the end of a sentence. The first word of 
a new sentence will always become the first word of a caption. The reason for this 
is that captions typically correspond to naturally occurring pauses in speech. And 
at the end of a sentence there is always a pause. 

In the example that follows, the second caption consists of only one word, “SCREEN.” 
The reason of course is that it is the last word of the first sentence.

Up to this point text has been entered into a word processor and then imported into the 
CaptionMaker, and we have a text file automatically broken up into individual captions.

The Import Option choices will format the text as follows. 

Row H V J Display Caption/Subtitle
1 5 B C Roll-Up 3 I'M AT THE LEFT OF THE
2 5 B C Roll-Up 3 SCREEN.
3 5 B C Roll-Up 3 SO CAPTIONS OF WHAT I SAY
4 5 B C Roll-Up 3 APPEAR AT THE LEFT OF THE
5 5 B C Roll-Up 3 SCREEN, TOO.
6 5 B C Roll-Up 3 NOW I'M AT THE RIGHT OF THE
7 5 B C Roll-Up 3 SCREEN, SO MY CAPTIONS
8 5 B C Roll-Up 3 APPEAR AT THE RIGHT.
9 5 B C Roll-Up 3 NOW I AM GOING OFF-SCREEN.
10 5 B C Roll-Up 3 TO INDICATE THAT I'M
11 5 B C Roll-Up 3 OFF-SCREEN, WHATEVER I SAY
12 5 B C Roll-Up 3 IS ITALICIZED.
13 5 B C Roll-Up 3 NOW MY NAME APPEARS AT THE
14 5 B C Roll-Up 3 BOTTOM OF THE SCREEN, WE
15 5 B C Roll-Up 3 PUT CAPTIONS OF WHAT I SAY
16 5 B C Roll-Up 3 AT THE TOP, SO THAT MY NAME
17 5 B C Roll-Up 3 IS NOT COVERED BY CAPTIONS.
18 5 B C Roll-Up 3 UP UNTIL NOW, WE HAVE BEEN
19 5 B C Roll-Up 3 USING POP-ON CAPTIONS.
20 5 B C Roll-Up 3 WHEN A NEW CAPTION POPS ON,
21 5 B C Roll-Up 3 THE OLD CAPTION DISAPPEARS.
22 5 B C Roll-Up 3 THIS IS A PAINT-ON CAPTION.
23 5 B C Roll-Up 3 ONE CAPTION BLOCK IS
24 5 B C Roll-Up 3 PAINTED ON THE SCREEN, FROM
25 5 B C Roll-Up 3 LEFT TO RIGHT, ONE
26 5 B C Roll-Up 3 CHARACTER AT A TIME.
27 5 B C Roll-Up 3 NOW THE ROLL-UP MODE.
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28 5 B C Roll-Up 3 THIS MODE IS NORMALLY USED
29 5 B C Roll-Up 3 FOR TV NEWS PROGRAMS.
30 5 B C Roll-Up 3 CAPTION LINES ROLL UP FROM
31 5 B C Roll-Up 3 THE SCREEN BOTTOM ONE LINE
32 5 B C Roll-Up 3 AT A TIME.
33 5 B C Roll-Up 3 Captions can appear in
34 5 B C Roll-Up 3 lower case, and also in
35 5 B C Roll-Up 3 Spanish: ¿Dónde está el
36 5 B C Roll-Up 3 niño?
37 5 B C Roll-Up 3 Está en la casa.
38 5 B C Roll-Up 3 And in French: Parlez-vous
39 5 B C Roll-Up 3 français?
40 5 B C Roll-Up 3 Répétez, s'il vous plâit.
41 5 B C Roll-Up 3 THE FOLLOWING SPECIAL
42 5 B C Roll-Up 3 CHARACTERS ARE ALSO
43 5 B C Roll-Up 3 AVAILABLE.
44 5 B C Roll-Up 3 á é í ó ú à è ì ò ù ä ë ï ö
45 5 B C Roll-Up 3 ü â ê î ô û THEY INCLUDE
46 5 B C Roll-Up 3 THE MUSIC SYMBOL AND
47 5 B C Roll-Up 3 ACCENTED CHARACTERS.
48 5 B C Roll-Up 3 ç ã ñ õ å ¿ ¡ ¢ £ ¥ © ® ™ °
49 5 B C Roll-Up 3 ß §

For instructive purposes, we purposely inserted two sections in which the text should be 
further refined to improve the appearance of the captions. In the CaptionMaker directory, 
there is a file called  Demo-R.cap. Open this file into the CaptionMaker using the Open 
option under the File menu as opposed to the Import option. This file is slightly different 
from the file shown above. We further refined the lines 35 through 49 using Push and 
Pull functions (See “Step 2: Refining Text into Captions” later in this chapter.)

35 5 B C Roll-Up 3 Spanish: 
36 5 B C Roll-Up 3 ¿Dónde está el niño?
37 5 B C Roll-Up 3 Está en la casa.
38 5 B C Roll-Up 3 And in French:
39 5 B C Roll-Up 3 Parlez-vous français?
40 5 B C Roll-Up 3 Répétez, s'il vous plâit.
41 5 B C Roll-Up 3 THE FOLLOWING SPECIAL
42 5 B C Roll-Up 3 CHARACTERS ARE ALSO
43 5 B C Roll-Up 3 AVAILABLE.
44 5 B C Roll-Up 3 á é í ó ú à è ì ò ù 
45 5 B C Roll-Up 3 ä ë ï ö ü â ê î ô û 
46 5 B C Roll-Up 3 THEY INCLUDE THE MUSIC SYMBOL 
47 5 B C Roll-Up 3 AND ACCENTED CHARACTERS.
48 5 B C Roll-Up 3 ç ã ñ õ å ¿ ¡ ¢ £ 
49 5 B C Roll-Up 3 ¥ © ® ™ ° ß §

Also notice the Horizontal (H) and Display columns. We also changed all the cells under 
the  Horizontal  column  to  5.  This  is  done  by  left-clicking  on  the  header  H of  the 
Horizontal column and right-clicking on any cell under H and choosing 5 from the option 
Other.  This  gives  us  a  left  indentation  of  4  characters:  the captions  start  at  the  fifth 
column. Remember we chose 28 characters as the maximum caption length. Added to the 
indentation  of  4  characters,  this  makes  a  total  length  of  32,  which  is  the  maximum 
allowable length from the left side of the screen to the right.
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We also need to change the Display Mode to Roll-Up. Left-click on the header Display. 
Now right-click on any cell under Display and choose Roll-Up 3 Lines. This will change 
all the cells to Roll-Up 3. This selection will display a maximum of 3 lines of captions on 
the video at any given time. 

Finally,  to  see  captions  on  the  video  screen  for  the  text  above,  we have  provided  a 
videotape to be used with this tutorial. This tutorial text starts at about 3.5 minutes from 
the beginning of the video right after this screen:

Now we will show you
how the CaptionMaker

software works.

As you view the segment starting at burn-in time code 00:19:55:04 on the top left corner 
of  the  video,  you  will  see  our  narrator  Valerie  on  the  left  of  the  screen.  Ignore the 
different positions of the narrator. Positioning captions on the screen above or below the 
person is used for Pop-On and Paint-On caption modes.

For the rest of the captioning job, follow Step 4a for non-time code captioning later in the 
manual. Steps 4b and 5 are used for time code-based captioning. 

Notes on Roll-Up Captioning
1. Pop-On and Paint-On captions  can be placed in  any of 15 rows on the video 

screen and can have a maximum of 32 characters. But Roll-Up captions can be 
placed in only the first 4 rows and last 4 rows on the video screen. To place Roll-
Up captions anywhere within these allowable rows, you need to right-click on the 
cell under the  V Column and choose from the choices  Top, Bottom, Other (Not 
Center). If you choose Other, you may choose 1, 2, 3, 4 or 12, 13, 14 and 15. The 
first row is same as T (Top) and the 15th row is same as B (Bottom). You may 
highlight a number of cells under the V column and right-click on it to change the 
row position for a number of rows in one stroke.

2. Roll-Up captioning is available for 2, 3 or 4 lines of captioning. When you choose 
any one of these modes, you will see a maximum of 2, 3 or 4 lines of text on the 
video monitor. Make a note that Preview Window will still show only one line of 
text.

3. When you press the [+] key to send the captions one line at a time, the text starts 
to appear on the video screen immediately, one character at a time. This makes it 
feasible to caption a video on the fly.  You can work without time code if you 
wish. On the other hand, if you choose Pop-On mode, you will notice that there is 
a delay of a second or so for the caption to appear after you press the [+] key. It is 
not possible to use Pop-On caption mode without time code. Use of time code 
fixes the delay problem internally as will be explained later.
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4. You may use the Block-Roll-Up captioning mode to give the same feel as the 
Pop-On or Paint-On caption mode. Captions go out on the fly immediately as you 
press the [+] key. You can also position the captions to the left, center and right. 
To use Block-Roll-Up mode, you must have more than one line of text in one row 
under  the  Caption/Subtitle column.  (See  section  under  “Pop-On,  Paint-On 
Block-Roll-Up Captioning” later in the manual.)

5. If there is more than one person on the video screen, to distinguish the speakers, 
you need to use the following technique. Use the symbol 

> for the first person and 
>>  for the second person
>  for the third person (if exists) or for the first person.

The use of > and >> alternatively distinguishes one speaker from the other. 

> Speaker one talking
Speaker one still talking
Speaker one still talking
Speak one still talking
>> Speaker two talking

Speaker two still talking
> Back to speaker one 

Speaker one still talking
>> Speaker three talking

 

6. Keep in mind that the maximum number of characters you can fit in one line is 
32. So if you have an indentation of 4 characters (horizontal position H = 5), and 
like to put one or two > symbols for change of speakers, you should import the 
original text file with no more than 25 ( = 32 – 4 – 3) characters per row.

7. To clear captioning from the screen when there is no one speaking for more than 
3 seconds or so, you can clear the captions by inserting blank row.

Reformatting Captions  After you import a file and work on it for Pop-
on or Roll-up display modes, if you change your mind, you may use 
3 reformat functions from the Format menu to change the file  for 
Pop-On or Roll-Up modes. See the section Reformat Rows in Chapter 
8: Menus for details.



72 CaptionMaker for Windows

Pop-on, Paint-On and Block-Roll-Up Captioning

Method II: Manual Captioning
1. Import a raw text file. The Import menu offers many formatting features to help 

you break raw text into individual captions.
2. Manually further refine the imported text into individual captions
3. Place the captions at a desired screen location and decide if the text is to be 

italicized, underlined or otherwise formatted (requires viewing the video).
4. Manually send captions to the caption device (Step 4a).

Method III: AutoSync Captioning with Time Code
1. Import a raw text file. The Import menu offers many formatting features to 

help you break raw text into individual captions.
2. Manually further refine the imported text into individual captions.
3. Place the captions at the desired screen location and decide if the text is to be 

italicized, underlined or otherwise formatted.
4. Associate time code on the video with each caption (Step 4b).
5. AutoSync captions with the video using time code (Step 5a).

Method IV: AutoSync Captioning with PC System Timer
1. Import a raw text file with special formatting. The Import menu offers many 

formatting features to help you break raw text into individual captions.
2. Manually further refine the imported text into individual captions
3. Place the captions at the desired screen location and decide if the text is to be 

italicized, underlined or otherwise modified.
4. Manually associate PC System Timer time stamps with captions (Step 4c).
5. AutoSync captions with the video using time stamps. (Step 5b).

Sample text files are included with CPC software for use in the tutorial. These files will 
help illustrate how you will go through each step to create the final formatted file with 
time  code  from a  raw text  file  These  files  are  located  in  the  home directory  of  the 
CaptionMaker (usually  C:\Program Files\CPC\CaptionMaker). The caption script files 
supplied are:

Filename Description
Demo.txt Raw text (ASCII text).
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Demo1.cap After opening Demo.txt in the CaptionMaker, the file looks like 
this. (Step 1)

Demo2.cap After breaking up text into individual captions (Step 2).
Demo3.cap After positioning captions on the screen (Step 3).
Demo.cap
Demo-R.cap

After associating time codes with each caption (Step 5).
Demo text formatted for Roll-up captions.

Step 1: Transcribing and Importing Script
If you do not have a transcript of the video, read the section Entering the Script at the 
beginning of this chapter.

For  this  tutorial  you  have  a  file  Demo.txt in  the  folder  C:\Program  Files\CPC\  
CaptionMaker\ Samples folder, so you do not need to transcribe it. Import the file by 
using  File → Import option. Choose  Files of Type  as  ASCII Text Files (*.txt) and the 
make sure that Look In folder is C:\Program Files\CPC\CaptionMaker\Samples in order 
to have the icon for Demo.txt appear. Double-click on the Demo.txt icon.

See Chapter 3 for details on importing various kinds of word processor files.

Import Dialog Box
The  Import ASCII  File dialog box will  appear,  which gives  you several  options  (see 
graphic on next page).

1. Select the first option, Free Form.
2. Under Options, choose the end-of-sentence punctuation option (radio button).
3. Under Options, choose the default settings for the maximum characters per line 

(default is 26) and the maximum number of lines per cell (default is 2). The 
CaptionMaker will use these last two factors to break the text into different cells. 

4. Make sure the Square-up text box is checked. Press the OK button.

Free Form

• Import file where caption/subtitle rows are composed by breaking the text 
into sections based on punctuation (“end-of-sentence”) markers or 
paragraph breaks.
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Check the appropriate boxes as shown below and fill-in the necessary boxes.
Start a row with is a custom character function. This allows you to let CaptionMaker 
start a new row whenever it encounters a particular character while importing text. Note 
that CaptionMaker also properly handles multiple consecutive instances of the character. 
For example, if you select the “>” character, CaptionMaker will start a new row when it 
sees “>”, or “>>”, or “>>>”, etc.

End a row with is a custom character function. This allows you to let CaptionMaker end 
the current row whenever it encounters a particular character while importing text. For 
example a new caption starts after the phrase [applause].

Tip    Even  though  one  caption  line  can  hold  a  maximum  of  32 
characters, it is customary to limit captions to around 26, which is 
the default used in this program. If you play with numbers between 
24 and 32 you will see how the appearance can vary.
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The Demo.txt File
If you were to examine the file (in Notepad, for example) before import, it would look 
like this

I'M AT THE LEFT OF THE SCREEN. SO CAPTIONS OF WHAT I SAY APPEAR AT 
THE LEFT OF THE SCREEN, TOO. NOW I'M AT THE RIGHT OF THE SCREEN, 
SO MY CAPTIONS APPEAR AT THE RIGHT. NOW I AM GOING OFF-SCREEN. TO 
INDICATE THAT I'M OFF-SCREEN, WHATEVER I SAY IS ITALICIZED. NOW MY 
NAME APPEARS AT THE BOTTOM OF THE SCREEN, WE PUT CAPTIONS OF WHAT 
I SAY AT THE TOP, SO THAT MY NAME IS NOT COVERED BY CAPTIONS. UP 
UNTIL NOW, WE HAVE BEEN USING POP-ON CAPTIONS. WHEN A NEW CAPTION 
POPS ON, THE OLD CAPTION DISAPPEARS. THIS IS A PAINT-ON CAPTION. 
ONE CAPTION BLOCK IS PAINTED ON THE SCREEN, FROM LEFT TO RIGHT, 
ONE CHARACTER AT A TIME. NOW THE ROLL-UP MODE. THIS MODE IS 
NORMALLY USED FOR TV NEWS PROGRAMS. CAPTION LINES ROLL UP FROM THE 
SCREEN BOTTOM ONE LINE AT A TIME. Captions can appear in lower 
case, and also in Spanish: ¿Dónde está el niño? Está en la casa. 
And in French: Parlez-vous français? Répétez, s'il vous plaît. THE 
FOLLOWING SPECIAL CHARACTERS ARE ALSO AVAILABLE. á é í ó ú à è ì ò 
ù ä ë ï ö ü â ê î ô û THEY INCLUDE THE MUSIC SYMBOL AND ACCENTED 
CHARACTERS. ç ã ñ õ å ¿ ¡¢ £ ¥ © ® ™ ° ß §

The Demo1.cap File
After importing the file, the computer screen should look like this. If it doesn’t, check to 
make sure you imported the correct file.

Row H V Caption/Subtitle
1 B C I'M AT THE LEFT

OF THE SCREEN.
2 B C SO CAPTIONS OF WHAT I SAY

APPEAR AT THE LEFT OF THE
3 B C SCREEN, TOO.
4 B C NOW I'M AT THE RIGHT

OF THE SCREEN, SO MY
5 B C CAPTIONS APPEAR

AT THE RIGHT.
6 B C NOW I AM GOING OFF-SCREEN.
7 B C TO INDICATE THAT I'M

OFF-SCREEN, WHATEVER I
8 B C SAY IS ITALICIZED.
9 B C NOW MY NAME APPEARS

AT THE BOTTOM OF THE SCREEN,
10 B C WE PUT CAPTIONS OF WHAT I

SAY AT THE TOP, SO THAT
11 B C MY NAME IS NOT

COVERED BY CAPTIONS.
12 B C UP UNTIL NOW, WE HAVE

BEEN USING POP-ON
13 B C CAPTIONS.
14 B C WHEN A NEW CAPTION POPS

ON, THE OLD CAPTION
15 B C DISAPPEARS.
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16 B C THIS IS A
PAINT-ON CAPTION.

17 B C ONE CAPTION BLOCK IS
PAINTED ON THE SCREEN,

18 B C FROM LEFT TO RIGHT, ONE
CHARACTER AT A TIME.

19 B C NOW THE ROLL-UP MODE.
20 B C THIS MODE IS NORMALLY

USED FOR TV NEWS PROGRAMS.
21 B C CAPTION LINES ROLL UP

FROM THE SCREEN BOTTOM
22 B C ONE LINE AT A TIME.
23 B C Captions can appear in

lower case, and also in
24 B C Spanish: ¿Dónde

está el niño?
25 B C Está en la casa.
26 B C And in French:

Parlez-vous français?
27 B C Répétez, s'il vous plaît.
28 B C THE FOLLOWING SPECIAL

CHARACTERS ARE ALSO
29 B C AVAILABLE.
30 B C á é í ó ú à è ì ò ù ä

ë ï ö ü â ê î ô û THEY
31 B C INCLUDE THE MUSIC SYMBOL

AND ACCENTED CHARACTERS.
32 B C ç ã ñ õ å ¿ ¡ ¢

£ ¥ © ® ™ ° ß §

TIP FOR FORMER DOS CAPTIONMAKER USERS: BREAKING LINES 
In  previous  DOS versions  of  the  CaptionMaker,  you had a “break 
lines”  feature  and  used  the  Enter  key  to  send  captions  out.  The 
Windows version is different. The work of the “break lines” feature is 
done automatically when the text is imported into the CaptionMaker, 
and moving  text  between captions  is  performed by  clicking  on  a 
variety of buttons when a row of the Work Area is selected, not by 
using  the  Enter  key  (though  use  of  it  will  not  harm  existing 
formatting). There is no longer any special meaning to the backslash 
( \ ) key. 

To scroll through text, use the scroll bar on the right side of the screen. Don’t worry if 
you can’t see all of the text in a cell. If you click inside the cell and press the down arrow, 
it should appear. 
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Step 2: Refining Text Into Captions

General Guidelines
You should now have the Demo.txt file loaded into the CaptionMaker. The Demo.cap file 
has the same information as the Demo.txt file, except now it is broken up into different 
cells.

Next you will further format the script into individual captions. An individual caption 
contains  the text  that  will  be sent  to  the screen when that  row is  selected,  either  by 
manual synchronization or by AutoSync. One row of cells in the Work Area corresponds 
to a caption. Make sure that you have set the computer for captioning. To do this, go to 
Caption → Device.

Note  A caption can accommodate up to 4 lines of text with up to 32 
characters  on  each  line.  When  the  menu  bar  indicates  that  the 
program is  configured  to  Caption,  the  computer  will  enforce  this 
requirement. The restrictions for subtitling are less stringent.

The process of conversion of the raw script into captions uses the four Row Operations 
buttons, and the five Processing icons (U, D, C, E, A) in the Work Area. To use a button, 
click on the row of text in the Work Area you would like to work on, and then click the 
formatting button that you would like to use. 

Operations Center: Row Operations
Helps you manipulate  the number  of 
captions  in  your  captioning  job.  The 
Demo.txt file initially has 22 captions 
in it; when we are done with the Row 
Operations we will have 30.

   Insert Row
This button will insert a row above the currently selected row. Hint: If you need to insert 
a row at the very bottom, click at the very end of the last cell and use the Split Cell 
button.



78 CaptionMaker for Windows

   Delete Row
This button will remove the currently selected row (the row where the cursor is). 

   Merge Cells
This button will merge all selected cells into a single cell. (More than one cell needs to be 
selected for this feature to work.)

   Split Cell
The Split Cell button will split the currently selected cell into two cells at the point where 
the cursor blinks.

Highlighting Multiple Rows and Cells 
You may highlight a number of rows or cells to change attributes, such as Horizontal 
Position,  Justification or  Display  Mode  for  the  selected  multiple  rows  or  cell.  The 
highlighting of multiple rows or cells can be accomplished in a number of ways. Here are 
a few examples.

To highlight all the cells 
under column H and change 
the Horizontal position of 
rows to L (left).

Click on the Heading H and then right-click and choose L

To highlight rows 2 through 
5 and change the Display to 
Paint-On.

Click on 2 under the heading #. Hold the Shift key and click 
on 5. This will highlight all 4 rows 2 through 5. Now right-
click on any cell under the heading Display and choose Paint-
On with a left-click.

To selectively highlight 
rows 2, 4 and 7 and change 
the Vertical position to Top.

Click on 2 under the heading #. Hold the Ctrl key and click 
on 4, then 7. This will highlight all 3 rows 2, 4 and 7. Now 
right-click  on  any  of  the  three  highlighted  cells  under  the 
heading V and choose T for Top position.

To highlight 3 text cells 
(rows 2 through 4) under the 
heading Caption/Subtitle 
and change text to italics.

Click the mouse somewhere other than cell 1. Now click the 
mouse  on cell  1 and without  releasing the button,  drag the 
mouse  downward to  cell  4.  This  will  highlight  3  text  cells 
(rows 2 through 4). Now Click on the Italics tool button.

To highlight text within cell 
4 under the heading 
Caption/Subtitle and change 
the text to underline.

Click the mouse on cell 4. Click again on the starting point of 
the text area you would like to highlight and without releasing 
the button, move the mouse to cover the text you would like to 
highlight. Then click on the Underline tool button.
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Work Area Icons
The icons in the Work Area to the left of the text include, 
in  order,  Pull  next  Cell’s  First  Word Up ,  Push Last  
Word Down ,  Compress Text ,  Expand Text  ,  and 
Alternate Break . Each icon, when clicked, will change 
the text in the row that the cursor is on.

Pull First Word and Push Last Word work between two 
cells. Changes occur at the end of the text in the current 
cell and at the beginning of the following cell.

On  the  other  hand,  Compress  Text,  Expand  Text,  and 
Alternate Break operate within a cell.

    Pull First Word (U)
The Pull First Word icons are under the column heading U. This will take the first word 
from the cell below and move it up to the end of the cell with the cursor. If the cursor is 
on the first cell:

I’M AT THE LEFT OF THE SCREEN.

and you click on the  icon, the first word of the next row will be pulled up:

I’M AT THE LEFT OF THE SCREEN. SO
 

    Push Last Word (D)
The Push Last Word icon is under the column heading  D. This will take the last word 
from the cell the cursor is on, and move it down to the beginning of the next cell. If the 
cursor is on the first cell,

I’M AT THE LEFT OF THE SCREEN. SO

and you click on the  icon, the last word will be moved down to the next line, changing 
the cell to this: 

I’M AT THE LEFT OF THE SCREEN.

Note   If you push all the text out of a cell it will be blank, and should 
then be deleted using the Delete Row button, which can be found in 
the Row Operations section of the Operations Center.
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 Compress Text (C)
The Compress Text icon reduces the left and right margins of the cell the cursor is on to 
squeeze the text into a smaller area. If you click on the Compress Text icon on the first 
cell, you will get:

I’M AT THE LEFT OF THE 
SCREEN.

Clicking the Compress Text icon a second time, you will get:

I’M AT THE LEFT OF 
THE SCREEN.

If you click the icon 4 more times, the cell will reach its maximum compression of 4 
lines:

I’M AT
THE LEFT
OF THE
SCREEN.

If you click the icon  again, nothing further will happen. You cannot have more than 4 
lines per caption.

   Expand Text (E)
The Expand Text icon increases the margins within a cell and decreases the number of 
lines. It is the reverse of the Compress Text function. If you click on this icon on the first 
cell, which looks like the previous box above, you will get:

I’M AT THE 
LEFT OF 

THE 
SCREEN.

If you click the icon 4 more times you will get:

I’M AT THE LEFT OF THE 
SCREEN.

Nothing further will happen when you click the icon again.
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   Alternate Break (A)
Clicking on the Alternate  Break icon results in changing the way that text is stacked 
within a cell, by alternating whether the top or the bottom line should display more text. 
Suppose the first cell looks like this:

I’M AT THE LEFT OF THE 
SCREEN.

When you click on the Alternate Break icon, the cell will look like this:

I’M AT THE 
LEFT OF THE SCREEN.

If you click on the icon twice more, the text will square up:

I’M AT THE LEFT 
OF THE SCREEN.

TIP FOR FORMER DOS CAPTIONMAKER USERS:  Deleting a Line 
Using CaptionMaker for DOS, if you deleted all of the information on 
a line, and hit delete one more time, you could completely eliminate a 
line. You cannot do this in the Windows version. In order delete a 
line, you must use the Delete Row button in the Operations Center.

Working with the File Demo1.cap:
Let’s work on the first three cells that look like this:

1 I'M AT THE LEFT 
OF THE SCREEN.

2 SO CAPTIONS OF WHAT I SAY 
APPEAR AT THE LEFT OF THE

3 SCREEN, TOO.

And suppose we would like the cells to look like this:

1 I'M AT THE LEFT 
OF THE SCREEN.

2 SO CAPTIONS 
OF WHAT I SAY 

3 APPEAR AT THE LEFT 
OF THE SCREEN, TOO.
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First click 6 times on the Row 2 Push Last Word icon so that 6 words from the end of 
Row 2 move to the beginning of Row 3. Then click on the Compress icon on each row 
several times until you see the cells look like the above table. If you make a mistake, 
click on the appropriate icon to fix the mistake. Manipulating text using the Work Area 
icons will quickly become second nature. 

In the process of breaking the text into different cells, you may need to create new rows 
and delete blank rows. If you need to create a new row above a row, click the mouse on 
that row and click the Insert Row(s) button in the Operations Center. If you need to delete 
a blank row, click on the Delete Row(s) button next to it. 

The Demo2.cap File
After working with all the cells you will create a file, which should look like this:

Row H V Caption/Subtitle

1 B C I'M AT THE LEFT
OF THE SCREEN.

2 B C SO CAPTIONS
OF WHAT I SAY

3 B C APPEAR AT THE LEFT
OF THE SCREEN, TOO.

4 B C NOW I'M AT THE
RIGHT OF THE SCREEN,

5 B C SO MY CAPTIONS
APPEAR AT THE RIGHT.

6 B C NOW I AM GOING
OFF-SCREEN.

7 B C TO INDICATE THAT
I'M OFF-SCREEN,

8 B C WHATEVER I SAY
IS ITALICIZED.

9 B C NOW MY NAME APPEARS
AT THE BOTTOM OF THE SCREEN,

10 B C WE PUT CAPTIONS OF
WHAT I SAY AT THE TOP,

11 B C SO THAT MY NAME IS NOT
COVERED BY CAPTIONS.

12 B C UP UNTIL NOW, WE HAVE BEEN 
USING POP-ON CAPTIONS.

13 B C WHEN A NEW CAPTION POPS ON,
THE OLD CAPTION DISAPPEARS.

14 B C THIS IS A
PAINT-ON CAPTION.

15 B C ONE CAPTION BLOCK IS
PAINTED ON THE SCREEN,

16 B C FROM LEFT TO RIGHT, 
ONE CHARACTER AT A TIME.

17 B C NOW THE ROLL-UP MODE.
18 B C THIS MODE IS NORMALLY
19 B C USED FOR TV NEWS PROGRAMS.
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20 B C CAPTION LINES ROLL UP
21 B C FROM THE SCREEN BOTTOM.
22 B C ONE LINE AT A TIME.
23 B C Captions can appear

in lower case,
24 B C and also in Spanish:
25 B C ¿Dónde está el niño?
26 B C Está en la casa.
27 B C And in French:
28 B C Parlez-vous français?
29 B C Répétez, s'il vous plaît.
30 B C THE FOLLOWING SPECIAL

CHARACTERS ARE ALSO AVAILABLE.
31 B C á é í ó ú à è ì ò ù ä

ë ï ö ü â ê î ô û
32 B C THEY INCLUDE THE MUSIC SYMBOL

AND ACCENTED CHARACTERS.
33 B C ç ã ñ õ å ¿ ¡ ¢

£ ¥ © ® ™ ° ß §

Step 3: Caption Position and Attributes
During this step, you will be watching the video to see where the speakers are on the 
screen. We must also decide two things.

1. We must decide where on the screen the caption should go. Should the caption be 
at the top of the screen or the bottom of the screen? The left of the screen, or the 
right of the screen? Simultaneously, we will select the justification of the text on 
the screen, from among the choices of left, center and right. 

2. Finally, some text should be underlined and other text should be italicized. 
(Italicized typically indicates an off-screen narrator.) You can apply these 
attributes to the text at this point in the process.

Positioning of Captions on the Screen
In order to accurately position captions on the screen, you need to be aware of what the 
computer screen is telling you about the caption positions.

The Preview Window accurately portrays  the way captions  will  appear  on your  final 
video. This is in contrast to a cell in the Work Area, which cannot represent the vertical 
location of a caption on the TV screen – it is one-dimensional, and the TV screen is two-
dimensional. 

If you have enabled the Horizontal Position and Vertical Position in the Visible Columns 
dialog box (View menu), you can figure out the position on the screen by looking at the 
numbers. The top of the screen starts at 1 (vertical position), and the left of the screen 
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starts at 1 (horizontal position). The maximum number of lines is determined when you 
choose subtitling or captioning. Basic left/center/right and position can be set along with 
justification by clicking a single button, as explained below under “Justification”. You 
can also set position (not justification) of a single caption by clicking and dragging the 
caption inside of the Preview Window with the mouse. 

       Justification 
You will note that the buttons on the toolbar for left, center and right, have a blue L, a 
green C, and a red R at the top of the button. By default, these buttons do the following:

Icons Preview Window Result
(Left Position, Left Justification)

SO CAPTIONS OF
WHAT I SAY

(Center Position, Center Justification)

SO CAPTIONS OF
WHAT I SAY

(Right Position, Right Justification)

SO CAPTIONS OF
WHAT I SAY

The Preview Window (shown on the right) shows relative position of different captions.

# H V J Caption/Subtitle
2 L B L SO CAPTIONS OF

WHAT I SAY
2 C B C SO CAPTIONS OF

WHAT I SAY
2 R B R SO CAPTIONS OF

WHAT I SAY

The Work Area shows how rows within each caption appear in relation to each other. The 
other positioning data, Horizontal (H), Vertical (V) and Justification (J) data are displayed 
in their respective columns.
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You will note that each of the justification buttons do two different things to the text:

1. They set text at a horizontal position on the screen –left, center and right. (The 
colored letter on the button (L, C or R) indicates this information, and they always 
stay in the order L, C, R on the toolbar.)

2. Each of the three buttons also set the appropriate justification of the lines (in other 
words, whether lines are flushed left, centered or flushed right), regardless of the 
lines’ horizontal location. 

By default, the three buttons will produce the justifications that shown on the previous 
table: The Left button, for instance, will left justify the text, such that if you have two 
lines, both of them will start flush left. However, you can change these defaults. For more 
information, see “Chapter 8: Menus”.

Vertical Position:
In captioning, there are only 15 possible vertical positions, which are numbered 1 through 
15. To change a vertical position you can:

1. Use the mouse to move the caption in the Preview Window. The caption will snap 
to the nearest valid screen position.

2. Type in a number from 1 to 15 in the Vertical Position column in the appropriate 
row. The computer will not let you enter an invalid number.

3. Right-click on the Vertical Position cell on the appropriate row. Select the general 
position or other numeric value for the vertical position.

If you would like to change multiple vertical positions, you can select multiple cells by 
using Shift + click or Ctrl + click, and performing the right-click operation on a Vertical 
Position cell in the selected group.

Attributes: Choosing Italics, Underline and Color
Select text within a cell by using the mouse, and then click the Italic or the Underline 
button on the toolbar. The text in that cell will change and can be displayed as italicized 
or underlined on the screen. 

You may also apply the following color and other attributes to emphasize a single word 
or the whole caption (See details in Chapter 8: Menus.)

Normal: On-screen speakers
Italics: Off-screen narrators
Underline: Emphasis



86 CaptionMaker for Windows

Working with Demo2.cap
We have provided a videotape to be used with this tutorial.  This tutorial text starts at 
about 3.5 minutes from the beginning of the video right after this screen (as of August 
2002): 

Now we will show you
how the CaptionMaker

software works.

As you view the segment starting at burn-in time code 00:19:55:04,  you will  see our 
narrator,  Valerie  on  the  left  of  the  screen  speaking.  Our  narrator  speaks  slowly  and 
distinctly on this tape. This is not the case for most captioning jobs. You should place this 
caption on the left margin under her so it is clear to the viewer that she is speaking.

Lines 1-3: Left Position
Let’s work on the first three cells that look like this:

# H V J Caption/Subtitle
1 L B L I'M AT THE LEFT

OF THE SCREEN.
2 L B L SO CAPTIONS 

OF WHAT I SAY
3 L B L APPEAR AT THE LEFT 

OF THE SCREEN, TOO.

Watching the video, we know that these 3 captions are to be placed on the left side of the 

screen. Click on the text area of Row 1 and then click on the Left position button  on 
the toolbar. The text will move to the left side on the Preview Window. Nothing will 
change on the Work Area screen. You can also click on the caption inside the Preview 
Window and drag the caption to any location you prefer. 

You may also change the position of all three rows by first highlighting the three rows. 
Click on the row number 1 in the far left column; then hold the Shift key and click on the 
row number 3. This operation will highlight rows 1-3. Now click on the Left position 
button on the toolbar.  This will  position text of all three rows on the left  side of the 
screen. 

Lines 4 and 5: Right Position
Now Valerie is on the right side of the screen, so you need to place the caption under her 
at the right.

Click on the row number 4, then hold the Shift key and click on the row number 5. 
This will highlight rows 4 and 5. Now click on the Right position button on the toolbar. 
This will position text of both rows 4 and 5 on the right side of the screen. Note the 
horizontal position under the column H has changed from C (center) to actual numbers. 
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# H V J Caption/Subtitle
4 R B R NOW I'M AT THE

RIGHT OF THE SCREEN,
5 R B R SO MY CAPTIONS

APPEAR AT THE RIGHT.

Lines 6-8: Italics 
Now Valerie is off-screen. Captions of an off-screen narrator are displayed in italics.

Click on the row number 6 in the far left column, then hold the Shift key and click on the 
button number 8. This operation will highlight three cells: 6, 7 and 8. 

Now click the Italic button on the toolbar. The text in both the Work Area and the Video 
Preview Window should change to italic. In general, captioning style dictates that an off-
screen narrator’s captions appear in italic. But in cases where the narrator goes on and off 
the screen, you could get by without using italic attributes.

6 C B C NOW I AM
GOING OFF-SCREEN.

7 C B C TO INDICATE THAT
I'M OFF-SCREEN

8 C B C WHATEVER I SAY
IS ITALICIZED.

Clearing  the  Screen  of  Captions     A  blank  row  clears  (erases) 
existing  captions  on  the  video  screen.  This  is  the  only  way 
CaptionMaker can clear the screen. The start time of the blank row is 
the time at which the screen will be cleared.

Lines 9-11: Top Positioning 
Captions 9 through 11 should be at the top of the screen because Valerie’s name appears 
at the bottom of the screen. You should also use the normal font since she is visible. 

Click on the row number 9 in the far left column, then hold the Shift key and click on the 
number 11. This operation will highlight three cells: 9, 10 and 11. Now right-click on any 
one of the three cells under the heading V (Vertical position) and choose Top.

Lines 12-13: No Need to Do Anything
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Lines 14-16: Paint-On Mode 
You may have programs where you can mix caption display modes. Lines 14 through 16 
are to be displayed in the Paint-On mode.

Highlight these three cells and right-click on the Display column of any one of the three 
rows  and left-click  on  Paint-On.  The  cells  under  Display  column  should  now show 
“Paint-On” as shown below.

14 C B C Paint-On THIS IS A
PAINT-ON CAPTION.

15 C B C Paint-On ONE CAPTION BLOCK IS
PAINTED ON THE SCREEN,

16 C B C Paint-On FROM LEFT TO RIGHT,

TIP FOR FORMER DOS CAPTIONMAKER USERS: Changing Modes 
In the DOS software, you would change from Pop-On to Paint-On 
mode by having a special control character sitting by itself on a line 
(such as ^T). In the Windows version on the row where you would 
like the change to take place, go to  Attribute  → Display Mode  and 
select  the  display  mode  for  that  row  only,  or  right-click  on  the 
Display column in the Work Area and pick from the pull-down menu.

Lines 17-22: Roll-Up Mode
Captions 17 through 22 have already been formatted for the Roll-Up mode. Note that for 
the Roll-Up mode, each cell should contain only one line.

Highlight these six rows and right-click on the Display column of any one of the six rows 
and left-click on Roll-Up. 

Again highlight these six rows and right-click on the Horizontal column of any of the six 
rows and left-click on Other to choose 4. The captions will be indented 4 characters from 
the left.  Remember  you  can put  a maximum of  32 characters  on a caption  line.  For 
example, if you use 4 characters left indentation, you can have only 28 characters on that 
line.

While the six rows are highlighted, right-click on the Justification column in any one of 
them and left-click on Left Justify.

The cells under the Horizontal, Justification and Display columns should reflect all the 
changes you have made as shown below.

17 5 B L Roll-Up NOW THE ROLL-UP MODE.
18 5 B L Roll-Up THIS MODE IS NORMALLY
19 5 B L Roll-Up USED FOR TV NEWS PROGRAMS.
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20 5 B L Roll-Up CAPTION LINES ROLL UP
21 5 B L Roll-Up FROM THE SCREEN BOTTOM
22 5 B L Roll-Up ONE LINE AT A TIME.

Lines 23 and 24: No Need to Do Anything

Lines 25 to the End: Multiple Captions on the Same Screen
We would like to place the captions of lines 25 and 26 on the same screen--one on the left 
and the other on the right, and at two vertical positions. We will do the same for the 
captions in cells 28/29 and also for 30/31 and 32/33. 

We will show you how you can place two captions on the same screen. You need to place 
the desired two captions at different locations on the screen. At the time of sending the 
captions, we will show you how to send both captions at the same time. 

Click on the row number 25 and while holding the  Ctrl key click on the number 28 
which will highlight both rows 25 and 28. Now click on the Left Position/Left Justify 
button on the tool bar.

You may also accomplish the same result by doing the following: Right-click on any of  
the two cells under the heading H and choose Left position. Now right-click on any of the  
two cells under the Heading J and choose Left Justify.

25 L 13 C Pop-On ¿Dónde está el niño?
26 R B C Pop-On Está en la casa.

Finally, do the same operation on row numbers 30 and 32. This time simply change the 
vertical position by right-clicking on any one of the 2 cells under the Vertical Position 
“V” and choosing Other position 1. 

When you are all done with the script, compare your work with Demo3.cap. It shows you 
the formatted text with placement and attribute information. When you are satisfied with 
your work, you are ready to actually caption your tape. 

The Demo3.cap File
After working with all the cells you will create a file, which should look like this:

Row H V J Display Caption/Subtitle
1 L B L Pop-On I’M AT THE LEFT

OFF THE SCREEN
2 L B L Pop-On SO CAPTIONS

OF WHAT I SAY
3 L B L Pop-On APPEAR AT THE LEFT

OF THE SCREEN, TOO.
4 R B R Pop-On NOW I'M AT THE

RIGHT OF THE SCREEN,
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5 R B R Pop-On SO MY CAPTIONS
APPEAR AT THE RIGHT.

6 C B C Pop-On NOW I AM GOING
OFF-SCREEN

7 C B C Pop-On TO INDICATE THAT
I'M OFF-SCREEN,

8 C B C Pop-On WHATEVER I SAY
IS ITALICIZED.

9 C B C Pop-On NOW MY NAME APPEARS
AT THE BOTTOM OF THE SCREEN,

10 C B C Pop-On WE PUT CAPTIONS
OF WHAT I SAY AT THE TOP,

11 C B C Pop-On SO THAT MY NAME IS NOT
COVERED BY CAPTIONS.

12 C B C Pop-On UP UNTIL NOW, WE HAVE BEEN
USING POP-ON CAPTIONS.

13 C B C Pop-On WHEN A NEW CAPTION POPS ON,
THE OLD CAPTION DISAPPEARS.

14 C B C Paint-On THIS IS A
PAINT-ON CAPTION.

15 C B C Paint-On ONE CAPTION BLOCK IS
PAINTED ON THE SCREEN,

16 C B C Paint-On FROM LEFT TO RIGHT,
ONE CHARACTER AT A TIME.

17 5 B L Roll-Up NOW THE ROLL-UP MODE.
18 5 B L Roll-Up THIS MODE IS NORMALLY
19 5 B L Roll-Up USED FOR TV NEWS PROGRAMS.
20 5 B L Roll-Up CAPTION LINES ROLL UP
21 5 B L Roll-Up FROM THE SCREEN BOTTOM
22 5 B L Roll-Up ONE LINE AT A TIME.
23 C B L Pop-On Captions can appear

in lower case,
24 C B C Pop-On and also in Spanish:
25 L 13 C Pop-On ¿Dónde está el niño?
26 R B C Pop-On Está en la casa.
27 C B C Pop-On And in French:
28 L 13 C Pop-On Parlez-vous français?
29 R B C Pop-On Répétez, s'il vous plaît.
30 C T C Pop-On THE FOLLOWING SPECIAL

CHARACTERS ARE ALSO AVAILABLE.
31 C B C Pop-On á é í ó ú à è ì ò ù ä

ë ï ö ü â ê î ô û
32 C T C Pop-On THEY INCLUDE THE MUSIC SYMBOL

AND ACCENTED CHARACTERS.
33 C B C Pop-On ç ã ñ õ å ¿ ¡ ¢

£ ¥ © ® ™ ° ß §

Clearing Captions
If you check the video, you will see a little pause (about a second) in the dialog between 
row 8 and row 9. We will create a blank row to clear the caption on row 8 for a second or 
so. Click the cursor on row 9 and then click on the button   to create a blank row 
between row 8 and row 9.
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8 C B C Pop-On WHATEVER I SAY
IS ITALICIZED.

9 C B C Pop-On NOW MY NAME APPEARS
AT THE BOTTOM OF THE SCREEN,

This will create a blank row between rows 8 and 9 as below

8 C B C Pop-On WHATEVER I SAY
IS ITALICIZED.

9
10 C B C Pop-On NOW MY NAME APPEARS

AT THE BOTTOM OF THE SCREEN,

Step 4: Manual Captioning With and 
Without Time Stamps

If you are using our sample digital video clip provided on the CaptionMaker CD, you will 
find the first spoken audio starts at 00:00:07:24. 

We also sometimes provide a videotape to be used with this tutorial. This tutorial text 
starts at about 3.5 minutes from the beginning of the video right after this screen:

Now we will show you
how CaptionMaker

software works.

As you view the segment starting at burn-in time code 00:19:55:04, you will see Valerie 
on the left of the screen speaking. We will caption the segment using the following three 
different methods. 

Step 4a: Manual Captioning 
Using this method, you can send captions to the recording VCR or broadcast out directly. 

1. Make sure the  button on the Time code section (shown below) of the Work 
Area is not in the down position.

2. Put the cursor on the row where you would like to begin captioning.
3. Run the playback and the record VCRs.
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4. When you hear the first word of each cell of text spoken, press the [+] key. The 
caption should appear on the video screen and in the Preview Window

.
No time stamps will appear in the Start column. Keep on pressing the [+] key for each 
and every row in the same fashion. Captions will go out and will be recorded in real time. 
You cannot stop in the middle of the video.

If you make a mistake, you do not have the advantage of adjusting time stamps to correct 
it. The tapes must both be rewound and the process must begin again unless you are using 
a video editing system, which can stop both tapes at the same time and restart the tapes 
and resume back to sending captions from that point on.

Drop Frame NTSC/PAL    If the time code formats on your work tape 
and master tape are different, you may convert them between NTSC 
and  PAL  and  also  between  drop  frame  and  non-drop  frame.  See 
Convert  Time Code in  “Chapter  8:  Menus” for  details.  To  convert 
time codes from one to another (PAL and NTSC or drop to non-drop) 
highlight  the  time  codes  you  would  like  to  convert  and  use  this 
option to convert them from one to another.

Step 4b: Captioning with Time Code Reader 
Using this method, you can assign a time code (using the time code from the video) to 
each caption, and then use Step 5a to do the final captioning.

This is the most professional way to caption. Press the  [+] key when the first word of 
each cell of text is spoken in order to capture the time code associated with this word 
(from the  Source  VCR). It  is  impossible  for  a  caption  to  appear  at  the  wrong time, 
provided that you pressed the [+] key at the proper time. If you did not press the [+] key 
at the proper time, it is easy to use time code to correct mistakes. For example, if you are 
captioning and make a timing mistake at 00:02:30:45, you would rewind the tape to a 
point before that  time (typically  5-6 seconds) and then play the tape.  When the tape 
reaches the point where you made the timing mistake, you would press  [+] on the row 
with the caption, which had the incorrect time. Assuming you pressed  [+] at the right 
time,  your  timing  mistake  would  be  corrected  and you  could  continue  on  with  time 
stamping the rest of the tape.

Don’t worry about trying to compensate for the amount of time it takes you to react (the 
time between hearing a word and pressing the [+] key). Relax and work at an unhurried, 
even pace. This time lag can be easily compensated for at a later time, as long as your 
reaction time lag is consistent (e.g., always .5 second late).
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There is a file on the disk, Demo.cap that has time codes already associated with the text. 
You can compare your file with this one to check whether you are on the right track.

Step-by-Step Procedure to Capture Time Codes
If you are using a digital video, choose Video Playback. 

If you are using a videotape, from Time code → Properties → Reader menu select your 
time code reader. If you have never installed the software to communicate with the time 
code reader, the appropriate installation routine will walk you through the process at this 
point. For details see Chapter 2.

1. Make sure the  button on the Time Code section of the Work Area is in the 
down position so that you can to read time code.

2. Play the Source VCR.
3. When you hear the first word of each cell spoken, press the [+] key on the far 

right side of the keyboard in order to capture the time code to the Start column. 
The time code at which you press [+] appears in the Time Code Start column 

4. As you press [+], the cursor will move down to the next caption. Press [+] in 
order to send a caption and get the time code for the next caption. Keep on 
pressing the [+] key for the rest of the file in the same fashion.

Fine tuning of time codes  If  you need to change a time code by 
small amount, click the cursor on the time code cell and press Ctrl+ 
or Ctrl-. This operation with change the time code value by 1 frame. 

Correcting Time Code Mistakes
If you make a mistake with time code, or if you spot a formatting error or typo, you can 
stop pressing the [+] key and fix the formatting, positioning or typographical error. If you 
need to fix the time code, follow the steps below.

1. Rewind the tape to a point just prior to the mistake.
2. Move the cursor to the place in the text where the error occurred.
3. Follow Steps 2 to 4 above and continue recording the time codes for the rest of 

the file.
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Calculate send time for Pop-On  This feature is very important when 
you caption a short commercial. In a commercial, if you add a Pop-
On caption at  the  very  beginning  of  the  video,  you  may lose  the 
caption. Since Pop-On captions need build-up time to be displayed 
on a particular frame of the video, you have to make sure that the 
onset of the caption is within the first frame of the video. Right click 
on the first time code under the Start Time column and make sure 
the send time of the first caption is well inside the beginning of the 
video.

Step 4c: Captioning with PC System Timer 
Using this  method,  you can assign a  time stamp to each caption  using the  computer 
system timer  and then use Step 5b to do the final captioning.  The PC System Timer 
emulates time code – but since it is only an emulation, it is not as effective or efficient as 
using real time code.

The PC System Timer method uses the clock inside the computer as a timing mechanism. 
The work of synchronizing the computer’s clock to the script, however, must be done 
manually,  by  choosing  a  reference  point  on  the  video  before  the  first  caption. The 
reference point could be the beginning of bars and tones or the beginning of theme music 
or something that you can easily identify as a specific point on the video.

Please read Step 4b for time code for a better understanding of PC System Timer even if 
you are not using time code. Working with time code is much simpler than working with 
the PC timer. Time code has a one-to-one correspondence with each frame of the video. 
When using time code method, you do not need a reference point because the time code 
moves forward and backward along with the tape. You can stop time coding any time and 
resume time coding from that point on at any time later. But with PC timer, you need to 
reset the PC timer any time you stop time stamping. When using the PC Timer, you are 
working in real time, which does not move backward with the tape. It moves forward 
only. It never stops. But you can reset the PC System Timer to match the time stamp in 
your caption script at any time using a PC timer reset technique.  The reference point 
should appear a row before your first caption. 

If you are using a digital  video,  choose  Video Playback.  The first  caption appears at 
00:00:07:20

We are going to use our demo videotape and use the screen with the following title as our 
reference point.
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Now we will show you
how CaptionMaker

software works.

This title appears at 00:19:55:04 time code and about 10 seconds before Valerie appears 
on the left of the screen and starts saying:

I AM AT THE LEFT OF THE SCREEN

Create a blank row at the beginning of the file and use the time code associated with this 
line as the reference point.

So the first few lines of our demo3.cap file now look like this.

1 C B C Pop-On Caption/Subtitle
2 L B L Pop-On I’M AT THE LEFT

OFF THE SCREEN
3 L B L Pop-On SO CAPTIONS

OF WHAT I SAY
4 L B L Pop-On APPEAR AT THE LEFT

OF THE SCREEN, TOO.
5 R B R Pop-On NOW I'M AT THE

RIGHT OF THE SCREEN,
6 R B R Pop-On SO MY CAPTIONS

APPEAR AT THE RIGHT.

Step-by-Step Procedure to Capture PC System Time
From Time code → Properties → Reader menu select PC System Timer. 

1. Make sure the  button on the Time Code section of the Work Area is in the 
down position.

2. Choose a reference point on the videotape that begins at least 5 to 10 seconds 
before your first caption. Referring to the example in the box above, there is 
more than a 5-second gap between the reference point and the first caption. That 
means during auto-captioning later, you will have enough time to set the 
reference point and then start the AutoSync. If you are a quick typist, five 
seconds is sufficient.

3. Run the Source VCR.
4. When you reach the predetermined reference point on the tape (with the cursor 

on the reference point row in your script), press the [+] key when you see or hear 
the reference point. 

5. Continue to the first row of captions. When you hear the first word of each row 
of text spoken, press the [+] key. Timing information will appear under the Start 
column corresponding to the row you just sent out as a caption. As you press [+], 
the cursor moves down to the next caption. Press [+] again to send the next 
caption and get the timing information for it. 
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Correcting Time Code Mistakes
If you make a mistake, or if you would like to stop time-stamping and take a break, you 
do not have to go back to the initial reference point in order to continue captioning.

1. Rewind the playback tape to a location a few seconds before the point you 
would like to resume time-stamping.

2. Bring the cursor to the last row you time stamped correctly. 
3. Right-click on the time code cell of that line. A small window will open up. 

Click on the Reset PC Timer to the time code. The PC Timer will be ready to 
reset the clock to the same time as the time stamp on that row.

4. Run the Playback VCR.
5. As soon as you hear the first word of that row spoken, press the [+] key to time 

stamp the caption on that row. This action will actually reset the clock to that 
time. Now keep on pressing the [+] key for rest of the file.

Fine-Tuning AutoSync     If the captions appear too early, press [Alt] 
+ [-] to slow them by one-third of a second. Press it again to slow the 
display of captions by another third, and so on. If captions appear 
too late, speed them up with the [Alt] + [+] key; the same rates apply. 
The only sure way to synchronize the time code and program is to 
use time codes on the tape along with the CaptionMaker.

Step 5: AutoSync Captioning with Time Stamp 
In this step the computer will read the time code or the PC System Timer and send the 
captions automatically, according to the time stamp associated with every caption row. 
To use this step you previously had to perform either Steps 4b or 4c.

Tip    Although  Windows  is  a  multitasking  operating  system, 
performing  other  tasks  (such  as  checking  email)  during  the 
AutoSync process is not recommended. This is because individual 
captions  might  be  sent  late  to  the  recording  VCR  if  too  much 
computing power is being used on tasks other than captioning.
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Step 5a: AutoSync Captioning with Time Code

1. Make sure the  button on the Time Code section of the Work Area is in the 
down position.

2. Rewind the playback tape to the beginning.
3. Run the playback tape and the recording tapes.
4. Click on the Caption → AutoSync menu option or on the AutoSync button in the 

toolbar to start automatic captioning.

The word AutoSync in the status bar will start flashing. Editing features of the program 
will not be accessible until the AutoSync task is finished. Click again on the AutoSync 
button to stop the job.

Adjusting Time Cue to Correct Human Reaction Time   When you 
press  the  [+]  key  to  record  the  time  stamp,  there  is  always  a 
possibility of an error of few frames. The source of the error is the 
reaction time from the time you hear the first word spoken until the 
time you press the [+] key. Assuming it is always a consistent error, 
you can change the time stamp of all the rows by a few frames using 
the Ripple time code option. Left-click on the Start column header to 
highlight all the time cues, and then right-click on the time code cell 
of the very first row and choose Ripple time code. Now you can enter 
the new time cue (a few frames more or less than the time cue of the 
first row) to replace the time cue of the first row and ripple the time 
cues for the whole file.

Step 5b: AutoSync Captioning with PC System Timer 

1. Make sure the  button on the Time code section of the Work Area is in the 
down position.

2. Rewind the playback tape to the beginning. 
3. Right-click on the time code cell of the row with the reference point. A small 

window will open up. Click on Set System Timer to Current Start Time. The PC 
Timer will reset to the same time as the time stamp on that row

4. Run both playback and record VCRs.
5. As soon as you see the Reference point on the video, click on the AutoSync 

button or Caption>AutoSync menu in the toolbar to start automatic captioning.
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The word “AutoSync” will display in the middle of the status bar. You cannot access any 
of the editing features of the program until  AutoSync is  finished.  Click again on the 
AutoSync button to stop. The system will then automatically insert captions into your 
tape.

Note that VCR motors do not always run at exactly the same speed. A consequence of 
this is that captions  may become slightly out of sync with the dialog on a long video 
when using AutoSync.

Final  AutoSync  Note  that  the  cursor  does  not  need  to  be  on  a 
specific place in the text in order to start AutoSync. In fact, if you 
rewind  or  fast-forward  the  video  while  AutoSync  is  on,  the 
CaptionMaker will read the time code and pick up AutoSync from any 
place in the file. 

Two Captions Appearing Simultaneously
You may wish to have two or more captions appear on the screen at once, but in different 
positions (the top and bottom of the screen, for example). The need for this may arise in a 
program where two people say different things at the same time. If you have two captions 
with the same Start Times, both will appear on the screen simultaneously. The easiest 
way to do this is to skip over one of the rows while assigning time code, and later cut and 
paste the Start Time from the row where you did assign time code to the row that you did 
not  assign  a  time  code  to.  Of  course,  you  should  assign  different  positions  to  these 
captions so they will both be visible.

Tip   You may use the function Same Start Time to assign same time 
code to multiple rows. Highlight multiple rows with time code, right-
click on any highlighted row and then click on Same Start Time.

Captioning Two Languages on the Same Video
CaptionMaker can use used to caption two languages on the same video in a limited way. 

With ITV-Injector/DV-2000/DV-3000
CPC distribution CD contains a utility software CaptionMerge. First create two 
CaptionMaker .cap files for two languages. Then export two files to Ultech DV2000/ 
DV30000/ITVInjector (*.ult) file format.
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Now run CaptionMerge software and do the following:
 
Choose the first file for CC1 and
Choose the second file for CC2 to CC3
Choose CC2 or CC3 for the second language 
Choose the final Destination (merge) ULT file
Finally, click on the Merge File button

Use this final .utl with the DV2000/ItvInjector. 
Make sure you have DV2000/ItvInjector software version 3.5 or higher.

Note:  Channel 1 and Channel 2 occupy the same space inside the 
Field 1. The same is true for Channel 3 and Channel 4. When you 
caption two channels in the same field, there is always fight with the 
space between CC1 and CC2. CC1 has the first priority.  Whatever 
space is left, is used by CC2. It is good idea to para-phrase the text 
and make it  short  in  both  languages  when you  do CC1 and CC2 
caption simultaneously.

With Other Encoders
Using one computer 
You can caption in CC1 or CC2 (Field 1) in one pass and then run the captioned video 
through the encoder and caption CC3 or CC4 (Field 2) in the second pass. Make sure the 
option Allow existing filed 1 data pass through untouched under the Caption > Caption  
Properties > Control menu is checked.

Using two computers
You can caption a video in CC1 or CC2 (Field 1)and CC3 or CC4 (Field 2)  at the same 
time. 

The encoder must be connected to two computers via 
1. a serial cable or a  modem,
2. 2 serial cables, or
3. 2 modems

Invoke the Caption → Device → Properties option.

You have to make sure that you set the following items properly. 
1. Channel (C1, C2, C3 or C4)
2. Allow existing field 1 (or 2) data to pass through untouched.



100 CaptionMaker for Windows

3. Send caption data if available box is checked.
4. Caption 2 or more channels – send init code for each line box is checked.

In the previous dialog box, CPC is set to caption in Channel 3 (field 2) under one of the 
following two situations: 

1. caption data is sent to the encoder  in channel 1 simultaneously via a modem or a 
serial cable or, 

2. the video is already captioned in channel 1 

A few important points to note:
You can have either of the following situations:

1. Both computers running CaptionMaker software or
2. One computer  running CaptionMaker  and the other  computer  running another 

captioning software.

You may mix and match any of the two methods of captioning:
1. Live or Realtime or, 
2. Live Display or, 
3. Post Caption.

In  Live Realtime method, you can use either a steno machine or a Speech Recognition 
software to send the caption live.

In Live Display method, you have to have the text prepared already. Then you can send 
the captions by pressing the (+) key in real time by listening to the dialog.

If you have access to the time code of the video, you may use the Post Caption method. 
You must have a already prepared time stamped file. Then you can invoke the AutoSync 
function and captions will go automatically synchronized with the video.

Note: You cannot caption Channel 1 and Channel 2 simultaneously 
using this technique since both Channel 1 and Channel 2 occupy the 
same space inside the Field 1. The same is true for Channel 3 and 
Channel 4.

AutoSync Error Checking
If this  option  Caption > AutoSync Error Checking is checked, CaptionMaker will  go 
through the whole file and make sure there is no missing time codes or the time codes not 
in  ascending  order  before  starting  AutoSync.  It  is  a  good  idea  to  have  this  option 
checked. That way for a long video you do not have to wait for long time until the error is 
caught and AutoSync stops at that point.
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Error Checking 
If this option Caption > AutoSync Error Checking is checked, CaptionMaker will go 
through the whole file and make sure there is no missing time codes or the time codes not 
in ascending order before starting AutoSync. It is a good idea to have this option 
checked. That way for a long video you do not have to wait for long time until the error is 
caught and AutoSync stops at that point.

Final Checking
This is a very important function to check all timing and formatting errors before you do 
the final encoding. The option is available under Caption > Final Checking menu and 

also can be accessed by clicking on the  icon at the top left corner of the screen. You 
can set  your  favorite  parameters  on the following window and check for errors after 
preparing a caption file and before using that file for encoding or any other purposes. 

When you invoke this option you will see a dialog box below where you may choose 
options related to time code tolerance, reading speed of captions, maximum characters 
per line, unacceptable characters for captioning, etc.

Timing Errors Settings
When you caption a video, it is very important that you conform to maximum WMP for 
caption, depending on your audience.  Similarly,  it  is customary not to have a Pop-on 
caption covering a shot change. And finally, if you do not give enough time for a Pop-on 
caption to build-up, the caption would not appear at the desired time you assigned. For 
Pop-on captions, it takes about a second for every 50 characters of text. If the difference 
of time codes of the previous caption and this caption is less than 1 second for a caption 
of 50 characters, the caption will appear little later than the assigned time code. To check 
all  these errors  on the fly,  you  can invoke the option under  Caption> Timing Error 
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Settings menu. You can check any one of the following items and assign different colors 
for each error in the following dialog box.

Find Shot Changes

You can find the shot changes in any video (wmv, avi, mov, mpeg, m2v etc.). It is a good 
idea not to have a shot change inside the duration of any caption in Pop-on mode. Try to 
place the caption after a shot change or finish displaying a caption before a shot change 
occur. It is more for esthetic purpose.

After you open caption file with the appropriate video file, to find the shot changes, click 
on Tool > Find Shot Changes.

It will take a while depending on the length of the video to find the locations of all the 
shot changes. When you save the caption file, the shot change information will be saved 
in the .cap file. So when you open the .cap file again later, you do not need to find shot 
changes again.
 
After finding the shot changes, when you play the video, the next shot change indicator 
appears right below the Time code display in HH:MM:SS:FF format. Next shot change 
display color becomes RED when it is less than 10 seconds from the next shot change.

You can also click the two buttons ( ) next to the time code display area to move 
to the previous and next shot change locations.

Digital Video: CaptionMaker-DV, NLE & HD
The CaptionMaker-DV/NLE/HD come with all the features of the CaptionMaker-Classic, 
plus additional  exciting features that  make it  easy to caption a video from your  hard 
drive. This section will guide you through the process of captioning a video from your 
hard drive.

VTR Control with VPedal inside CaptionMaker You can control (play, 
pause, fast forward, rewind etc.) a digital video file using vPedal foot 
pedal  controller  (www.vPedal.com).  One  interesting  feature  of  the 
vPedal  foot  controller  is  the  "release  back"  function  which  is 
available under VTR Control >> vPedal menu option. Release back 
time is user selectable.

http://www.vPedal.com/
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Once the Play button on the VTR Control) is first clicked, you will be 
able to use the Pause function on the pedal to toggle between Play 
and Pause but  the first time you play the video,  you  must start  it 
manually by clicking the mouse on the Play button.

Open Video File in CaptionMaker-DV, NLE & HD
Click on the  Video Camcorder icon located in the Preview Window area. A dialog 
box like the one below will open.

RealOne video  CaptionMaker relies on Windows engine to play all 
video files. At  the time writing this manual, WMP does not play rm 
files. As a result, CaptionMaker can’t play RM, or Real Media files. To 
open a .RM file, you may install a third party software which allows 
WMP play a .RM videos and then you can open a RM file in CPC. You 
may  download  the  software  from  
www.free-codecs.com/download/Real_Alternative.htm. 

http://www.free-codecs.com/download/Real_Alternative.htm
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Make  sure  that  you  unselect  the  Enable  external  video  from tape button,  but  leave 
Display rendered caption/subtitle selected. Select  Enable video file playback from disk 
and make sure Play video file during AutoSync/AutoPreview is selected (unless you are 
planning to use a video feed from a USB device for AutoSync only). Click the Browse 
button. Find the video file on your hard drive, and then click Close. 

QuickTime  Movie:  CaptionMaker  made  a  special  effort  to  play 
QuickTime mov even though WMP can t play MOV files. You have to 
check the box for QuickTime files when you open the video.
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Read and use actual TC values in the file
Checking this box will read the actual TC from a digital video (Mpeg and DV), if and 
only if  the  digital  video was recorded with TC in special  TC area of  the video file. 
Normally digital videos do not have internal timecode.

Unless CaptionMaker reads internal time code of a digital (Mpeg & DV) video, it assigns 
00:00:00:00  to  the  first  frame  of  the  video  and  then  counts  the  frames  and  assigns 
timecodes to any frame according to drop frame (29.97 fps) or Non-drop frames (30 fps).

Temporarily set TC reader to “Video Playback”
If you normally use a timecode reader to read timecode from a video tape, you can check 
this box to read timecode for a video file. This way, later on when you choose to play 
video tape, you will fall back to your choice of timecode reader.

Video file frame rate
Most digital videos are created at 29.97 frames/second (drop-frame). Unless you know 
that the video was created at a different frame rate, use 29.97 fps for the Video file frame 
rate.

Enable Offset
Checking this box and assigning a desired timecode value, you can match the burn in 
timecodes of a digital video when you playback the video. Adding an offset will add the 
offset value to the timecode when it is displayed. 

Digital Video Time Code

Go to Time Code → Time Code Reader Properties menu or simply click on the  icon 
in the Time Code bar to open up the Time Code Reader Properties. Once there, select 
Video  Playback from  the  drop-down  menu.  Now  you  can  assign  time  code  to  the 
captions. See Step 4b: Captioning with Time Code Reader  earlier in this chapter to learn 
how to break the script into individual captions and time stamp the script to synchronize 
the captions with the audio.

CaptionMaker counts the frames of digital video and convert them to SMTE time codes. 
If you use a Mpeg2 video, CaptionMaker can read embedded time codes in Mpeg2 video 
too. To read time codes directly from the video you need to click on  Scan Playback File  
for Time Code Info.

Video File Automatic Shuttling
You can automatically shuttle the video file to the time code of the selected row. When 
enabled and you click on a row, the video file quickly moves to the start time code of the 
row you clicked on.
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This feature is only enabled under the following conditions:
When the “mark time codes on send lines” feature is enabled (via the “time code” menu 
or the icon in the “time code” display section of the program).
When a video file is loaded and enabled during editing, and it is stopped (not playing and 
not paused).

Note: If you do not like this feature and like to turn it off, you may 
uncheck the item Enable Video Auto Shutting from the Time Code 
menu.

Drop Frame vs. Non-Drop Frame Time Code
There is no time code track on the A/V file. CPC keeps track of the video frames starting 
with 00:00:00:00 time code for the first frame of the video and keeps a frames counter 
that counts 29.97 frames per second (on average). The exact counting mechanism is bit 
more complex. This is exactly the same way drop frame time code is used for videotape 
format. That’s why the time code from the Video Playback acts in the same way as the 
drop-frame time code does for a videotape format. If you have a video file on the hard 
drive that is exactly one hour long according to the clock on your wall, the very first time 
code of the first frame of the video is 00:00:00:00 and the time code of the very last 
frame of the video is exactly 01:00:00:00. On the other hand, the time code of the very 
last frame will be 00:59:56:12 for Non-Drop frames. There is difference of 00:0:03:18 
frames.

Video File Time Code Offset

This option allows you to specify the time code value for the first frame of a video file 
selected for play back. If you have a digital video with burn-in time code, you can adjust 
the time code offset matched with the time code of the first caption. This way, the time 
code displayed in the time code display window and time codes for the captions with 
match with the burn-in time code.

Going Back to Videotape Format for Reference
There are number of reasons you may  need to go back to the videotape format from 
which the video on the hard drive has been created. They include the following:

Captioning a videotape using a closed caption encoder or subtitling using a character 
generator
Captioning/Subtitling a DVD
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There  are  two issues  when you  need to  go back to  videotape  format  after  the  time-
stamped file has been created using video from the hard drive.

1. Matching the time code from the video on hard drive to time code on the 
videotape 

2. Drop frame vs. non-drop frame 

If you are going to do the following, you do not need to go back to the videotape format

Captioning/Subtitling a video for webcast
Captioning video residing on a NLE system

Matching A/V Time Code to Videotape Time Code
When  you  work  with  the  video  on  the  Hard  Drive,  the  start  time  code  is  always 
00:00:00:00.  On  a  videotape,  it  is  very  unlikely  that  the  starting  time  code  will  be 
00:00:00:00. So it is necessary to “match” the time code from the videotape with the time 
code from the video on the hard drive.

There are two preferred methods for doing this. 

1. The easiest way is to originally put visible burnt-on time code (at the top left 
corner) onto the videotape before converting the A/V to an A/V file. Then 
matching the time code of the A/V file and the actual time code from the 
videotape format is very simple. You can simply move through the video on the 
hard drive slowly, frame-by-frame until you find the burnt-on time-code for the 
very first caption.

2. The other method is slightly more complicated. It involves finding the actual time 
code of the first caption directly from the videotape. Some tape decks have digital 
time code readouts. You may get the time code for the first audio, which is 
captioned from the readout display by playing the tape and pausing the tape at the 
onset of the first audio. Or you may use the CaptionMaker software to get the 
time code from the videotape as long as you have a time code reader in the 
computer running CaptionMaker software.

After noting the time code of the first caption from the videotape, you are ready to match 
the time codes on the file you created from the video on the hard drive. 

1. Highlight the time code column by clicking on the Start header of the time 
code column

2. Right-click on the first caption and select Ripple Time Code.
3. Enter the burnt on time-code shown in the preview window. 

This will ripple all the time codes starting with the true time code of the videotape.
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Drop Frame vs. Non-Drop Frame
If you have to go back to the videotape format with non-drop frame time code, you need 
to convert all the time codes to non-drop frame time codes. Go to Time Code → Convert  
Time Code menu. Choose the option to convert from drop frame to non-drop frame.

The Final Step 
Once you have prepared the script with time code for the video on the hard drive, you 
have a number of different options, depending on the type of media you would like for 
your final product. Here are a few examples, which are described in details for different 
media.

Captioning a Videotape with Drop-Frame Time Code 
You would like to caption a videotape that uses drop-frame time code. In this case the 
only thing you need to do is to “match” the time code from the videotape with the time 
code from the video on the hard drive by following the procedure above. Now you are 
ready to use the file you have prepared to encode the captions onto the videotape. Follow 
the steps in the section below, “Encoding Videotape Using a Time Code Reader and an 
Encoder”.

Captioning a Videotape with Non Drop-Frame Time Code
If you would like to caption a videotape that uses non-drop frame time code, you need to 
first “match” the time code from the videotape with the time code from the video on the 
hard drive by following the procedure above. 

Then you have to convert the drop frame time code to non-drop frame time code. Go to 
Time Code → Convert Time Code menu. After converting from drop frame to non-drop 
frame, you are ready to use the file you have prepared to encode the captions onto the 
videotape following the steps in the next section.

Encoding Videotape Using a Time Code Reader and an Encoder
To switch back to see the video from the tape format and to choose the appropriate time 
code card and encoder, follow these steps:

1. Click on the  Video Camcorder icon located in the Preview Window.
2. Unselect Enable Video file playback from disk and Play video file during 

AutoSync. 
3. Select Enable external video from tape.
4. Click on Caption → Device and choose the appropriate closed caption 

encoder. 
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5. Finally, click on the  icon in the Time Code bar to open up the Time Code 
Reader Properties dialog box and select your original time code reader card 
from the drop-down menu. 

You are ready to AutoSync and caption the videotape using a time code card and a closed 
caption encoder as done by the CaptionMaker software.

Caption/Subtitle a DVD
For a DVD, the process is the same as the process described above. You must “match” 
the time code (from the videotape you will use to make a DVD) to the time code you 
prepared using the video from the hard drive. You should also make sure the time code 
on the video is drop frame, otherwise you must convert the time code to non-drop frame 
following the steps described earlier. Once you have done this, you are ready to export 
DVD caption or subtitle files for your DVD authoring system.

For captioning, click on Caption → Device, choose Generic Encoder. Then click on File  
→ Export, choose the group  Caption Formatted and then select your DVD authoring 
system.

For  subtitling,  click  on  Subtitle  → Device and  select  your  DVD Authoring  System. 
Using the font icon in the Preview Window toolbar, choose the desired font attributes and 
then click OK. Then go to File → Export and select the group DVD/DVD2000/Webcast  
Subtitle radio button. Choose your DVD Authoring System and continue. Once you are 
done, import the exported CPC files into your authoring system for subtitles. 

Please consult the  Subtitling Chapter for a detailed step-by-step tutorial to caption and 
subtitle DVDs.

Caption a Video Using an NLE System With CCaption
If you are not using CaptionMaker, you would need another software CCaption-NLE to 
caption a video residing on an NLE system without using an encoder. Go to  File  → 
Export  and  choose  the  Caption  Formatted radio  button,  then  select  CPC/Leapfrog 
CCaption(*.onl) or CPC-715 Online Caption (*.onl) from the drop-down menu. Enter a 
file name and click on Finish.  Now you must import this file into CCaption-NLE. The 
instructions  differ  depending  on  which  NLE  you  have,  so  it  is  best  to  consult  the 
CCaption manual at this point. 



110 CaptionMaker for Windows

Caption a Video Using an NLE System With 
CaptionMaker-NLE/HD

To caption/subtitle digital video using CaptionMaker-NLE, check the chapter on 
CaptionMaker-DV/NLE/HD for details.

Caption a Video for Webcast
For this process you must first choose the type of online media player you would like to 
use (RealPlayer, Windows Media Player, or QuickTime). 

• Once you have chosen a media player and you have a compatible file for it, go 
to File → Export and select the DVD/DV2000/Webcast radio button. 

• Then choose the desired file type from the drop-down menu. 
• Name the file and click on Next. The dialog box will offer different options 

depending on the selected media player. 

Please  consult  the  Webcasting  section  of  this  Manual for  detailed  step-by-step 
instructions.

Caption Tips 

Suggestions for Breaking Lines
Watching captioned programs on television will show you how professional captioning is 
done, including breaking text into individual captions, positioning the captions and use of 
time  sequencing.  You  will  notice  that  many  times  professional  captioners  adjust  the 
timing of the captions to give uniform readability. 

Various signs indicate that text needs to be broken into separate captions. 

1. End a caption at the end of a sentence. The import file option can make these 
breaks automatically (“.”, “?”, and “!”)

2. End captions at commas and semicolons if they come at a natural pause in the 
dialog and conclude a phase. The import file option can make these breaks 
automatically as well, but there are many commas in English that are NOT good 
places to break text.

However, when you break text into individual captions, they should make grammatical 
sense. Here is an example:

Unformatted, Raw Text:
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On the way to the airport, I got caught in 
traffic and ended up being late for my 
flight. I had to wait around for five hours 
to catch the next available flight.

A poor way to caption it:
On the way to the airport,

I got caught in 
traffic and ended up being late
for my flight. I had to wait

around for five hours to catch
the next available flight.

A good way to caption it:
On the way to the airport,
I got caught in traffic
and ended up being late

for my flight.
I had to wait around

for five hours
to catch

the next available flight.

We will go over some basic captioning guidelines. The first basic convention concerns 
the difference between how you represent on-screen and off-screen speakers. The words 
spoken by off-screen speakers (commonly narrators) appear in italics (but italics can be 
skipped if the speaker comes in and out of view). The words of on-screen speakers appear 
in the normal (roman) font. 

The next convention concerns centering and non-centering. Captions indicate the location 
of the speaker, and should appear under the speaker. However, if centering the caption 
interferes with a graphic and/or important on-screen visual information, then the caption 
should be moved to another location.

The main objective is to have each caption represent a single thought. There is no single 
right way to caption a video, but a few additional guidelines may help:

1. Your captioning style should be consistent throughout the video.
2. Whenever possible, you should break captions into logical phrases. Captions 

randomly broken up may convey a different meaning than intended. 
3. Captions can indicate the location of the speaker. For instance, a caption on the 

left side of the screen will indicate the speaker is on the left, while a centered 
caption shows that only one person is speaking throughout a scene.

4. Words can be emphasized with underlining.
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5. Use Attribute → Insert Music Symbol to place a musical note at the beginning and 
end of musical lyrics. Never paraphrase lyrics. Use the title of the song when 
possible.

6. Indicate sound effects in parentheses in lower case: (boom), (applause).

Suggested Styles and Conventions 
Caption Media Program (National Association of Deaf) has created a style guide, which 
is available from www.cpcweb.com/download/CaptionKey.pdf. 

This is a very helpful guide to understand the styles and conventions used to caption a 
video.  We strongly encourage  you  to  read this  document  before producing captioned 
video.

 

http://www.cpcweb.com/download/CaptionKey.pdf


C h a p t e r  5
S u b t i t l i n g

Overview
The CaptionMaker can be used to subtitle multiple types of media:

Analog Video
DVD
Webcast
Digital Video (DV, Mpeg2 and video residing on NLE systems) with CaptionMaker-DV/ 
NLE/ HD

Subtitling Digital Video If you like to subtitle digital videos like AVI, 
mov with CaptionMaker-DV/NLE/HD, go to chapter 6.

Subtitling is  similar  to  captioning  and  consists  of  the  same  basic  steps  discussed  in 
Chapter 4 (Transcribe, Import, Format, Position, Time Code). Subtitling does not involve 
the font and attribute limitations common to captioning. If you can see a font on the 
Windows screen, you can reproduce it on the subtitling device. For devices such as the 
MagniCoder Pro, DVD or DV2000, ITVInjector there are no extra steps to create these 
special character sets. However, for the Chyron Codi Character Generator, a small set of 
default  Codi  fonts  are  provided  by  the  CaptionMaker.  If  you  would  like  to  use  the 
Windows font of your choice with the Codi, you will need to convert the Windows font 
(or graphics image) into the appropriate formats using the optional Chyron Font Create 
software, which is available from CPC. 

All fonts used for subtitling should have a border around each character  to increase the 
contrast between the characters and the background. Therefore, it is advisable to choose 
fonts for subtitling that  are thicker and taller and do not have serifs (curly tails on the 
letters).

Subtitling is typically intended for an audience that can hear, but cannot understand the 
original language of the movie or video. Therefore you do not need to indicate by subtitle 
placement which person is speaking or the presence of music or sound effects. However, 
you  may  occasionally  wish  to  use  subtitles  instead  of  closed  captions  for  a  hearing 
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impaired audience. In this case you should use the captioning style (such as indicating 
sound effects) as discussed at the end of Chapter 4. Subtitles created with a character 
generator are easier to read than the output of a closed caption decoder.

Subtitling Devices
Using CaptionMaker software you  can  subtitle videos on various media. In some cases 
you will use subtitle character generators or other subtitle hardware devices to create the 
final subtitled video. In other cases, you will simply create a file to be used by some other 
organization to place the subtitles on a specific medium.  Hardware requirement details 
are listed in the table below.

Media Hardware Transfer via Software needed to transfer
subtitles

DVD DVD 
Authoring 

Picture files DVD Authoring

Webcast Web Server Media files HTML editor like FrontPage 
and File Transfer software like 
WsFTP

International Languages and Fonts 
If you have a file in Microsoft Word or WordPerfect in a language other than Western 
European languages such as English,  Spanish, French, German, Portuguese or Italian, 
you may need to manipulate the text to see it in the Work Area. After importing a file, if 
you  do  not  see  the  text  in  the  appropriate  language,  you  must  change  the  font. 
CaptionMaker uses Windows Arial font, which covers almost all languages. 

But for non-Western European languages, you must assign the font to the Work Area. 

• Click on the Image Font  icon on the Operations Center. The Image Font 
dialog box will appear. Current font and script types are shown. 

• Click on the Select button next to the current font type. (This is illustrated in 
the screenshots that follow.)
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A Font dialog box will open. From the Font dialog box, the font type, style, size, color 
and script can be changed. 
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• Choose the appropriate font and size. But most important, click on the Script 
list box. It will probably show Western. 

• Slide down the list box until you find the appropriate language group. Then 
click on OK.

• Again click on OK in the Font dialog box. 
• CaptionMaker will ask whether you would like to update the font used in the 

grid area. Click on Yes. Now the Work Area will show the appropriate font 
for the language you are using.

There  is  a  sample  Russian  file  in  the  C:\ProgramFiles\CPC\CaptionMaker\Samples 
folder.  Try to import the file and the Preview Window will show the font properly as 
below.

But in the Work Area the text will look like this:

Â 1884 ãîäó â Àòëàíòè÷åñêîì
îêåàíå çàòîíóë êîðàáëü.

After you change the Font Script as described above, the text will also change to 
В 1884 году в Атлантическом

океане затонул корабль.

Keyboards for International Languages
See the information on selecting a keyboard in Chapter 2. The CPC CaptionMaker allows 
use of any Windows keyboard layout.

Chyron Codi and PC Codi Card
Users of older versions of the CaptionMaker should notice that there is no longer a need 
to run the PC Codi card driver software. The PC Codi driver automatically loads the fonts 
chosen by the user as soon as you try to send the first subtitle. It takes a while to load all 
the fonts (depending on how many are chosen in the Codi font list box). 

After the fonts are loaded, the Default  Horizontal  Shift is set to 115. For most video 
sources,  centered  subtitles  will  now  appear  centered  on  the  video  screen.  Minor 
adjustments may be necessary with certain video setups. To fine-tune the system, run any 
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professional  video  with  centered  graphics,  and then  send a  subtitle  to  the  video  and 
compare it with the graphics’ position. Change the value of the Horizontal Shift until the 
subtitle is centered with respect to the graphics.
.
The Codi device provides the character width and height from newly uploaded fonts and 
stores these widths in the Registry. This only occurs the very first time a font is loaded.

An  Advanced  button  is  now  available  for  Codi  font  properties  to  allow  special 
customized padding or spacing to account for non-exact widths. This is necessary for 
some fonts (e.g., italics) because the mechanism used to get the width apparently is not 
exactly what the Codi uses. 

There are Codi fonts for five language sets (both normal and italics) in the C:\Program 
Files\CPC\CaptionMaker\Fonts folder. The files that end with an “i” are the italics fonts. 
The italics fonts are of same size and style as the normal fonts of the same group.

Groups Languages Codi Fonts
US ANSI English, French, German UsEuro41.cdi

Italian, Portuguese, Spanish UsEuro41i.cdi

Eastern Czech, Polish, Romanian, EEuro42.cdi
European Slavic EEuro42i.cdi

Greek Greek Greek42.cdi
Greek42i.cdi

Russian Russian Russ57.cdi
Russ57i.cdi

Turkish Turkish Turk45.cdi
Turk45i.cdi

There are two radio buttons for Codi font types: 
Codi default font format 
Windows Font Convert Format

Because the accented characters stored in the font files are different in the above two font 
formats,  CaptionMaker  must  be told  what  kind of  font  you  will  upload  to  the  Codi. 
Otherwise the accented characters will not appear correctly.  If the accented characters 
appear wrong, go to the Codi Font dialog box and change the radio button for the font. 
The characters should then work properly.
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Codi and PC-Codi

Upload and Assign Subtitle Font Type
Click on the Subtitle → Device menu. Make sure to choose the Chyron Codi or Chyron 
PC-Codi. Click on OK to go back. Now click on the Subtitle Properties button to modify 
them.

Click on the Fonts tab to upload fonts and assign font types. The following dialog box 
will appear.

In the following example we are going to upload 2 fonts:

UsEur41.cdi in font slot #2 (Normal font) and
UsEur41i.cdi in font slot #8 (Italics font) 
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Follow the following five steps to do this:

1. Click on 2 Unknown on the top area of the dialog box.
2. Click on the Browse button to choose the font UsEur41.cdi from 

C:\ProgramFiles\ CPC|CaptionMaker/Fonts folder.
3. Click on the radio button: Chyron Windows Font Convert Format in the middle of 

the dialog box to indicate that this font was originally created by Chyron 
Windows Font Convert Software.

4. Click on the  button for Normal font type; choose 2 Unknown.
5. Finally,  Click  on  Upload to  upload this  font,  which is  going to  be used as a 

normal (roman) font.

For font #8 (UsEur41i.cdi) follow the same procedure. Make sure you click on the   
button for Italics font type.

Now all the text in normal font will use UsEur41.cdi (normal) Codi font and text typed in 
italics will use UsEur41i.cdi (italics) Codi font. You may do this for up to 8 fonts, the 
maximum number that can be loaded.

If you assign a third font as Bold, you must type the text in bold (in the CaptionMaker) in 
order to access the font you assigned to bold with the Codi.

Tip  You can access all 8 fonts for the same project as long as you 
upload all 8 fonts to the Codi. To access those fonts, you need to 
open the visible column Font by invoking View → Visible Columns → 
Codi Font menu as below. Now right-click on any row under Font and 
choose the desired font. Or you may highlight a number of rows and 
assign a particular font for all rows.
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Codi Default Fonts
Up to 8 fonts can be simultaneously loaded into the Codi. When the Codi external box is 
turned on, the first 7 slots are loaded with Swiss fonts and the last slot is loaded with TV 
Ratings Images (in newer Codi machines only). 

The  PC Codi  card  does  not  have  any fonts  loaded. But  the  CaptionMaker  software 
automatically loads these fonts when you choose the Codi card as your subtitling device. 
Any of these fonts may be overwritten by a user-chosen font, which may be created by 
the user (see the next section).

Each font is described by two characteristics: the height of the characters in the font, in 
scan lines (there are 525 scan lines per screen), and the number of pixels of border or 
drop shadow between the character and the background. For subtitling, font number 2 (33 
scan lines high with a 2-pixel shadow) is the best choice.

Choosing the Default Fonts
In order to choose the normal text font, use the list box called Normal Font. You can also 
choose a font with bold, underline or italic attributes. If you have not selected a font with 
these attributes, the normal font will be used. 

The Refresh button will verify that communications with the Codi are working properly 
and will display a list of fonts that  are currently loaded into the Codi. The Codi will 
remember downloaded fonts until it is switched off.
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Changing the Fonts
To change a font, click on one of the 8 font slots listed in the dialog box, and then click 
on the  Browse button.  The  Choose Chyron Codi Font dialog box will appear.  It will 
default to looking for fonts with an extension of .CPC. When you have selected the font 
that you would like to replace,  click on it.  The screen will not update until you have 
clicked the Update button to actually download the font to the Codi. If you have more 
than one font that  you would like to change, pick all  of them that you would like to 
change before clicking the Update button. Note: This download is a lengthy process, but 
you should not need to do it more than once a day. 

Selecting Colors
The Colors tab in the Properties dialog box will allow you to change the colors used by 
the Codi. 

There are eight text colors and a default color. The eight colors are accessible from the 
Attribute → Text Color menu item. Simply highlight text and then change the color. 
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Specifying User-Defined Colors
Each of the eight colors can be assigned a precise color from the 16,777,216 possible 
combinations of red, green and blue available when you click on a color button. In order 
to specify a color, you need to enter values from 0-255 for red, green, and blue. It is best 
to note exactly which values you use, because it is difficult to match colors later. 

When you pick a color for the text itself, you are also picking a color for the border or 
drop shadow behind the character. This edge color icon is located to the right of the color 
icon for the body of the text. 

Changing the Default Output
Note that in order to make the default color change on the video screen, you must check 
the  box that  will  send a  different  default  foreground color.  This  foreground color  is 
chosen from the eight colors you have specified above in the dialog box.

Chyron Codi Windows Font Create Software
If you have a licensed version of the Chyron Codi Windows Font Conversion software 
(available from CPC), you may create Codi fonts from Windows TrueType fonts and use 
them with the CaptionMaker.

A  font  for  use  in  subtitling  requires  a  border  around  each  character.  Each  desired 
Windows font must first be converted with the Chyron software and then placed in the 
appropriate directory (selected under the Fonts tab in the Properties dialog box) so that 
the CaptionMaker can see it. You should associate the Windows font used to create the 
Codi font with the Codi font from that screen, so that what you will see on the screen will 
match what you see on the finished video.

Each Codi font has 191 positions in which you may fit information (e.g., letters). For a 
user-defined font, they correspond to whatever the first 191 letters are in the Windows 
Character Map. See the Chyron Codi Windows Font Conversion software manual  for 
further information.

DVD Captioning and Subtitling Overview
With CPC CaptionMaker software, you can both caption and subtitle DVD. Captioning 
and subtitling are very different, and there are different options to choose and different 
procedures to follow in each case. 

You need a DVD authoring system to caption or subtitle a DVD. The function of the 
CaptionMaker is to generate the appropriate caption or subtitle files needed by the DVD 
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authoring system. Please note that the CaptionMaker does not have the capability to add 
captions or subtitles directly to the DVD medium.

DVD Multiple Language Capability
A DVD disk has different tracks to hold the caption and subtitle data. There are 6 tracks 
for captioning and 32 tracks for subtitling. So you can caption the same DVD disk in up 
to 6 languages and also subtitle in up to 32 languages. This makes the DVD a medium 
much more accessible than conventional videotape. A DVD user can press a button to 
display captions or subtitles on any one of the tracks as long as caption or subtitle data 
has been added to those tracks. In practical  use, a DVD is typically captioned and/or 
subtitled in just a few languages.

Create a CPC Time-Stamped File First 
Create a time-stamped script using the CaptionMaker software exactly the same as you 
would create a file for conventional videotape (See “Chapter 4: Tutorial”). Then you need 
to export the file to the appropriate DVD authoring system. You may create multiple files 
for multiple languages using the CaptionMaker and then you can add all those languages 
to the DVD using the DVD authoring system. See the “Import/Export” section in Chapter 
3 for details on creating the time-stamped file in one language from scratch and then 
producing the time-stamped file in another language in almost no time.

DVD Captioning
Creating a DVD caption file is relatively simple compared to creating a DVD subtitle 
file. A DVD caption file is universal for all DVD authoring systems. To create  a  DVD 
caption file, use the same procedure as you would to create a caption file for conventional 
video. Although you are not using an encoder or a captioning device for this task, you 
still need to choose a device in order to set the software in caption mode. 

Use the step-by-step procedure below, in which the Spruce DVD system is used as an 
example. 

1. Choose EEG DE241 CG as a default caption device (Caption → Device → EEG 
DE241 CG).

2. Create the time-stamped file. (Follow instructions in “Chapter 4: Tutorial”.)
3. Export the captions to the proper authoring system (File  → Export  → Caption  

Formatted File →  Spruce DVD Caption).
4. Import the above exported file from CPC into the DVD authoring system.
5. Follow the DVD authoring system instructions to create the DVD with captions.
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Here is a sample DVD caption file exported from CPC CaptionMaker for the Spruce 
DVD authoring system.

Scenarist_SCC V1.0
00:19:54:11 94ae 9420 94d0 49a7 cd20 c154 2054 c845 204c 4546 5480 9470 4f46 2054 c845 

20d3 4352 4545 ceae 942c 8080 8080 942f

00:19:56:01 94ae 9420 94d0 d34f 2043 c1d0 5449 4fce d380 9470 4f46 2057 c8c1 5420 4920 
d3c1 d980 942c 8080 8080 942f

00:19:57:09 94ae 9420 94d0 c1d0 d045 c152 20c1 5420 54c8 4520 4c45 4654 9470 4f46 2054 
c845 20d3 4352 4545 ce2c 2054 4f4f ae80 942c 8080 8080 942f

00:20:00:03 942c

00:20:00:23 94ae 9420 9454 9723 ce4f 5720 49a7 cd20 c154 2054 c845 2052 49c7 c854 94f8 
97a1 4f46 2054 c845 20d3 4352 4545 ce2c 942c 8080 8080 942f

00:20:02:17 94ae 9420 9454 97a2 d34f 20cd d920 43c1 d054 494f ced3 20c1 d0d0 45c1 5280 
94f8 97a2 c154 2054 c845 2052 49c7 c854 ae80 942c 8080 8080 942f

A  number  of  DVD  authoring  systems  are  listed  in  the  Export menu,  including  the 
following:

Daikin DVD Caption
Sonic Solutions DVD Caption
Spruce DVD Caption

Internally all DVD caption files are the same. The only differences are the header lines 
inside the file and the file extensions. If you have a DVD authoring system other than the 
above three, please consult the manual and inform CPC of the differences. We will try to 
incorporate the changes and add your DVD authoring system to the Export DVD Caption 
list. In the meantime, call us and we will try to make 
the minor changes needed to use the file with your authoring system.

DVD Subtitling
Creating  a  DVD  subtitling  file  is  much  more  involved  and  complex  than  DVD 
captioning. It is recommended that you read this entire section. For some DVD authoring 
systems, you can export two kinds of files for DVD subtitling:

Text file format
Picture file format

If you create a text file format, you must choose the font from the DVD authoring system 
and the DVD authoring system will control the subtitles’ appearance. On the other hand, 
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if you choose the picture file format, you will choose the font from the CaptionMaker and 
you will have total control of the appearance. It’s your choice.

If you have a video with 1,000 subtitles in the text file format, the  CaptionMaker will 
create only one text file and the exported file size will be very small (perhaps 50KB). 

If  you  have  a  video  with  1,000  subtitles  created  in  the  picture  file  format,  the 
CaptionMaker will create 1,001 files – 1,000 Windows picture files (.bmp, .tif etc.) and 1 
text (navigation) file (.txt, .scr etc.). The size of all the files together could be anywhere 
between  50MB and  500  MB.  Because  of  the  enormous  size  of  these  files,  they  are 
automatically exported to a zipped file. This is discussed in more detail later.

If you feel you already understand the concept and would like a quick rundown of the 
steps taken to create  DVD subtitling picture  files,  here  is  a brief  overview using the 
Spruce DVD Maestro TIF Graphics (*.zip) as an example:

1. First, choose the subtitling device (Subtitle → Device → DVD/DV2000/Webcast  
Subtitle → Spruce DVD Maestro TIF Graphics (*.zip)).

2. Create the time-stamped file (see “Chapter 4: Tutorial”).
3. Adjust the font settings, background color, margins, letter spacing, etc. (Use the 

icons  and  labeled Preview Window on the right side)
4. Export the file (File → Export → Spruce DVD Maestro).

Export DVD Subtitle Files
Here is a detailed discussion on how to export DVD subtitle files – both text and picture 
formats. 

Choose DVD Subtitle Device
Choose the appropriate DVD subtitle device. You must not leave the device as a default 
caption device. To choose a subtitle device, click on the Subtitle menu at the top of the 
screen and choose Device…

Choose the appropriate subtitle device and you are ready to begin.

CPC can export DVD subtitling files for the following DVD authoring systems:

Apple DVD StudioPro
Adobe Encore
Daikin Scenarist (Now under Sonic Solution)
DVD CVC
Pinnacle Impression    
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Sonic Solutions 
Spruce DVD Maestro 
Generic DVD System

Some of the above systems support multiple formats, which CPC also supports. Details 
will be discussed in this chapter.

After you have chosen the right device, you must export the file to your DVD authoring 
system format. For example, if you are using a Daikin system, choose the first option 
(Daikin Scenarist TIF Graphics).

Note on “Generic DVD System” Option   If your DVD system is not 
one of the brand names listed and if you know the specifications of 
the picture files, you may choose this option. You should select the 
proper colors and picture file size from the choices described below. 
If you have trouble making the right choices, you may contact us and 
we  will  try  to  implement  your  brand  of  DVD  system  in  the 
CaptionMaker software.

Create a Time-Stamped File
At this point we are assuming that you have already created a subtitle file for the video in 
which you both positioned and time-stamped the subtitles. Follow the steps in “Chapter 
4: Tutorial” to create the time-stamped file using the video and synchronize the subtitles 
with the time code. (In other words, the process of repeatedly pressing the plus key [+] to 
capture time codes is already over.)

Adobe Encore
The exported file for Adobe Encore is essentially a text file with a special formatting. 
Note that Adobe Encore requires these files to be in UTF-8 format, but CaptionMaker 
exports them in standard text format. To convert them to UTF-8, open them in Windows 
Notepad and then “Save As” and select UTF-8 encoding.

Sample  File
00:00:33:13 00:00:36:25 Up until now, we have been
using pop-on captions.
00:00:36:27 00:00:41:08 When a new caption pops on,
the old caption disappears.
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Export DVD Subtitle Text Files
At this point you are ready to export DVD subtitle files in text format. To export DVD 
subtitle text, go to File → Export; select the radio button DVD/DV2000/Webcast Subtitle 
and choose the format from the drop down list 

• DVD Studio Pro (ver. 3)
• Sonic Solutions Text (*.txt)
• Spruce STL Script File (*.stl)

STL Subtitle Text file exports for Spruce & DVD StudioPro (Simple 
and Extended Positioning)  There are two STL text exports for both 
DVD  StudioPro  and  Spruce  DVD  Maestro  with  “standard”  or 
“extended” positioning information.

The standard positioning, which is to be used if all your subtitles are 
set  to  the  Center  and  Bottom.  On  the  other  hand  the  extended 
positioning is to be used if you have subtitles on different parts of 
the screen.  Note that if you are doing extended positioning, you will 
have to make sure that the fonts and sizes you use to format the 
subtitles are the same fonts and sizes you use in DVD StudioPro and 
Spruce to build the DVD.

Extended  positioning  actually  generates  internally all  the  subtitle 
images (tiffs) according to your choice of font then finds the exact 
positions  of  the  subtitles.  The  file  does  not  contain  the  subtitle 
images (tiff), it contains the actual text.

Before exporting the file, make sure the margins - top, bottom, left 
and right are set correctly. In most cases you need to set all margins 
to 0. In other cases, you need to set the margins as 72 for left and 
right and 48 for top and button depending on what settings you will 
use in DVD StudioPro and Spruce DVD authoring software.

After you choose the appropriate option, type the file name to save the file and you are 
done.  Below  are  two  sample  file  formats  for  the  simple  positioning  and  extended 
positioning.

Spruce STL file  (Simple Positioning)

$FontName           = Arial
$FontSize           = 20

$HorzAlign          = Center
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$VertAlign          = Bottom
$XOffset            = 0
$YOffset            = -48

00:00:00:01 , 00:00:01:28
00:00:02:00 , 00:00:07:28 , [music]
$HorzAlign = Left
$XOffset   = 72
00:00:08:00 , 00:00:09:16 ,I'm at the left|of the screen.
00:00:09:18 , 00:00:11:00 ,So captions|of what I say
00:00:11:02 , 00:00:12:28 ,appear at the left|of the screen, too.
00:00:13:00 , 00:00:14:14
$HorzAlign = Right
$XOffset   = -72
00:00:14:16 , 00:00:16:09 ,Now I'm at the right|of the screen,
00:00:16:11 , 00:00:18:07 ,so my captions appear|at the right.
00:00:18:09 , 00:00:19:17
$HorzAlign = Center
$XOffset   = 0
00:00:19:19 , 00:00:21:02 ,^INow I am off screen.
00:00:21:04 , 00:00:22:23 ,^ITo indicate that|^II'm off screen,
00:00:22:25 , 00:00:24:25 ,^Iwhatever I say is italicized.

Spruce STL file  (Extended Positioning)
$HorzAlign = Center
$XOffset   = 0
$VertAlign = Bottom
$YOffset   = -48

00:00:02:00 , 00:00:07:28 ,§ music §
$HorzAlign = Center
$XOffset   = -196
00:00:08:00 , 00:00:09:16 ,I'm at the left|of the screen.
$HorzAlign = Left
$XOffset   = 72
00:00:09:18 , 00:00:11:00 ,So captions|of what I say
$HorzAlign = Center
$XOffset   = -168
00:00:11:02 , 00:00:12:28 ,appear at the left|of the screen, too.
$HorzAlign = Right
$XOffset   = -72
00:00:14:16 , 00:00:16:09 ,Now I'm at the right|of the screen,
00:00:16:11 , 00:00:18:07 ,so my captions appear|at the right.
$HorzAlign = Center
$XOffset   = 0
00:00:19:19 , 00:00:21:02 ,^INow I am off screen.
00:00:21:04 , 00:00:22:23 ,^ITo indicate that|^II'm off screen,
00:00:22:25 , 00:00:24:25 ,^Iwhatever I say is italicized.

Note:  The  $Xoffsets  are  different  for  different  subtitles  in  the  extended  positioning  
compared to the simple positioning.

Sonic Producer text file
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1 00:00:02:00 00:00:07:28 [music]
2 00:00:08:00 00:00:09:16 I'm at the left

of the screen.
3 00:00:09:18 00:00:11:00 So captions

of what I say
4 00:00:11:02 00:00:12:28 appear at the left

of the screen, too.

Sonic Solutions Text File

1 00:00:02:00 00:00:07:28 [music]
2 00:00:08:00 00:00:09:16 I'm at the left
of the screen.
3 00:00:09:18 00:00:11:00 So captions
of what I say
4 00:00:11:02 00:00:12:28 appear at the left
of the screen, too.

For DVD subtitle picture file format, go through a few more steps described below. 

Export DVD Subtitle Picture Files
To create  DVD subtitle  picture  files,  do  the  following  two steps  you  used  to  create 
subtitle text files earlier:

1. Choose the proper DVD device
2. Create a time-stamped file

Then go through a few more steps to complete the job (detailed instructions follow):

3. Choose font size and style
4. Assign color 
5. Adjust margins
6. Export DVD graphics file

Font Style and Size 
Click on the Image Font icon  on the Preview Window and a dialog box will open. 

Make sure to choose an appropriate font. For most Windows fonts, sizes 16 to 20 will 
work well. If each subtitle contains a lot of text, use a smaller font size. If you use a font 
that is too large, lines will wrap unexpectedly within subtitles. If this happens, reduce the 
size.
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Note  on  Kerning       Kerning  is  the  amount  of  space  between 
characters.  If  you  use  a  negative  value,  the  characters  will  move 
closer. If you use a positive value, the characters will separate.

For the best result, CPC recommends using the following font attributes. Of course, you 
can experiment with these numbers to see how they change the final picture file.

Arial 18 or 20 Bold font
Character Pixel Kerning = –2 (space between two characters)
Line Pixel Spacing  = 5 (extra space between two lines of a two line subtitle)
Space Character Width = 0 (space between two words)
Character Border = 2

“Double Bold” Tip    To achieve the best output, use Arial Bold 18 
and also select  the text  and apply bold in  the CPC program. See 
below.

Bold Text
To make the text bold, click on the header Caption/Subtitle above the Work Area. This 
will highlight the entire text.

Object 5

Now click on the Bold   icon on the toolbar. This will make the whole text bold as 
shown above. Using “double bold” (applying the bold option in addition to using a bold 
font) should produce the best result.
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Keep in mind that if you choose a font too large, the subtitles will break into multiple 
lines and you will lose your formatting. When you are generating the subtitle files, you 
will receive an alert if that happens. So we suggest that you choose a smaller font and 
keep the subtitles as compact as possible.

Color Adjustment 
Click on Image Color icon  on the Preview Window panel next to the  icon.

Choice of Preview background color has no effect on the final picture file. This is only 
used for viewing images on the CaptionMaker screen.

Background Type is not accessible to the user. The various DVD authoring systems use 
different background color information to superimpose the picture files on the video 
properly. The background color does not show on the video. It is needed only to create 
the picture files.

Anti-Alias smoothes out the contours of characters and gives a sharp look that makes the 
subtitles look good. Otherwise the characters’ edges would appear jagged.

If you would like to see the subtitles in white with a black border, do not change the 
foreground, background, border and anti-alias colors. They have been preset for the 
appropriate DVD authoring systems. 

Some authoring systems, such as CVC, Pinnacle and Sonic, do not allow for any choice 
of colors. For Daikin and Spruce, you may change the foreground, background, border 
and anti-alias colors to those you desire. Default user-defined colors (which are same as 
the final color mappings) are listed in the table that follows.

DVD System Foreground * Background* Border* Anti-Aliasing*
CVC Fixed - White Fixed - Gray fixed Fixed - Light Gray
Daikin (255,255,255)

White
(0,0,128)
Gray

(0,0,0)
Black

(128,128,128)
Light Gray

Pinnacle Fixed - White Fixed  - Gray fixed fixed - Light Gray
Sonic Fixed - White fixed - Gray fixed fixed - Light Gray
Spruce (255,255,255)

White
(0,0,128)
Gray

(0,0,0)
Black

(128,128,128)
Light Gray

Generic (255,255,255)
White

(64,64,64)
Gray

(0,0,0)
Black

(128,128,128)
Light Gray

Daikin, Sonic Solutions and Spruce choose to use colors different from the user-selected 
colors to create the picture files. If you open a picture file using Adobe Photoshop or any 
other  image-viewing  software,  you  will  see  the  following  colors  associated  with  the 
picture. 
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DVD System Foreground* Background* Border* Anti-Aliasing*
CVC (255,255,255)

White
(64,64,64)
Gray

(0,0,0)
Black

(128,128,128)
Light Gray

Daikin (0,0,255)
Blue

(255,255,255)
White

(0,0,0)
Black

(255,0,0)

Pinnacle (255,255,255)
White

(0,0,255) (0,0,0)
Black

(128,128,128)
Light Gray

Sonic (0,0,255)
Blue

(255,255,255)
White

(0,0,0)
Black

(255,0,0)
Red

Spruce (0,0,255)
Blue

(255,255,255)
White

(0,0,0)
Black

(255,0,0)
Red

Generic User defined User defined User 
defined

User defined

* Numbers in parentheses in the table above are Red, Green and Blue, respectively.

Warning  on  Colors     In  general,  subtitle  characters  are  white 
(foreground) with black borders. After creating the picture files, you 
might notice the colors used in the picture file are not same as the 
colors used on the Image Colors dialog box, but they must be same 
as those described in the above table.

Margin Adjustment 
To  adjust  the  margins,  click  on  the  Margin  icon  .  The  CaptionMaker  software 
automatically  sets  the margins  at  10% of the size of the screen.  You do not  need to 
change them unless you have a special requirement.

Full Screen View
Click on the Pop Up Preview Window  icon to see the subtitle picture full-screen. This 
is how the subtitle will look on the DVD. 

Export DVD Subtitle Picture File
To export DVD subtitle picture files, follow these instructions:

1. Point to the File menu. 
2. Click on Export and a new menu dialog box opens up. 
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3. Select the radio button DVD/DV2000/Webcast Subtitle, and choose the desired 
format from the drop-down list.

4. Now click on the Browse button to indicate where to save the file. 
5. Then click on Next.

You will need to furnish the following information:

Image Prefix
Description (optional)
Graphics file size 

Script Name
The name of the script (navigation) file. The default name is automatically going to be 
assigned as the name of the CaptionMaker file. If you like, you may change it to any 
name (preferably up to 8 characters).

Image Prefix
The Image Prefix  can be anything  up to  four characters.  The reason for limiting  the 
length to four is to accommodate 9,999 caption images, which at this point in time is 
more than you will ever need. Now, you may ask, why would a 5-character-long image 
prefix not be able to accommodate 9,999 caption images?

Some  DVD authoring  systems  do  not  allow an  image  file  name  to  be  more  than  8 
characters. The first four characters of the file name constitute the Image Prefix, and the 
last four denote chronological order (from 0000 to 9999).

Description
You may add a video description in this field. This information will be added to the script 
(navigation) file. For DVD subtitles to work properly, it is doesn’t matter whether you 
add a name or not. 

Graphic File Size
This field is normally grayed out for most DVD authoring system. It shows the size of the 
graphic (picture) files. Some DVD authoring systems ask for the picture to be the size of 
the actual subtitle and others require a full-size picture file (720x480 for NTSC).

The picture file screen sizes for all DVD systems are listed below. 

DVD System Picture Size
CVC Each bitmap size will be the actual size of each subtitle
Daikin Each bitmap size will be full-screen size
Pinnacle Each bitmap size will be full-screen size
Sonic Each bitmap size will be the actual size of each subtitle
Spruce Each bitmap size will be the actual size of each subtitle
Generic Each bitmap size will be full-screen size
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After you are done with these, click on the Finish button. The CaptionMaker will create a 
zipped file or text file with the specified name. Examples of these two sizes of DVD 
picture files follow.

   
DVD bitmap’s size is equal to the full-screen size of the video.

 
DVD bitmap’s size is equal to the actual size of each subtitle.

Verify Subtitle Rendering
If this box is selected, at the time of exporting the picture files the CaptionMaker will 
check any unwanted breaking of each and every subtitle. This unwanted breaking could 
happen if you choose a large font. For example,  a two-line subtitle may break into a 
three-line subtitle. In that event, the following dialog box will open. 
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The CaptionMaker will not bring the cursor to the exact row, but the Preview Window 
will show which row has the problem. If you would like to fix the problem, click on the 
No button and check the text in that row. You have two solutions:

1. Break the row up into two rows, or 
2. Change the font to a smaller size.

The recommended remedy is to break up the text into two lines. You probably will not 
want  to  change  the  default  font  for  the  whole  production  just  to  accommodate  one 
oversized row. After doing any one of these, once again follow the same procedure of 
exporting the DVD formatted subtitles.

Final Step: Export the File
Finally, click on the Finish button to export the subtitle files. After you export the files, 
locate the folder where you exported the zipped file(s). Unzip the files to sample-check a 
few of these files. The text (script) file should look like one of the following sample files. 
The picture file should look like one of the two bitmap subtitle pictures shown previously 
under “Graphics File Size”.

Note on Number of Picture Files     If for some reason you see fewer 
files than you expected, don’t panic. The blank lines in the caption 
file are ignored, decreasing the number of subtitles. 

Also duplicate/triplicate captions marked with the same time code 
are formed into a single picture file, decreasing the total number of 
files. 

Examples of Navigation (Text) Files

CVC Navigation File
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# DVD Subtitle file 10/31/01 1:55:53 PM
# Filename:   Video.scr
# Language:   09 - English
# Subtitles:  42
#
# Start:      00:19:55:04
# End:        00:21:19:18
# Font:       Arial
#
Vide0001.bmp 00:19:55:04 00:19:56:20 576 384 72 48
Vide0002.bmp 00:19:56:22 00:19:58:04 576 384 72 48
Vide0003.bmp 00:19:58:06 00:20:00:02 576 384 72 48
Vide0004.bmp 00:20:01:20 00:20:03:13 576 384 72 48

Daikin Navigation File
st_format 2
################################################################
# Daikin Scenarist Script
#---------------------------------------------------------------
# Filename:   Daik.nav
# Created:    7/17/00 8:10:03 PM
# Time Code:  DropFrame
# Video Mode: NTSC
# Author:     CPC CaptionMaker Version 1.10
################################################################

TV_Type       NTSC
Tape_Type     NON_DROP
Base_Time     01:03:24:22
Pixel_Area    (48 430)
Display_Area  (72 48 646 430)
Color         (2 4 3 3)
Contrast      (14 15 15 0)
BG            ( 255 255 255  = = = )
PA            ( 0 0 0  = = = )
E1            ( 0 0 255  = = = )
E2            ( 255 0 0  = = = )
Directory     
################################################
SP_NUMBER     START       END       FILE_NAME
0001      01:03:24:22 01:03:26:19   Daik0001.tif
0002      01:03:26:21 01:03:27:29   Daik0002.tif
0003      01:03:28:01 01:03:31:06   Daik0003.tif

Pinnacle Impression Navigation File
00:19:55:04 00:19:56:20 VDO0001.bmp
00:19:56:22 00:19:58:04 VDO0002.bmp
00:19:58:06 00:20:00:02 VDO0003.bmp
00:20:01:20 00:20:03:13 VDO0004.bmp
00:20:03:15 00:20:05:11 VDO0005.bmp
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00:20:06:23 00:20:08:06 VDO0006.bmp

Sonic Solutions Navigation File 

Soni0001.tif 01:03:24:22 01:03:26:19 206 086 072 345
Soni0002.tif 01:03:26:21 01:03:27:29 194 086 072 345
Soni0003.tif 01:03:28:01 01:03:31:06 270 086 072 345
Soni0004.tif 01:03:31:08 01:03:33:05 278 086 369 345

Spruce Navigation File

st_format 2
################################################################
# Spruce Technologies SON Script for DVDMaestro
#---------------------------------------------------------------
# Filename:   Spru.nav
# Created:    7/17/00 8:14:08 PM
# Time Code:  DropFrame
# Video Mode: NTSC
# Author:     CPC CaptionMaker Version 1.10
################################################################

TV_Type       NTSC
Tape_Type     NON_DROP
Base_Time     01:03:24:22
Pixel_Area    (48 430)
Display_Area  (72 48 646 430)
Color         (5 0 2 9)
Contrast      (14 15 15 0)
Directory     
################################################
SP_NUMBER     START       END       FILE_NAME
Display_Area  (72 345 277 430)
0001      01:03:24:22 01:03:26:19   Spru0001.tif
Display_Area  (72 345 265 430)
0002      01:03:26:21 01:03:27:29   Spru0002.tif
Display_Area  (72 345 341 430)
0003      01:03:28:01 01:03:31:06   Spru0003.tif

Importing DVD files
You can import the following two types of DVD files into the CaptionMaker:
DVD caption files
DVD Text/Script subtitle files (Sonic Solutions and Spruce)

You cannot import DVD subtitle picture files into the CaptionMaker. DVD subtitle files 
include details of time code, size and position of each subtitle with a picture file for the 
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subtitle (.tif).  Because the picture file cannot be easily converted to the actual text into 
the software, DVD subtitle files cannot be imported into the CaptionMaker. 

Foreign Language Subtitles
If  you  would  like  to  subtitle  DVDs  in  foreign  languages  using  the  CaptionMaker 
software,  you  can  do  that  too.  As  of  November  2001,  CaptionMaker  supports  all 
languages supported by ANSI Windows TrueType (TTF) fonts except the Pacific Rim 
languages such as Chinese, Japanese and Korean. For some languages you have to take 
special care. CaptionMaker does not support Unicode. CPC has grouped all languages in 
four groups:

Groups Languages Supported by 
CaptionMaker

Special Action 
Needed

1 Western European Yes No
2 Hebrew, Arabic Yes (Partially) Yes
3 All other ANSI Languages Yes Yes
4 Pacific Rim Languages (Unicode) No N/A

Group 1 Languages
Characters associated with most Western European languages such as these:

Dutch
French
German
Italian
Portuguese
Spanish

These  are  covered  in  the  standard  Windows  (US)  character  set  within  the  first  256 
characters. If you import a Microsoft Word document in any of the above languages, you 
will not need to make any special effort to see all the additional accented characters of 
that language in the CaptionMaker. 

Group 2 Languages
CaptionMaker supports Hebrew and Arabic languages in a limited capacity. Since these 
two languages use the convention of writing from right to left, the CaptionMaker does 
not  handle proper  wrap around at  the end of a  line.  If  you prepare  the file  properly 
formatted and broken up into individual subtitles and each subtitle is further broken up 
into individual lines separated by a tab, you can import the file using the option of Tab 
Delimited file (File  → Import menu). After importing the file, you won’t be able to do 
major editing because of the restrictions of improper wraparound.
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Group 3 Languages
For all  other  languages  using Windows ANSI TrueType (TTF) font  (such as Eastern 
European languages,  Hindi,  Bengali,  Vietnamese,  Thai,  etc.)  you  need  to  choose the 
proper font, which may or may not be available in Windows Arial or Times New Roman. 

Group 4 Languages
CaptionMaker  does  not  support  Unicode.  As a  result,  CaptionMaker  does  not  handle 
Pacific Rim languages such as Chinese, Japanese and Korean.

Note on TrueType Fonts    If you like to use a special font to create 
subtitles, you must have that font inside the Windows → Font folder. 
Simply copy the font in the folder and then it will be available inside 
the  CaptionMaker.  Arial  and  Times  New  Roman  fonts  contains 
characters  associated  with  many  languages.  They  are  accessible 
only by using the Script feature, described below.

Choosing the Right Script Font
If  you have a  Microsoft  Word or WordPerfect  file  in a  language other than Western 
European languages such as English,  French,  German,  Italian,  Portuguese or Spanish, 
you may need to manipulate text to see it in the Work Area. If the imported text does not 
appear in the appropriate language, you need change the font. Windows Arial font covers 
almost all languages, but if there is a specific font you like to use, you may do so. 

1. Click on the Image Font icon on the Operations Center. The Image Font dialog 
box will appear, where current font and script types are shown. 

2. Click on the Select button next to the current font type as shown below:

The Font dialog box will appear, where the Script type can be changed.  
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3. Click on the  Script  list  box at  bottom right.  It  will  probably show the option 
Western.

4. Scroll until you find your desired language group (the vertical scroll bar slide may 
show no choices available, but still click on the up and down icons, if they are 
available). Then click on OK. 

5. Again click on OK on the Font dialog box. CaptionMaker will ask you:

Do you want to update the font used in the edit grid?

6. Click on Yes. Now the Work Area will show the appropriate font for the language 
in use.

A  sample  Russian  Microsoft  Word  file  (Russian.doc)  can  be  found  in  the 
C:\ProgramFiles\CPC\CaptionMaker\Samples folder.  Try  to  import  the  file  and  the 
Preview Window will show the font properly as below.

But the Caption/Subtitle area will show the text as below:

Â 1884 ãîäó â Àòëàíòè÷åñêîì
îêåàíå çàòîíóë êîðàáëü.
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After  you change the  Font  Script as  described above,  you will  see the text  will  also 
change to this:

В 1884 году в Атлантическом
океане затонул корабль.

DV2000/ITV-Injector Tutorial
The DV2000 unit from Ultech is a computer in itself.  This tutorial  assumes that you 
know how to create a subtitle file.  The file you will need to use is  Demo.cap, which 
should be located in the directory where your CaptionMaker program was installed.

Go to File → Open and load the Demo.cap file. It subtitles the first few minutes of the 
CPC training video. You will need both a digital video Source VCR and a digital video 
Record VCR for this tutorial. The DV2000 cannot process analog video input.

You should go to  Subtitle  → Device on the menu bar and select the DV2000 from the 
box. You are now ready to generate the files on your machine that the DV2000 will use 
to create the digital subtitles.

Click on the AutoSync button on the toolbar. The  Save/Generate Files dialog box will 
appear on the screen. You need to put the files that the program will generate in a place 
so that they can be moved to the DV2000. There are three ways to move files from the 
computer running the CaptionMaker to the DV2000.

Network Method: The CaptionMaker computer and the DV2000 can be connected to a 
network. The DV2000 has the capability of being connected to either a 10 base 2 (black, 
thin coaxial cable) or 10 base T (looks like phone cable) network. Note: Your DV2000 
might not have a network card, but any DV2000 can be upgraded with a network card.
Superdisk Method: The DV2000 has a 120-megabyte Superdisk (the floppy drive on the 
front of the DV2000 unit can read either a standard 1.44 megabyte floppy or a 120-
megabyte Superdisk). In a 60-minute video, if a subtitle appears every 2 seconds, with 
each subtitle being 50K, you can fit all of the files from the entire video onto one 
Superdisk. However, you cannot fit all of the files from a 120-minute show onto a single 
Superdisk.
Serial Port Method: The DV2000 has a serial port that can be used to transfer files. This 
is the slowest and most cumbersome method. You will need a “Null Modem” cable.

Placing Subtitles on the Video
Press  the Enter  button  on the DV2000.  You should get  an  indication  that  the  job is 
running. Turn on the Source VCR, press Play, and make sure that it is rewound to the 
beginning of  your  video.  Turn on the Digital  Record VCR, and make sure that  it  is 
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rewound to the beginning. When the first subtitle comes up, you can watch the subtitles 
as they are placed in the video stream by watching the monitor.

Simultaneous Captioning and Subtitling
You  can  easily  run  a  caption  job  and  a  subtitle  job  concurrently  on  the 
DV2000/ITVinjector using a script file. The syntax for the script file is as follows:

   ;run the caption job "Spiderman.onl"
   encodecc Spiderman.onl

   ;run the subtitle job "Spiderman.usf"
   runsubtitle Spiderman.usf

   ;Keep script job from stopping before the jobs are done
   ;by waiting until some huge timecode, i.e., 10 hours.
   ;Without this line the script job will end and the
   ;caption job and subtitle job will be stopped.
   waituntil 10:00:00:00 

In the above example, the lines started with a semicolon (;) are comment lines. They are 
not needed to execute the script file. The three lines not starting with the semicolons are 
important. 

Spiderman.onl is the caption file and Spiderman.usf is the subtitle navigation 
file.

Spiderman.onl is the caption file exported from CaptionMaker software as a CPC-
715 CaptionMaker  online (*.onl)  file.  You may also export  the CaptionMaker file  as 
Ultech Ult Caption (*.ult) file format. DV2000/ITVInjector accepts both files as valid 
caption files.

Spiderman.usf is the subtitle navigation file. This file along with all the picture files 
(*.uyc) are created by exporting a CaptionMaker file to DV2000 UFS/UYC file format.

Make sure to put the .scr, .onl, and .usf files all in the root of the script job folder. You 
can put the .uyc files in a directory just below the script job (in fact, for Superdrive media 
you must keep the .uyc in a subdirectory as Superdisks have a 256 file count limit in their 
root directories).
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MagniCoder Pro

Installing MagniCoder Pro Software
After physically connecting the MagniCoder Pro cables, you must install the MagniApp 
software using the two disks that came with the MagniCoder Pro. To do that, insert Disk 
1 first, then click on the Start button at the bottom left corner of your computer screen 
and go to Run. Now type:  A:\Setup.exe. Follow the instructions and insert Disk 2 when 
prompted. Once a message saying: “Setup has successfully installed MagniApp” appears, 
click on Finish to complete the setup.

Setting Up MagniCoder Pro Software
Now that you have the MagniApp software installed, the first step will be setting the 
Character Resolution so that you will get the best resolution for your subtitle fonts. 
                                                                      

1. Run any video.
2. Turn on the MagniCoder Pro and then run the MagniApp software.
3. You must choose an available serial port in your computer. To do that click on the 

Config tab and choose Comm Port Select.
4. Click on the Size tab and set up the VGA resolution for 640x480 by either moving 

the bar for the H Size and the V Size or by using your mouse and increasing and 
decreasing the inner box.

5. Since you have your video running through the MagniCoder Pro, you will also 
have to set up the MagniApp software to be able to see the video on your monitor. 
To do that, click on the Mix tab and drag the little arrow all the way from graphics 
to video. Also make sure that Video is checked; to do that click on CUT. After the 
setup is completed you should be able to see the video on your monitor.

6. The Character Resolution of the VGA Pan dialog box might differ from computer 
to computer.  In this case it might be out of focus. To fix that, click on the Config 
tab and then click on Setup. This will bring out the Setup dialog box.  To adjust it 
automatically,  click on  AutoCal.  The video should look fine after  the setup is 
completed. Make sure that the Sync Select and Flicker Select boxes in the Setup 
dialog box are checked. 

7. Now save the  settings  to  your  hard  drive  on the  Save  Settings button  on  the 
Config tab, and also to the MagniCoder Pro device by clicking on the  Save to  
NVRAM button in the Setup dialog box. 

8. If you are not quite satisfied with it, you may do it manually. While you’re still on 
the  Setup dialog, you must adjust the Graphics Origin (Horizontal and Vertical) 
and  then  the  PLL (Frequency,  phaseA and phaseB).  Make  sure  you  save  the 
settings to your hard drive by clicking on the Save Settings button on the Config 
tab and also to the MagniCoder Pro device by clicking on the  Save to NVRAM 
button on the Setup dialog box as well.
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Running the CPC CaptionMaker Software
Now that you have adjusted the Character Resolution for the MagniCoder Pro, you must 
set up the CaptionMaker to configure it to work with the MagniCoder Pro.

1. Run the CaptionMaker.
2. Go to File and choose Open. 
3. Now open the file that you wish to work on.
4. Go to Subtitle/Caption → Device and check Subtitle. 
5. Choose MagniCoder Pro as your device. 
6. Click on the Configure button and make sure to choose the same serial port as you 

did for the MagniCoder Pro. Now you will need to choose colors for background, 
foreground, attribute, and border. Click on the Image Colors icon on the 
Operations Center toolbar (top right corner). You must select the true colors and 
have these settings:

Background color: Black (Red → 0, Green → 0 and Blue → 0)
Foreground color: White (Red → 255, Green → 255 and Blue → 255)
Attribute color: N/A
Border color: Dark Blue (Red → 0, Green → 0 and Blue → 64)

7. Now you will need to choose your fonts. Click on the Image Font icon on the 
Operations Center toolbar.  Click on the Select button next to the font.  This will 
bring up the Font dialog box.  Here you may change the font type, style, size, 
color and script. 

8. Make sure that the Apply Character Border of is checked and also that the Pixels 
number, right at the bottom choice, reads “2” or “3.” You may choose different 
settings for the Kerning, Scaling, Spacing and Character Width in case the font 
characters are too far apart or too close to each other.

9. Now you are ready to go. Click on the AutoSync icon  and play the video. You 
should see the subtitles appearing on the monitor. If you find a problem with the 
margins, go to the Operations Center toolbar and click on the Margins/Padding 
icon  and adjust the settings.

Caution: Make sure that the MagniApp is not running when you are 
about to invoke AutoSync.
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Webcast Captioning and Subtitling
Webcasting, in simple terms, means streaming video on the web. You can stream a video 
that is already produced, or you can stream a live video in real time.

When you caption or subtitle videos on the web (webcasting) you can reach out not only 
to the hearing impaired community, but also to people all over the world. You can put 
subtitles in virtually any language! You can take care of the language barrier and sound 
barrier at the same time! People from all over the world, no matter what language they 
speak, will be able to turn on the video and understand what is being said by choosing the 
subtitles in their own language.

There are two scenarios for webcasting:
• Video on Demand
• Realtime Video

When you a have a video in hand, you may upload the video on the web and people can 
see the video whenever they wish to. This is called Video on Demand Webcasting. On the 
other hand, if you want to webcast a live event, you may stream the live video on the web 
and people can watch the video as the event is in progress. This is called Realtime Video 
Webcasting. Typically broadcasters use this process to broadcast programs on the web.

Captioning Realtime Webcasts
CaptionMaker  is  capable  of  captioning  webcasts  only  for  Video  on  Demand.  This 
document  will  only  explain  webcasting  for  video  on  demand.  The  Realtime  Video 
Webcasting is done by CPC-800 software.

Captioning Video on Demand
If you are considering webcasting, you will need to decide which format you will use, 
Windows  Media  Player, RealPlayer,  QuickTime  Player  or  Flash  Player.  Each  offers 
different benefits and only you can decide which is best for your webcast.

CaptionMaker can create files for all of these formats. 

Subtitle  Examples:  On our web site,  www.cpcweb.com, we have a 
few sample demos under the link Webcasting. Check it out to get a 
better idea of subtitling a webcast.

Inside the C:\Program Files\CPC\capmaker\Samples folder  on your 
computer there are examples of webcast captions for all 4 players. 
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You may take a look at these files to get some familiarity with these 
files.

Captioning or Subtitling?
Closed captioning on conventional video differs from subtitling on conventional video in 
several ways. The most important difference is that you can turn the captions on or off by 
choosing the closed caption option on the TV remote control. Closed captioning is used 
mostly by people who cannot  hear well.  Subtitling on conventional  videos cannot  be 
turned on or off. Subtitles are always on since they are part of the video. Subtitling is 
normally used by people who do not understand the language spoken in the video, so 
typically it appears in a language other than the language being spoken on the video. On 
conventional video media captions or subtitles appear on the bottom of the video.

Webcasting video on the web, a completely different medium, combines the concept of 
captioning and subtitling. The video appears in a small window on the computer screen 
and the text is displayed outside the area of the video. The viewer has a choice:

• Turning the text on or off (on most players)
• Switching between multiple languages (if multiple languages are present)

Throughout  this  document  we  will  use  both  terms  “captioning”  and  “subtitling” 
interchangeably in relation to webcasting. 

Creating a Time-Stamped File
To caption a webcast, your first task is to create a time-stamped file for the video. See 
Chapter 4 for details.

RealPlayer can handle both Pop-on and Roll-Up display modes. Windows Media Player, 
QuickTime and Flash can handle Pop-On mode only. To play safe, follow these rules for 
all webcast exports.

• use Pop-On display mode.
• use upper and lower case, which is easy to read. 
• limit caption length to 32 characters. 
• position captions at the bottom of the screen. Since the captions are below the 

video, there is no need to place the captions at different vertical positions as is 
done in captioning a videotape to avoid graphics and other relevant information 
on the video. 

• position captions centered.
• do not use music symbol. Use [music] instead of the music symbol. The music 

symbol does not appear as a music symbol in most players.
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Windows Media Player 
We recommend  Windows Media Player  for  webcasting.  It  offers  more  options.  Also 
everyone who uses a Windows computer will automatically have Windows Media Player, 
meaning that your viewers will not have to download new software to watch your video. 
There are four ways you can caption formats for Windows Media Player

• Embedded Text  (browser independent)
• ASX format (browser independent)
• HTML Normal format (works with Internet Explorer only)
• HTML Book Format (works with Internet Explorer only)

Windows Media Player – Embedded Text

In this method, the caption text is inserted inside the video file, there are no additional 
files for captioning. When you play the video in WPM, captions are extracted by WMP 
and are shown below the video.

Windows Media Player - ASX Format
You can  also  export  a  .smi  file  and  a  .asx  file.  The  .smi  file  contains  the  text  and 
timecode information. The .asx file is a short file, which pulls in the video and .smi file 
together to play within Windows Media Player. It does not matter which internet browser 
you use. It is browser independent. 

Two files .asx and .smi are created. Make a link to the .asx file to see the Webcast with 
captions. To test the files, place all files (.asx, .smi and .wmv) in one folder and double-
click on the .asx file. The video will play and display the captions.

No Need for ASX File !!! If the file names for the WM video file and 
the .smi file without the extensions are exactly the same, you really 
would not need the .asx file. When you click on the .wmv file, WMP 
will see the .smi file with the same name and will pull the captions 
from the smi file.

Windows Media Player – Html Format
You can  export  captions  for  Media  Player  in  HTML file  format,  which  works  with 
Internet Explorer only. Internet Explorer launches Windows Media Player and plays the 
video with captions.

Two files .html and .smi are created. Make a link to the .html file to see the Webcast with 
captions. To test the files, place all files (.html, .smi and .wmv) in one folder and double-
click on the .html file. The video will play and display the captions.
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Windows Media Player – Html Book Format

In the Book format, a box is added next to the video with the full text. As the words are 
said, they are highlighted in the text box. This format works with Internet Explorer only. 
There is one advantage to this style. You may highlight the text with a mouse and copy 
and save the text on your hard drive.

Three files .html,  .dat   and .smi are created.  Make a link to the .html file  to see the 
Webcast with captions. To test the files, place all files (.html, .dat, .smi and .wmv) in one 
folder and double-click on the .html file. The video will play and display the captions.

WMP  Caption  On/Off  Switch  To  see  captions  on  Windows  Media 
Player, make sure to turn the captions on. For different versions of 
WMP, the steps to turn caption on are different. For details, check 
the link:

www.cpcweb.com/wlive/WMPSwitches.html

To export files for Windows Media Player, go to  File  → Export  → Webcast- Media  
Player option.. You will see all the choices in the export window.

The export window is self-explanatory.  Here are a few notes:
• Do not use version 6 unless you know the viewer is going to use this old version 

WMP. 
• Version 7,8,9 also works for version 10 of WMP. 
• Make sure to jot down the time code of the first caption.
• Choose size 12 Arial Bold font for clarity.
• Check the box “Auto Size” unless you know the exact  size of the video,  like 

320x240

http://www.cpcweb.com/wlive/WMPSwitches.html
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After exporting the file(s), upload the file(s) created by CaptionMaker and the video in 
the same folder on the web, and make a link to the appropriate file. 

Additional Notes on Windows Media Player 
• Captions do not move left and right
• When working with the HTML exports, you have to open it in Internet Explorer. 

Firefox will not open it correctly.  Also, most Internet Explorer pop-up blockers 
will block Active Content.  When the bar pops up that says Internet Explorer has 
blocked content, you have to click on the bar and Allow Blocked Content

• It’s also important to remember to set your Caption Area Height large enough to 
accommodate multiple line captions.  When working with the HTML file, users 
have the option of viewing small or large text, so that has to be taken into account.
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RealPlayer 
RealPlayer  is  probably  the  easiest  way  to  webcast,  but  some  people  may  not  have 
RealPlayer  on their  computer.  The subtitles cannot be turned off from the RealPlayer 
options. The only way you can turn the subtitles off is to create a button on the web that 
plays the video without the subtitle files. Perhaps one day RealPlayer will have an option 
to turn the subtitles off or on as Windows Media Player does. 

To export files for RealPlayer, go to File → Export → Webcast SMI/RT (*.zip) option to 
export the file. The Export Webcast dialog box opens up.

The export window is self-explanatory.  Here are a few notes:
• Make sure to jot down the time code of the first caption.
• Choose size 12 Arial Bold font for clarity.
• You  can  do  rollup  captioning  with  maximum  of  10  lines  of  text  in  the  text 

window. Make sure to adjust caption text height appropriately.
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After you export the file for RealPlayer, unzip the file and you will find three files. (If 
you use both Pop-On and Roll-Up modes, you will have more than three files.) 

• video.rt
• video.smi
• videoweb.rm

The .smi file contains the name of the video file you assigned in the export process. Let’s 
say the name of the file is video.rm

The videoweb.rm file contains one line of text as below:

http://www.cpcweb.com/RealPlayer/Video.smi

This link (in this example) represents the following:
• http://www.cpcweb.com is the web site where you would like to host this 

Webcast.
• RealPlayer is the folder where you put all four files.
• video.smi is the name of the .smi file described above.

Now take these three files along with the RealPlayer video file video.rm and upload all 
four to your website folder RealPlayer and make a link to the file VideoWeb.rm and you 
are  finished.  When  a  web surfer  clicks  on  this  link,  he  will  see  the  video  with  the 
subtitles. If you also would like to make a link just to see the video without the subtitles, 
simply make another link to the file video.rm

Additional Notes on RealPlayer
• Words move left and right, size and font can be changed in export options, size of 

the text track itself is customizable in export options. Do not use music symbol, 
use the word [music].

• Set the margins accordingly when doing right positioned captions.  If you don’t 
leave enough space in the margin for a right positioned caption, the words that 
don’t fit will be moved to the very left of the screen on the next line.  Setting 
margins to 0 works best, but you can get away with higher numbers depending on 
how your text is formatted.

• Ignore the format for Roll-Up you used when creating the initial .cap file.  Upon 
export you will be asked to set the maximum number of lines for Roll-up mode. 
If you enter 1, roll-up captions will appear one at a time, if you choose 5, then 5 
roll-up captions will appear at once.  The only thing to remember is that you 
follow the warning and set your Caption Area Height accordingly to the font 
you’ve selected and the max number of lines you’ve set.

http://www.cpcweb.com/RealPlayer/Video.smi
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QuickTime
QuickTime is definitely the most difficult of the three programs for subtitling webcasts. 
Like RealPlayer, subtitles shown with QuickTime cannot be turned off or on. There are 
two ways you subtitle a QuickTime movie.

• smi and text file format 
• Embedded text 

To export files for QuickTime, go to File → Export → QuickTime Webcast Script (*.txt) 
option.  You will get two files, one with extension .txt and the other with extension .smi

SMI and text file format 
If you have the .smi, .txt and the video file .mov all in the same folder, open the .smi file 
in QuickTime and you will see the video with the captions. It is that simple. On the other 
hand if you want to embed the text inside the video, follow the steps below.
 
Embedded Text

1. Open QuickTime Player.
2. Choose Open movie in new player and select the movie that you would like to 

subtitle.
3. Go to File → Import and choose the text file that has just been exported from 

CaptionMaker. (You may have to change the Type field from Movies to All).
4. A new dialog box will open: Save converted file as. Click on Options in the 

bottom left corner. Here you can choose your font, font size, text style, screen 
width and height. You can also choose to do Keyed Text, which means that the 
text shows up right over the movie, not on a black background. Since this is just 
the text portion of the movie, you don’t want to make the height any bigger than 
2-3 lines of text will require. Match the width with the width of the movie, and 
make the height just big enough for 2 lines of text (100-200 depending on your 
font size). You may have to try this a few times to get the right size.

5. When you click on OK, a new movie will be created that contains only text. To go 
into this movie, go to Edit → Select All, then Edit → Copy. Now go into the 
movie that you would like to subtitle, and go to Edit → Add. You will see a black 
box at the top of the screen where the text should be. If you are using keyed text 
you will not see a black box; you may need to move forward a few seconds into 
the movie to see the text. But you probably don’t want a big box on the top of 
your movie, so you need to move it.

6. Go to Movie → Get Movie Properties. A new dialog box will open. First, select 
the top left drop-down menu and change it from Movie to Text Track. Now 
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change the top right drop-down menu from Annotations to Size. When you click 
on Size, a new interface will open under the drop-down menus. Click on Adjust.

7. A screen like the one above will open up. Click anywhere in the black area and 
drag it down so it is just out of the picture, so it looks like this: 

8. Now click on Done in the Movie Properties dialog box, save the file, and you are 
ready to upload the new .mov file to the web.

Additional Notes on QuickTime 
• If you make a stand-alone QuickTime movie with captions in Windows, you can 

enlarge the size of the video and the size and font of the text will actually change 
and get bigger to. 

Flash  Player

This is the fourth player CaptionMaker supports. There is only one way you subtitle a 
Flash video.
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• Embedded text inside the video

Here are the steps on how to insert captions to a Flash video using the CaptionMaker 
software and a third party software Captionate (around $60)

You will need these 4 things to do this:
• CaptionMaker
• Captionate (This is the program that will allow you to embed captions inside 

your .flv files.  You can find it here: http://www.buraks.com/captionate/6.html )
• Macromedia Flash Professional 8 or higher (This is the program that will allow 

you to build the .swf and/or .html files using your .flv video.  You can find it here: 
http://www.adobe.com/products/flash/ )

• Skins for FLVPlayback that support Captionate
You can download them from the following link: 
http://blogs.adobe.com/accessibility/assets/CaptionedFLVSkins.mxp
Just double click the .mxp to install after you download

Creating an .flv using Macromedia Flash 8 Video Encoder
• If you purchased Flash Professional 8, it should come with Macromedia Flash 8 

Video Encoder
• You can use that to encode almost any type of video into an .flv file
• Open Flash 8 Video Encoder, click Add, and choose your video 
• You can add as many videos as you want and the Video Encoder will convert all 

of them into .flv videos
• If you don’t have any specific video settings you want to set, just use the default 

Medium Quality (400kbps)
• After you have all your videos added in, just click Start Queue

Creating an .xml using CaptionMaker
• CaptionMaker cannot play .flv videos so use your original video to time, position, 

and format all your captions inside CaptionMaker
• When you are finished, go to File >> Export DVD/DV2000/Webcast Subtitle and 

choose Webcast - Flash XML for Captionate from the pull down menu

Combining the .xml with the .flv
• Run Captionate and go to File >> Open and choose to open the .flv video you 

converted earlier
• Go to File >> Import >> Captionate XML and choose the .xml file you just 

exported from CaptionMaker
• After it imports all your captions in go to File >> Save
• Now all of your captions are saved inside your .flv video

Creating a .swf and an .html file using Macromedia Flash
• Run Macromedia Flash and choose to start a new Flash Document

http://blogs.adobe.com/accessibility/assets/CaptionedFLVSkins.mxp
http://www.adobe.com/products/flash/
http://www.buraks.com/captionate/6.html
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• Make sure to save this project in the same folder as your .flv video
• From the Components, & Actions, & Properties & Parameters panel, go to the 

Components tab 
• Expand FLV Playback – Player 8 and drag the FLVPlayback component from the 

tab into your work area
• Now that you have a component to work with, go over to the Parameters tab and 

under Content Path put the full filename of your .flv (ex: MyVideo.flv).  You 
should not include the entire path to where your .flv is located.  Just put the name 
of the actual .flv

• Then under Skin choose any skin that begins with the word Captioned
• If you want your captions to appear over your video, choose a skin that contains 

the word External.  If you want your captions to appear below the video, choose a 
skin that contains the word Over.  In either case you can choose to auto-hide the 
video control panel by setting the Parameter skinAutoHide to true.

• After that you can go to Control >> Test Movie to see a sample of what your 
video will look like.

• Press the CC button to turn your captions on or off
• Once you are ready to create the final files go to File >> Publish Settings to 

confirm the names and types of files you want to export
• Then go to File >> Publish to actually create them

Playing your finished captioned flash videos
• Make sure all 4 of the following files are in the same folder:

1. The .flv video
2. The .swf file for your video
3. The .html file (for those who exported .html)
4. The .swf file you chose as your skin

• Then just double click the .swf file to bring up a player in flash, or double click 
the .html to bring up the flash player inside your web browser (IExplorer, Firefox, 
Safari, etc)

Note
• It is extremely important to remember that when you are building your project in 

Macromedia Flash that you do not include the entire path to your .flv in the 
Content Path section of the Parameters tab.  Doing so will make the video work 
perfectly fine on your computer, but it will not work for anyone else.

Sample XML file

- <caption time="00:00:07:20">
  <speaker>-1</speaker> 
- <tracks>
  <track0><P ALIGN="LEFT">I'm at the left<br>of 

the screen.</P></track0> 
  </tracks>

file:///C:/Users/som/Desktop/AppData/My Documents/Documents and SettingsOwnerDesktopFlash"
file:///C:/Users/som/Desktop/AppData/My Documents/Documents and SettingsOwnerDesktopFlash"
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  </caption>
- <caption time="00:00:14:05">
  <speaker>-1</speaker> 
- <tracks>
  <track0><P ALIGN="RIGHT">Now I'm at the 

right<br>of the screen,</P></track0> 
  </tracks>

  </caption>
- <caption time="00:00:19:07">
  <speaker>-1</speaker> 
- <tracks>
  <track0><P ALIGN="CENTER"><I>Now I am off 

screen.</I></P></track0> 
  </tracks>

  </caption>

file:///C:/Users/som/Desktop/AppData/My Documents/Documents and SettingsOwnerDesktopFlash"
file:///C:/Users/som/Desktop/AppData/My Documents/Documents and SettingsOwnerDesktopFlash"
file:///C:/Users/som/Desktop/AppData/My Documents/Documents and SettingsOwnerDesktopFlash"
file:///C:/Users/som/Desktop/AppData/My Documents/Documents and SettingsOwnerDesktopFlash"
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Ca p t i o n / S u b t i t l e  w i t h  

Ca p t i o n M a k e r - D V / N L E / H D

Full blown and Encoder flavors of CaptionMaker
CaptionMaker-DV,  CaptionMaker-NLE,  CaptionMaker-HD  Enterprise  come  in  two 
flavors – Complete and Encoder.

Two Flavors
CaptionMaker series is a caption/subtitle editor and closed caption/subtitle encoder. It 
allows you to do a complete captioning/subtitling job from start to finish. It accepts text 
from a variety of sources. CaptionMaker series lets you edit, position, and synchronize 
the captions/subtitles with video using time code. It then combines the captions/subtitles 
with the video as open captions, closed captions or subtitles, and allows you to save them 
in a number of different formats. CaptionMaker series supports drop frame as well as 
non-drop frame NTSC/PAL video.

CaptionMaker Encoder series does not have caption/subtitle editing capabilities. It is a 
closed caption/subtitle encoding software only. You need to have a prepared 
caption/subtitle file from a different source like CPC CaptionMaker or multiple of other 
caption files from other caption software vendors. After you import a prepared file, you 
can add captions/subtitles to a video as open captions, closed captions or subtitles, and it 
allows you to save the file in a number of different formats. CaptionMaker Encoder 
supports drop frame as well as non-drop frame NTSC/PAL video.

Four versions:
• CaptionMakerr-Classic version allows you to add captions & subtitles to any 

videotape using external closed caption encoder.
• CaptionMakerr-DV version allows you to add captions & subtitles to DV videos 

- both DV25 and DV50. 
• CaptionMaker-NLE version does everything that the DV version does, plus it 

can add captions & subtitles to video residing inside an NLE system. It can also 
add captions to all SD (Standard Definition) MPEG2 including DVD video.

• CaptionMaker-HD Enterprise does everything that the NLE version does, plus 
it can add captions and subtitles to HD (High Definition) Mpeg2 video.
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Note: Encoder versions allow 50 changes (key strokes & a limited 
number of other things) to an imported file.

Caption/Subtitle digital video on your hard drive
With the CaptionMaker® DV/NLE/HD (includes patented [#6,895,166] software engine) 
you can caption and subtitle your digital videos without losing a generation. No need for 
any hardware caption encoder or subtitle character generator.

CaptionMaker-DV/NLE/HD have all the features of CPC-Classic plus you can caption 
and subtitle your digital videos without losing a generation. Here is what you can do.

Retrieve Captions
You can retrieve captions from any one of the following videos as long as the video 
contains closed captions.
DV (720x480) MOV
DC (720x480) AVI
Mpeg2 (720x480) video (for DVD)

Encode Captions/Subtitles
You can encode closed captions to a DV (.mov and .avi) , Mpeg2. You can also export a 
blank video (720x486) file with encoded closed captions to be merged to the original 
video using an NLE system. 

You can  subtitle  any digital  video  with your  choice  of  fonts.  The  resulting  video  is 
always an AVI video. You can also export a blank video (720x486) with subtitles, which 
can be merged to the original video using an NLE system.

Print DV Video to Tape
You can transfer a captioned DV video via Firewire to a MiniDV, DVCAM or DVCPRO 
tape. You can also dump a captioned DV video to an analog tape such as VHS or BetaSP 
using a digital to analog converter such as Sony DVMC-DA1 and DA2 or a captioned 
compatible DV deck, which retains caption. 

Capture DV Video
You can capture a DV video (720x480) via firewire. This function allows you to receive 
a DV video via fire wire (IEEE 1394) and create a DV AVI file. Video may be captured 
from Firewire devices such as the Sony DVMC-DA1/DA2 or a camcorder or a DV deck.
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Caption encoding (No generation loss) 
If you are dealing with digital videos, once the caption file has been created, you have 
three  distinct  options for  creating  your  captioned  master  directly  on  the  hard  drive 
without using a closed caption encoder hardware. 

If  you  are  dealing  with  720x480  DV25  or  DV50  (compressed)  video,  or  Mpeg2 
(compressed) video, you choose the DV and Mpeg2 route. There is no need for any Non-
Linear system. 

On the other hand if you are using a Non-linear system and like to work with 720x486 
(uncompressed) video, then you choose the NLE route.

DV Caption Encoding
If your original digital is a DV video, and you transfer the video to a tape via firewire, 
then the DV function will work well.  CaptionMaker-NLE can create a copy of your 720 
x 480 DV video file with the caption data in the VAUX data area. In case you want a 
BetaSp or Digibeta video, you would need a Caption compatible DV deck or a Sony 
digital to analog converters like DVMC-DA1 or DVMC-DA2 to dump the DV video via 
Firewire. 

Proper QT Movies - to work with CaptionMaker: QT DV video must be 29.97 fps and 
audio must be either 32KHz for 4 12-bit audio channels or 48KHz for 2 16 bit audio 
channels. There are no exceptions to these rates. 
  
The video must be compressed with DV codec. If the video and audio rates are incorrect, 
you can fix it using QuickTime Pro by re-exporting the file with proper video/audio rates. 

Inserting Captions to a 720x480 DV25/DV50 Video
From the NLE > Encode Captions/Subtitles menu, choose one the following choices:

• DV AVI 720x480 video (*.avi)
• DV QuickTime 720x480 movie (*.mov)

Follow the steps to create a copy of the DV video with closed captions.

Next, go to NLE >> Print DV Video to Tape option to transfer the DV video via firewire 
to a MiniDV, DVCAM or DVCPRO tape.

You can also dump the DV video on an analog tape such as VHS or BetaSP using a 
digital to analog converter, which retains caption. We found Sony DVMC-DA1 and DA2 
are good converters. Unfortunately it is discontinued now. But you can get a used one 
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from CPC. Most digital to analog converts like the one Canopus or TVOne do not retain 
captions.

Now play the tape in a VCR and display the output on a TV with caption channel 1 
turned on. You will see captions superimposed on your video. If you do not see any 
captions, check your TV’s menu and make sure the CC1 mode is selected.

Compatible DV Decks
CaptionMaker works with both DV25 and DV50 video. You can create your DV video in 
any NLE system or simply import from a videotape via Firewire.

Up-to-date List: For most recent list of caption compatible DV decks, please check http://
www.cpcweb.com/dv/dv-hardware.htm

Caption data sits in the VAUX Data area of a 720x480 DV video. On the other hand, 
caption data sits in Line 21 of NTSC (525 lines) video.  When you transfer the DV video 
to NTSC, you must use a deck which can transfer the caption data from the DV VAUX 
data area to the NTSC Line 21. 

After you caption a 720x480 DV video sitting on your hard drive, using CaptionMaker 
software, you need to dump the video to a tape format via Firewire. 

We have tested the following decks and media converters, which do the job successfully. 
If your deck is not listed below, you can use the compatibility check below to test it. 

DV Decks - Caption Compatible 
Panasonic AJ-D650, AJ-D455 
SONY DHR-1000 
SONY DSR-11, DSR-20, DSR-30, DSR-40, DSR-80 
SONY GV-D300 portable 
SONY DCR-TRV110, TRV720, TRV820 Digital8 camcorder

Media Converters - Caption Compatible 
SONY DVMC-DA1 and DVMC-DA2

Note from a Sony Rep. on DSR 45, 50 and 85: The DSR-45 does output Closed Captions 
only in NTSC and only on the monitor out connector. Not the component, composite, 
main video or S-Video outputs. There is no magic mod to my knowledge to turn this on 
and it has been asked for previously to my recollection. 

By the way, among the DVCAM products, CC only exists in NTSC machines or NTSC 
mode. The DSR-85 never supported Closed Captioning, the DSR-45 as you now know 

http://www.ccaption.com/HardwareRecommend.shtml
http://www.cpcweb.com/dv/dv-hardware.htm
http://www.cpcweb.com/dv/dv-hardware.htm
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only outputs CC on the monitor output and the DSR-50 only outputs CC on the video 
output. All the other DVCAM machines basically output Closed Captioning. The POSC 
Group at 800-883-6817 has this information in their FAQ database.  Please refer the 
customer to the Sales brochure and maybe give a heads-up to the other Sales people who 
may need to know this gotcha. Sorry again for the bad news.

The Sony Business Solutions & Systems Product Operations Support Center: 
http://bssc.sel.sony.com/BroadcastandBusiness/minisites/HDV/support.shtml  

The following video decks and video cameras  do not do the proper transfer of caption 
data onto NTSC video. But you can still record closed captioned DV video using any DV 
video deck, including the ones below, even though you can not play back the video with 
captions from these decks. This is a subtle, but important distinction. 

DV Decks  - Not Caption Compatible 
CANON XL-1 camcorder 
SONY DSR-PD100 
SONY DSR-85 
Panasonic AG-DV1000 

Remember, if you record captions onto a DV tape using a non-caption compatible deck 
and then want to output the video with captions to an NTSC deck (BetaSP, VHS etc.), 
you must use a caption compatible deck or media converter to play that DV videotape in 
order for the captions to appear. 

Compatibility Check 1
There are many other DV hardware devices which work with CaptionMaker. To check 
whether CaptionMaker works with your specific hardware, you can do the following test.

Take a commercial  video with closed captions and save it  via  Firewire on your  hard 
drive. Now print the video out of your computer via Firewire to your DV hardware and 
then finally to a TV with its closed caption decoder turned on. If you see captions, your 
hardware is most likely compatible.

Compatibility Check 2
Download one of the following videos (295 MB)
www.cpc-usa.com/1ccaption/DemoDV720_480_MOV/Demo_DV_720x480_CC.mov
www.cpc-usa.com/1ccaption/DemoDV720_480_AVI/CPCDemo_DV_720x480_CC.avi
and open the video in your NLE system or any software which allows you to dump the 
video via  Firewire to your deck. Now connect the deck to a TV with its closed caption 
decoder turned on and output the video. If you see captions, your hardware is compatible.
 

http://www.cpc-usa.com/1ccaption/DemoDV720_480_AVI/CPCDemo_DV_720x480_CC.avi
http://www.cpc-usa.com/1ccaption/DemoDV720_480_MOV/Demo_DV_720x480_CC.mov
http://bssc.sel.sony.com/BroadcastandBusiness/minisites/HDV/support.shtml
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Inserting Captions to Mpeg2 for DVD
You can add captions to the data area of Mpeg2 video (for DVD) directly without using a 
NLE system. For a sample Mpeg video with captions, go to the link: 
www.cpc-usa.com/1ccaption/CPC Demo DVD.zip

Note:  To caption a DVD video,  you have another choice. You can 
export a .scc file from CaptionMaker and bring it to Adobe Encore, 
DVD Studio Pro (DSP), Sonic or  Scenarist  DVD authoring system. 
The authoring system will add the captions to the caption track of 
the DVD.

Inserting Captions to Mpeg2 (DTV/ATSC) 
CaptionMaker software implemented a way to embed closed captions in DTV/ATSC 
MPEG2 video for both 4:3 and 16:9 formats. HD is basically MPEG2 video so the 
concepts here will work for HD as well as SD MPEG2 video.

In MPEG2 video closed captions are carried in User Data packets in the MPEG data 
stream. There are three distinct closed caption data formats used in MPEG video: 

1. One format is used for encoding CCs into MPEG data that will be used as video 
assets in DVD authoring; 

2. A second format is used for Digital Television (DTV) and carries EIA 608 
formatted closed captioning data; 

3. A third format is used for encoding DTV EIA 708 closed captioning data. This is 
the same as HD.

The CaptionMaker software supports adding closed captions to DTV MPEG video; and 
CPC is researching adding EIA 708 closed captions into DTV. At present the current 
CaptionMaker software can decode EIA 708 closed captions.

CaptionMaker will decode and encode standard MPEG2 closed caption User Data 
packets in video encoded with the Vela Research MPEG hardware, 
http://www.vela.com/. 

The DVD and DTV 608 closed caption formats both conform to the EIA 608 standard 
specification for closed caption data encoding, but they differ in their physical 
positioning and bit coding layout in the MPEG data stream. The DTV 608 and the DTV 
708 formats differ in their standard specifications for closed caption data encoding, but 
they are transmitted together and in the same User Data packet in the MPEG data stream.

DTV 608 closed caption data that is inserted into MPEG video is typically copied directly 
from its analog standard definition video EIA 608 closed caption counterpart.

http://www.vela.com/
http://www.cpc-usa.com/1ccaption/CPC%20Demo%20DVD.zip
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CaptionMaker can currently encode closed captions for the following MPEG formats:
1. DVD Closed Captions (*.m2v)
2. DVD Style Closed Captions (*.mpg)
3. ATSC DTV 608 Closed Captions (*.mpg)
4. CCube/LSI DVx 608 Linear Closed Captions (*.mpg)
5. CCube/LSI DVx 608 Temporal Closed Captions (*.mpg)

CPC is continuing to test its MPEG2 closed caption encoding and welcomes specific user 
feedback on its software. If you want to share your Mpeg2 video with us for more testing, 
please let us know.

Mpeg2 Video Codecs
The software that comes with the Pinnacle DVC 80 (MovieStar 5 and DVD Complete) 
has the a good Mpeg2 codec. Install the MovieStar software and Mpeg2 codec will be 
installed  in  your  computer.  This  codec (Main Concept  MPEG codec)  works  well  for 
CaptionMaker. You may also install this codec from
http://www.mainconcept.com/products.shtml

Non-Linear caption encoding
The advantage of a non-linear solution is that the master that you can work with your 
uncompressed 720x486 video can add captions without losing any quality.  See below for 
NLE compatibility.

Compatible NLE Systems
CaptionMaker  can  add  captions  directly  to  video  using  NLE  systems.  After  adding 
captions to a 720x486 video with an NLE system you typically write the final video to a 
videotape using the NLE hardware (not Firewire). 

Up-to-date List: For most recent list of caption compatible NLE Systems, please check 
www.cpcweb.com/Captioning/NLE-DV-HardwareCompatibility.shtml 

Caption data sits in 720x486 video in Row 0 or Row 1 depending on the NLE system. In 
NTSC (525 line) video caption data  sits  in Line 21.  When you transfer the video to 
NTSC, you must use an NLE system, which can transfer the caption data from Row 0 or 
Row 1 of 720x486 video to NTSC video Line 21. The following NLE systems can do 
this, which makes them caption compatible. Caption data for use with NLE systems is 
stored in the following locations: 

NLE Systems Primary 
Row 

Starting Column 

AJA Io LA * 1 24 
AJA KONA * 2 24 

http://www.cpcweb.com/Captioning/NLE-DV-HardwareCompatibility.shtml
http://www.mainconcept.com/products.shtml
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AJA KONA (alternate) * 1 24 
AJA KONA LH/Lhe, LS/LSe * 2 24 
AJA KONA LH/Lhe, LS/LSe (alternate)* 1 24 
Avid ABVB 0 35 
Avid ABVB (alternate) 480 35 
Avid Adrenaline 0 22 
Avid Adrenaline (alternate) 1 35 
Avid DS Equinox 1 26 
Avid Express Pro 1 26 
Avid Meridien 1 26 
Blackmagic DeckLink # 1 26 
Blackmagic DeckLink (alternate) * 2 26
Leitch DPS Velocity 1 26 
Matrox DigiSuite# 1 30 
Media 100 1 26 
NewTek Video Toaster 3 & 4 # 1 19 
Sony XPRI 1 26 
TARGA 1000-3000 1 26 

* Works with Mac Final Cut Pro
# Works with Windows Adobe Premier

The Primary Row is the row number, 0 – 484, where caption data is placed in a 720x486 
video for use within an NLE system. The Starting Column is usually at 14 through 40.

Notes on NLE hardware: 
1. Blackmagic DeckLink can be used with Final Cut Pro and Adobe Premiere. If you 
have difficulty with exporting captions, please check for a new software update at: 
www.blackmagic-design.com/support/software 

2. Matrox DigiSuite hardware works with the following NLE systems

• Adobe Premiere Pro   
• Discreet edit  
• in-sync Speed Razor RT  
• IMC Incite  
• United Media On-Line Express  

3. The following  Pinnacle hardware used by many Windows NLE systems are caption 
compatible.

• TARGA 1000 PRO
• TARGA 2000 RTX
• TARGA 2000 DTX

http://www.pinnaclesys.com/TARGA
http://www.unitedmediainc.com/
http://www.incite-tech.com/
http://www.in-sync.com/
http://www.discreet.com/
http://www.adobe.com/products/premiere/main.html
http://www.matrox.com/videoweb/products/ds/home.cfm
http://www.blackmagic-design.com/support/software
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• TARGA 2000 PRO
• TARGA 2000 SDX
• TARGA 3000

Compatibility Check 1
There are many other NLE hardware devices which work with CaptionMaker. To check 
whether the CPC software works with your specific hardware, you can do the following 
test.

Take a commercial video with closed captions and save it uncompressed via your video 
input/output device (not Firewire) on your hard drive. Now send the uncompressed video 
out  of  your  computer  to  a TV with its  closed caption  decoder  turned on.  If  you see 
captions, your hardware is most likely compatible. 

Compatibility Check 2
You can also download one of the two sample NLE 720x486 black videos containing 
closed captions created with CPC software.
1. www.cpc-usa.com/1ccaption/NLE_MOV_Exports.zip
2.   http://www.cpc-usa.com/1ccaption/NLE_AVI_Exports.zip  

Open the video in your NLE software and output the video via your video input/output 
device (not Firewire) to your video deck. Now connect the deck to a TV with its closed 
caption decoder turned on. If you see captions, your hardware is compatible.
 

NLE System Not Listed Above
If your  NLE system is  not listed above,  you can check whether your  NLE system is 
caption compatible or not.  We created a tool to determine the preset values for your NLE 
system if it is not listed  in the table above.  

Here are two 720x486 4-minute video files which can be used to find the primary row 
and column number where caption data are encoded on your NLE system. We created 
this video in both .mov and .avi formats and they are available from: 

NLE calibration movie in mov: 
http://www.cpc-usa.com/1ccaption/NLE_Calibrate_MOV.zip
NLE calibration movie in avi: 
www.cpc-usa.com/1ccaption/NLE_Calibrate_AVI.zip

The closed caption content of the first 5 seconds of the movie is "R 0, C 14" and it is 
generated with Primary Row set to 0 and Starting Column set to 14; the next 5 seconds of 
the movie has the CC content of "R 0, C 15" and is generated with Primary Row set to 0 
and Starting Column set to 15. This continues through Row 0 and Column 40 at which 

http://www.cpc-usa.com/1ccaption/NLE_Calibrate_AVI.zip
http://www.cpc-usa.com/1ccaption/NLE_Calibrate_MOV.zip
http://www.cpc-usa.com/1ccaption/NLE_AVI_Exports.zip
http://www.cpc-usa.com/1ccaption/NLE_MOV_Exports.zip
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time it shifts to Row 1 Column 15. The last movie segment is Row 1 Column 40. The 
entire movie is approximately 4 minutes long.  
When the you import the video into your NLE system, put it on the timeline and play the 
video through your NLE hardware to a TV with the built-in closed caption decoder set to 
CC1 channel, you will see the content of the Primary Row and Starting Column  only 
when it successfully decodes the captions. You just have to watch the TV screen for up to 
4 minutes until you see a few captions like
R 0, C 21
R 0, C 22
R 0, C 23
...
R 0, C 29

If do not see any captions at all, your NLE system is not caption compatible. And if you 
do see captions, you need to pick a row and column value pair from the numbers you see. 
To avoid errors, you pick the mid-value of all visible column numbers. In this example it 
is C 25. So the preset NLE values for your NLE system is Primary Row: 0 and Starting 
Column: 25. Once you have determined these values, you can use these values in the 
CPC software and caption your videos using your NLE system.

Adding Closed Captions to Video using an NLE
Non Linear Editing system (NLE) is an editing system used to edit a video digitally on a 
computer. Typically the video resolution is 720x486. CaptionMaker works very well with 
Avid and Media 100, Final Cut Pro, Adobe Premier etc. with the associated hardware.

CaptionMaker-NLE can add captions directly to video using most NLE systems. After 
adding captions to a 720x486 video with an NLE system you typically write the final 
video to a videotape using the hardware (not firewire) associated with your NLE system.   

Caption data sits in 720x486 video in Row 0 or Row 1 depending on the NLE system. In 
NTSC (525 line) video caption data sits  in Line 21.  When you transfer the 720x486 
video to NTSC, you must use an NLE system which can transfer the caption data from 
Row 0 or Row 1 of 720x486 video to NTSC video Line 21. For example, for most Avid 
systems, the caption data sits on Row 1 and column 26. 
CaptionMaker-NLE a 720x486 black video with closed caption data on row 0 or 1. The 
720x486 video file is then imported into the NLE system and put on the time line exactly 
like other video material. A picture-in-picture effect or a crop effect is then applied to the 
imported video to mask off all but the closed caption image lines, and the NLE system is 
used  to  merge  the  imported  video  with  video  program material.  The  resulting  video 
output  from  the  NLE  system  is  closed  captioned.  Using  this  method,  no  additional 
encoder is needed to produce closed captioned video. 

After  you prepare a  time stamped caption  file,  go to  the NLE menu and make your 
choice. You can add closed captions to digital videos in one the three methods:
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• Encode captions to DV20 or DV 50 (720x480) video (*.mov and *.avi)
• Encode captions to Mpeg2 (720x480) video
• Export captions to a black 720x486 video to be used by an NLE system

Inserting captions to 720x486 video with an NLE System
From the NLE > Encode Captions/Subtitles menu, choose one the following choices:

• Encode NLE 720x486 avi video
• Encode NLE QuickTime 720x486 mov movie

When prompted, assign a file name and click Next. You will see the screen below:
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Choose one of the NLE systems listed there.  Make sure the Start Time Code is 
00:00:00:00 and End Time code is at least a few seconds more than the last the time code 
of the caption.

My NLE If your NLE system is not listed and you know the Primary 
Row  and  Starting  Column  information  from  the  Calibration  test 
described  earlier,  enter  the  information  in  Configure  My  NLE. 
Secondary Row information  is  not  important.  You  may just  put  a 
number like 481 or 482. Then Choose  My NLE. Please let us know 
your preset values, so we can add a button for your NLE system in 
the next version.

After you click Next, you will get the following screen. Choose the Codec used by your 
NLE  system,  otherwise  choose  Animation  Codec  for  a  mov  export  and  Full  frame 
uncompressed for an avi export.. If you are using Avid system, make sure you have Avid 
Codec on the computer you are running CaptionMaker-NLE. IF you do not have that 
Codec, you can get the proper Codecs from:
www.avid.com/onlineSupport/browse.asp?productID=92&topicID=404&browse=go

You will need to unzip the download. You will find the two files. For Avid Meridien the 
codecs are AvidQTAVJICodec.qtx and AvidQTAVUICodec.qtx. Place both of these 
files in C:\WinNT\System32\ or C:\Windows\System32\. You will not need to reboot in 
order to use the newly added Codecs, but you may have to restart any applications that 
were using QuickTime.

http://www.avid.com/onlineSupport/browse.asp?productID=92&topicID=404&browse=go
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Export to a 720x486 mov movie

Export to a 720x486 avi video

Animation codec is lossless. When you compress an image with the animation codec it 
preserves all of the data. You should not use this codec on normal video because it 
generates very big files but since the NLE file is about 98% black the animation codec is 
very good for this purpose.

The millions of colors+ generates a movie that contains an alpha track. The resulting 
video will contain 32 bits per pixel (8 bits for each of R, G, B and alpha). A millions of 
colors video only contains R, G and B data. Millions of colors+ makes the file 33% 
bigger (24 bits to 32 bits per pixel) but it also means that you can use an alpha track 
effect on the imported clip when you import the movie into your NLE. It is not necessary 
to use millions of colors + if you do not use alpha channel to merge the black video to 
your NLE video. 
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If you use Animation codec, the Quality option should not do anything since it is lossless 
but it should be at 100% anyway.

FPS must be 29.97 for drop frame video as most video on NLE systems use drop frame.

Key frames are not meaningful for the Animation codec. A key frame is a frame that is 
self contained and doesn't reference any other video frame in order to construct its own 
video frame data. As each frame of video in an animation codec should be spatially 
independent, probably key frame in the animation codec has any meaning.

Data rate limit should not be specified since by putting a value here it will cause the 
video to be limited in its resolution and we want 100% quality. This value should be 
meaningless for the animation codec. You would want to limit the data rate if you were 
streaming your video and needed to limit the size of each frame to a specific value. When 
you limit the data rate the quality of the compressed image will decrease. This is not what 
we want for our NLE closed caption image.

Video Compressors
Just before starting the process to export a digital video file, CaptionMaker displays a 
“Video Compressor Settings” dialog to allow you to select a video compressor codec. 
There are many codecs to choose from, and you may have to experiment a little to get a 
feel for the codecs that work best for your requirements.

There are several video compressors that are included with Windows, and many third 
party video compressors are available. The “Video Compressor Settings” dialog presents 
you with a list of all of the video compressors that are installed on your system. Note that 
some of these compressors are installed by third party software such as video capture and 
DVD burner applications, and many of these compressors are only licensed for use with 
the application that installed them, so you may get an error if you try to use some of these 
compressors  with  CaptionMaker.  In  addition,  some  video  compressors  may  not  be 
compatible with the format of the video file to be subtitled or the format of the output 
AVI video file to be written, so you may also get an error when CaptionMaker tires to 
assemble the DirectX components using these compressors.

For detailed information about codecs, there are many web sites devoted to this topic. For 
example,  the  following  are  links  to  sites  containing  general  information  for  many 
common codecs.

http://www.siggraph.org/education/materials/HyperGraph/video/codecs/Default.htm
http://www.jmcgowan.com/avicodecs.html#CodecPerformance

A good place to start is with the most common codecs that come with all versions of 
Windows. These are very reliable and will produce AVI files that are easily played back 
on most PC’s and Mac’s.

http://www.jmcgowan.com/avicodecs.html#CodecPerformance
http://www.siggraph.org/education/materials/HyperGraph/video/codecs/Default.htm
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Cinepak Codec by Radius – This is one of the most widely used codecs for AVI files. 
It’s most  significant  strength is  its  ability to be played back on the widest variety of 
machines.

Intel Indeo Video R3.2 –Indeo is very similar to the Cinepak codec. It also plays back 
on a wide variety of machines.

Microsoft Video 1 – This is an older codec developed for Microsoft Video for Windows. 
Note that this codec only supports 8 and 16 bit color.
Microsoft  RLE  –  This  is  another  older  codec  developed  for  Microsoft  Video  for 
Windows. Note that this codec only supports 8 bit color.

MJPEG Compressor –  This is the Microsoft motion JPEG compressor – it performs 
JPEG image compression on each individual frame of video. It is mostly used by video 
editing systems.

The following is a list of other codecs commonly found on Windows PC’s that typically 
don’t work well (or at all) for subtitling with CaptionMaker.
Intel 4:2:0 Video V2.50
Microsoft H.261
Microsoft H.263

Compression Options
The  “Video  Compressor  Settings”  dialog  allows  you  to  set  several  fundamental 
parameters for the selected codec. The dialog only allows you to change the settings that 
the currently selected codec supports, and the dialog also displays the default values of 
these settings for the currently selected codec.

Quality – controls the video quality produced by the codec. It is specified as a floating 
point  number  between  0.0  and  1.0.  Higher  values  will  produce  higher  quality  video 
playback and subsequently larger AVI files. Lower values will produce smaller AVI files 
at the expense of lower video quality.

Key Frame Rate – controls how often a “full frame” is recorded into the AVI file. The 
rest of the time, the compressor only records what has changed since the previous “full 
frame”. A higher value generally increases the compression ratio and reduces the AVI 
file size.

P Frames Per Key Frame– P frames are used in MPEG compression; in general, this 
property does not apply to other compression formats. For example, suppose a key frame 
occurs once every 10 frames, and there are three P frames per key frame. The P frames 
will be spaced evenly between the key frames. The remaining six frames are bidirectional 
(B) frames.
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Black  Video  File  Size  If  you  use  Animation  codec  or  any 
uncompressed codec to generate the black video, the size of the file 
would be enormous.  If  you need to transfer  the file  to a different 
location, it is advisable to zip the file before transfer, Typically the 
file will be reduced to less than 5% of the original file.

After you make your choices for the Compression Settings, and click OK, CaptionMaker-
NLE will generate an output movie with a frame size of 720 x 486. Minimal compression 
should be used when generating the output movie. Two video field output should be 
specified.

Avid Media Composer ABVB hardware users should select the Media Composer codec at 
AVR75 or AVR77.

Avid Meridien users can use either an AVI codec or a QuickTime codec. Select NTSC, Meridien 
Interlaced, Odd Field Dominant under the AVI codec options.

Media 100 users should select the Media 100 720 codec.

Matrox DigiSuite users should select the DigiSuite codec and set the compression to be minimal.

TARGA users should select the Animation codec and specify 30 fps and Millions of Colors+. 
Note: TARGA users can also select JPEG-B or the TARGA Video codec, however, due to 
hardware conflicts the TARGA Video codec can only be used by CaptionMaker-NLE if the NLE 
software that uses the hardware is not concurrently running and vice versa.

In your NLE system create a project, import the resulting QuickTime or AVI file and 
place this clip on the timeline. There should be some black before and after the clip on 
the timeline. TARGA users should highlight the clip produced with the Animation codec, 
select Clip: Video: Transparency, and select Key Type - Alpha Channel.

Alpha Channel   You can select either AVI file output or QuickTime 
file  output  if  QuickTime  is  installed.  The  selection  of  “Millions  of 
Colors+” in the QuickTime codec dialog box will  generate a 32-bit 
output  file  containing  an  alpha  channel.  Other  output  selections 
generate 24 bit movies. Note: If you generate an alpha channel you 
should  set  the  Secondary  Row  equal  to  the  Primary  Row  in  the 
Preferences  dialog,  to  prevent  a  second  occurrence  of  closed 
caption data from being inserted into your video program. 
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Adding closed captions using Avid ABVB hardware
To superimpose closed caption data onto an actual video image, place the QuickTime 
movie onto its own video track above your background image. Place a Blend: Picture-
In-Picture effect onto the imported clip and set the PIP Size to 100 and V Position to 
-941 for a Media Composer Version 6 or to -991 for a Media Composer Version 7. This 
PIP effect positions the closed caption control codes that are located towards the bottom 
of the QuickTime image file  to line 1 of the NLE image.  Line 1 of the NLE image 
corresponds to Line 21 of the VBI output signal. This has been found to be the most 
reliable way to superimpose clean image data onto line 21 of the VBI. Using the Edit: 
Preferences menu you can change the image file data generation lines.

Adding Closed Captions using Avid Express Pro
Make sure to set Avid Express Pro HD to allow it to pass line 21 caption data. Two 
settings are required to allow Avid Express Pro HD to work with CaptionMaker. These 
are 

• Preserve VBI which is located in the video output tool and 
• Set Effects Aperture to ITU601 in the General Settings
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To superimpose closed caption data onto an actual video image, follow the instructions 
described below for other Avid systems.

Adding closed captions using Avid Meridien hardware
Avid Meridien users should use the Meridien QuickTime codec. Select NTSC, Meridien 
Interlaced, Odd Field Dominant. To superimpose closed caption data onto an actual video 
image,  place the AVI movie onto its own video track above your background image. 
Place a Blend:Picture-In-Picture effect onto the imported clip and set the Crop Bottom 
value to -989. Set the Width and Height scaling to 100%.

On Macintosh Avid systems without real time effects the PIP effect must be rendered and 
is time consuming. This can be avoided by the use of the Alpha Mask file as follows. 
Place your background clip on V1 and place the Alpha Mask file on V2. Step Into the 
Alpha Mask clip and put the imported QuickTime movie onto the Graphic Fill portion, 
V2, of the Alpha Mask image. Step Out of the track and play the timeline. You should 
see a closed caption message superimposed on the output video image. Using this method 
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you are using closed caption information located on the first line of the generated image 
file.

Adding closed captions using the Media 100
To superimpose closed caption data onto an actual video image, place the QuickTime 
movie onto a video track. Place a Picture-In-Picture effect onto the imported clip, set the 
PIP Size  to  100 and V Position  to  479.  This  PIP effect  positions  the  closed caption 
control codes that are located towards the bottom of the QuickTime image file to line 1 of 
the NLE image.  Line 1 of the NLE image corresponds to Line 21 of the VBI output 
signal. This has been found to be the most reliable way to superimpose clean image data 
onto line 21 of the VBI. Using the Preferences NLE Tab you can change the image file 
data generation lines.

Adding closed captions using Pinnacle Systems  
(TARGA 2000 RTX, DTX, PRO and SDX and TARGA 1000 PRO) 
To superimpose  close-caption data  onto an actual  video image the QuickTime movie 
should be created with the Animation codec at 30 fps and Millions of Colors+. Place the 
QuickTime movie onto its own video track above your background image. Highlight the 
clip, select Clip:Video:Transparency and select Key Type - Alpha Channel.

For everyone: Remember to start the NLE playback before the start of the closed caption 

Primary Row is the row number where field 1 data will be placed. Field 2 data will be 
put  on Primary Row + 1.  The Primary Row data  value must  be between 0 and 484 
inclusive.

Secondary Row is the alternate row number where field 1 data will be placed. Field 2 
alternate data will be put on Secondary Row + 1. The Secondary Row data value must be 
between 0 and 484 inclusive. Secondary row data is needed for any NLE system other 
than Avid with ABVB hardware.

Starting Column is the column offset for the center point of the first closed caption 
clock run-in bit. The Starting Column data value must be between 14 and 39 inclusive.

Small QuickTime allows the generation of QuickTime data files that reuse a previously 
compressed image frame. For example, the QuickTime frame corresponding to the closed 
caption binary values of 0, 0 occurs fairly often in a closed caption QuickTime movie. 
With Small QuickTime selected, when a second 0, 0 frame is about to be compressed a 
pointer is built into the QuickTime file that references the previously compressed 0, 0 
image frame. The use of the previously compressed image frame saves both the time 
needed to compress the image as well as the space needed to store it. A QuickTime 
movie file created in this manner is significantly smaller in size than one created without 
this option, however, not all non-linear editing systems are able to display video that is 
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compressed with these type of previously referenced frames. Deselecting Small 
QuickTime can turn off this feature.

Adding closed captions using Blackmagic DeckLink Extreme
The Blackmagic Design DeckLink Extreme hardware requires a specific video setting to 
work with close captions. To configure DeckLink Extreme hardware to work with close 
captions  open the Macintosh System Preferences,  find the DeckLink Extreme control 
panel and set up the 3:2 Pull down & VANC settings as follows:

Under NLE/Export menu use "Black 720x486 NLE Movie with Closed Captions" and 
generate a QuickTime movie containing just closed captions. To superimpose closed 
caption data onto an actual video image, place the QuickTime movie onto a video track 
and crop the video keeping just the close caption lines that are located near the very top 
of the video frame.

Adding closed captions using AJA Io Hardware
To use AJA Io hardware with Final Cut Pro time line must be configured for a video size 
of 720x486. Export an NLE video from CaptionMaker using the Animation codec at the 
uncompressed resolution and import it into FCP. When you play the imported video clip 
the closed captioned video will appear on the SDI, component and composite video 
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outputs. To merge the imported closed caption video with the underlying video material 
put the imported clip on a higher video track than the rest of the video and crop the 
imported clip up from the bottom leaving the closed caption data at the top. When 
cropping the imported clip you should leave one extra line of black below the closed 
caption data to act as a clean separator line between the closed caption data and your 
video program. The AJA Io hardware can not be used to export video containing closed 
captions in DV video.

Retrieve captions
CaptionMaker-NLE can display and decode closed captions from a video as long as the 
video is closed captioned, plus it captures the closed captions as a text file, from the video 
coming via FireWire. 

Go to the NLE > Retrieve Captions menu and choose one from the following:

• DV AVI 720x480 video
• DV QuickTime 720x480 movie
• Mpeg2 720x480 video (mpg, mpeg, m2v, vob)

Many  Digital  Video  cameras  and  VCRs  will  convert  an  analog  signal  to  a  digital 
FireWire signal.  To watch a real time TV broadcast with your computer,  connect the 
analog video and audio output from a VCR to the analog video and audio input of your 
DV camera or DV VCR and connect the Digital/FireWire output of your camera to your 
computer. You may use the retrieved caption data and create a DVD video with captions 
or export caption files for video-on-demand Webcasts for QT, WMP or RealPlayer.

Adding subtitles to digital video
• (Burn Subtitles) to any Video File (*.*) and saves as (*.avi) 
• (Export Subtitles) Blank AVI 720x486 for NLE (*.avi)
• (Export Subtitles) Blank QuickTime 720x486 for NLE (*.mov)

CaptionMaker-NLE can read a video file (AVI, MPEG, WMV, etc.), overlays subtitles, 
and outputs a standard Windows AVI file with your subtitles “burned” into the video.  

In addition, CaptionMaker-NLE can export a 720x486 blank video (with your choice of 
color) with subtitles in both QuickTime and AVI formats. These videos can be added to 
the original video (720x486) inside an NLE system using a special effect to get rid of the 
background and extracting the subtitles.
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Tips: You will probably get the best result, if you choose the option 
of blank video and merge the subtitles with your original video using 
your  NLE  system.  This  way  CaptionMaker  does  not  have  to 
decompress  your  video  and  write  the  subtitles  on  the  video  and 
compress it back.

To play back and capture  video files,  video and audio decompressors (decoders)  and 
compressors  (encoders)  are  required.  Encoder/decoder  software  modules,  called 
“codecs”, are installed into the Windows operating system for this purpose. There are 
several codecs that come with Windows, and there are many third party codecs available.

Note that Windows Media Player uses this DirectX functionality to play back video files. 
If  you  have  trouble  playing  or  subtitling  a  particular  video  file  with  CaptionMaker, 
playing back the problematic  file with Media Player  will  usually correct  the problem 
(because Media Player can automatically update your system by to properly play your 
file by downloading and installing updated codecs).

Burning subtitles to a video file
Select Ultech DV2000 (ITV Injector) subtitle device as the default device.
Author the subtitles. Typically, the video file to be subtitled is also used during the 
authoring process. If so then steps 2 and 3 below can be skipped because they were 
already performed at the start of the authoring process.
In the “Video Properties” dialog, enter the full path and file name of the video file to be 
played during authoring. CaptionMaker also uses this entry as the input video file to be 
subtitled.
Also in the “Video Properties” dialog, enter the time code value for the first frame of the 
video file (if required). CaptionMaker uses this entry to control the timing of the 
overlaying of the subtitles into the video file.
It is highly recommended that you run AutoSync at this point to verify the appearance, 
positioning, and timing of your subtitles in the preview window.
Choose “Export” in the “File” menu.
Select “File Type” =  “DVD/DV2000/Webcast Subtitle” or “All File Types”.
In the drop down list, select “Video File (Overlay Subtitles)”.
Enter the full path and file name for the subtitled output AVI video file to be generated.
Click “Finish”. CaptionMaker will display the “Video Compressor Settings” dialog.
Select the desired Video compressor and compression options.
Click “OK” to start the subtitling process. The progress of the operation is indicated at 
the bottom of the main CaptionMaker window. The operation can be aborted by pressing 
the “Esc” key.
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Subtitle quality vs. video dimensions
The subtitle generator inside CaptionMaker generates the subtitles images at a resolution 
of 720x480 (NTSC). When the dimensions of the video file (width x height) are smaller 
than this,  for example 320x240, then the subtitles  must  be scaled down to match the 
resolution of the video file. This results in some loss in the quality of the subtitles. The 
smaller the dimensions of the video file, the more quality is lost scaling down the subtitle 
images. To obtain the highest quality subtitles, the video dimensions should be 720x480 
(or at least 640x480).

Time code restrictions
The subtitle generator inside CaptionMaker uses time code (SMPTE12M) to control the 
timing of the subtitles. Therefore, the video file being subtitled needs to be 24, 25, 29.97, 
or 30 frames per second. Subtitling a video file with a frame rate other than these can be 
done, but this can make it very difficult to achieve accurate subtitle timing.
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C h a p t e r  7
L i v e  C a p t i o n i n g

Overview
The CaptionMaker is designed for live realtime captioning using a steno machine.

Additionally, it can also be used for:

1. Budget realtime captioning using optional speed typing software. 
2. Budget realtime captioning using optional speech recognition software.

DSP-1000  LED  Display  Device  Beside  captioning  video  with  a 
standard closed caption encoder, you can also display captions on 
Museum Technology's LED display DSP-1000/CC-1000 device. This 
is  a  4  line  32  column  LED  display  device.  
CaptionMaker can send caption data in Roll-up mode to this device 
via a serial  connection.  This is usually used for live caption for a 
large audience sitting in an auditorium.

Realtime Captioning Using a Steno Machine
For realtime captioning with a steno machine, you need: 

1. A steno machine (writer) to enter data at high speed. 
2. A high-speed computer with a sizable amount of memory to store a large 

dictionary, which is used to translate steno keystrokes into words. 
3. Realtime captioning software, which translates steno keystrokes into English and 

then sends that data to an encoder. 
4. A caption encoder to insert the caption data onto the video. 
5. A highly skilled court reporter (realtime captioner). 

Preparation and Fixes
Before the show starts,  the realtime captioner  goes through the materials  that  will  be 
covered in the show and enters all the proper names and new words that might not be in 
their  dictionary.  For  a  half-hour  show  the  captioner  sometimes  needs  to  spend  an 
additional half-hour or more to do this.
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Some TV stations rebroadcast their evening news later at night. You may have observed 
that the rebroadcast part of the late night news has virtually no captioning errors. This 
happens because the captioner has time to fix errors before the news is rebroadcast. At 
the time of rebroadcast, the captioner simply presses only one key to send one line of 
captions at a time from the script prepared earlier for the evening news. Since one whole 
line goes out at a time, captions are painted on the screen very smoothly from left to 
right. You can easily identify these captions. You may sometimes even see the captions 
appear before they are spoken!

Captioning at the Top of the Screen
Decoders adopting the new 1993 FCC/EIA specifications can support Roll-Up captioning 
at the top of the screen. All decoders manufactured before July, 1993, can only display 
Roll-Up captions at the bottom of the screen. If you have a new decoder or a new TV 
with a built-in decoder, you might sometimes see captions appear at the top of the screen 
to avoid conflicts with the graphics (names of people, etc.) at the bottom of the screen. Of 
course, the captioner has to make an extremely fast decision to move the captions to the 
top when necessary. If the captioner does not do that, even with the new decoders you 
will see captions covering graphics at the bottom.

Do Not Blame the Captioners for All Errors
Not  all  the  captioning  errors  on  the  TV  news  are  the  result  of  mistakes  made  by 
captioners. The captioners work under intense pressure, and it is quite possible that they 
make some errors. A good captioner normally does not make more than 2% errors.

Errors can also arise because the caption information is a very sensitive signal encoded in 
a small area inside the video. If the picture reception on your TV is not very good, you 
will invariably see some mistakes in captions due to the distortions of the caption signal.

The Ultimate Solution
Ideally,  if  there  were  a  machine  (speech  recognition)  to  translate  the  speech  of  all 
speakers into captions, you would not need highly skilled and expensive captioners. The 
expense factor  prevents  many TV stations  from captioning  the news. But the present 
speech recognition systems are still  in their  infancy.  They cannot even interpret  more 
than one speaker at a time. A large amount of research and money is being spent every 
year to make this technology feasible, but there is still a long way to go. 

Realtime Captioning and Steno Writing
There are more than 20,000 court reporters in the United States. When they work in the 
courtroom  environment  they  can  afford  to  make  some  mistakes.  They  can  fix  the 
mistakes later and present the final corrected copy the next day (unless they are doing 
realtime  reporting).  In  regard  to  realtime  captioning,  they  do  not  have  that  luxury. 
Because the captions go out live instantly, there is no time for corrections. This is why 
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not all court reporters are realtime captioners. In fact, only a small percentage (less than 
2%) are certified as realtime captioners. Their average writing speed is around 250 words 
per minute. The steno machine has only 24 keys with thousands of possible keystroke 
combinations. There are 4 keys for vowels (A, O, E and U). To write a letter I, you need 
to press E and U together. The rest of the keys are divided into two parts. The left keys 
are for the beginning of a word, and the right keys are for the end part of a word. Left 
keys are S, T, K, P, W, H and R; and right keys are F, R, P, B, L, G, T, S, D and Z. Not 
all consonants are available as a single keystroke. For example, to write B, you need to 
press P and W together. You may press only one key, or as many as 10 keys all at the 
same time. Each keystroke, whether it is a single key or multiple keys, can produce a 
syllable, a word or even a phrase. It completely depends how you design your dictionary 
to respond to your keystrokes. It is astounding to think how it is possible to remember 
thousands of keystrokes. Of course, there are some standards which people follow. But 
every captioner adds their own keystrokes to their system. Here are you a few examples. 

Keystrokes English word(s)
TH This
g_ Is
PW A_LS _D Balanced
PWLTD SKWR_ET Budget
SPH A_FT as a matter of fact

Captioners keep a number of phrases and abbreviations like this in their repertoire to 
attain writing speeds in excess of 250 wpm. 

Realtime Captioning Not Using a Steno Machine
Since it is impossible type as fast as words are spoken, realtime captioning can only be 
done properly by using a steno machine. A professional realtime captioner can type more 
than 250 words per minute with over 99% accuracy using a steno machine. Due to their 
amazing skills, these professionals are quite expensive.

For low-budget situations,  there are two possible alternatives solutions that are not as 
good as  realtime  captioning  with  steno  machines,  but  in  some  cases  are  acceptable. 
Instead of using the steno machine, text can be entered using speed typing software or 
speech recognition software. The details can be found at the end of this chapter.
 

Realtime Captioning Setup
To set up for Live Caption, make sure to go though the following checklist. 

1. Open Ancillary Toolbar
2. Invoke Full Screen Spreadsheet view
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3. Invoke Live Caption mode
4. Set the desired choices to display captions
5. Configure Encoder/Decoder
6. Modem setup (if you are captioning from a remote location) 
7. Install software for text entry (steno machine, etc.)

Open Ancillary Toolbar
Go to the View menu and click the Ancillary Toolbar. At the right end of this toolbar you 
see icons pertinent to Live Captioning. Bring the mouse on top of each icon to view the 
tool tip and familiarize yourself with the function of each icon. The details can be found 
in the “Chapter 9: Icons and Buttons”.

Invoke Full Screen Spreadsheet View
It is much easier to caption live in the full-screen view as opposed to the screen with the 
video window. Click on the option under View → Full screen Speadsheet menu to set the 

full screen view. You may also click on the icon  to toggle between the two screens.

Note:  Do  not  use  the  view  with  video  preview  window.  This  window  takes  lot  of 
processing power and slows down captioning.

Invoke Live Caption Mode
Click on the option under Caption → Live Caption menu to set the Live Caption mode. 
You may also click on the icon   on the ancillary toolbar to do the same. In Live 
Caption mode, CaptionMaker captions in the Roll-Up mode only. Roll-Up captions scroll 
up from the  bottom (usually)  of  the  screen one  line at  a  time.  Two to four  lines  of 
captions (maximum of 32 characters per line) normally appear on the screen at any given 
time. Television news and talk shows normally use Roll-Up captioning.

Set the Desired Choices to Display Captions
You can choose parameters like Caption Length, Number of lines in Roll-Up mode, Left  
Indentation  etc.  from the  Caption  → Live  Caption  Options  menu.  You  may  assign 
shortcut  keys  to  invoke any of  these  options  too.  See “Chapter  8:  Menus” for  more 
details. Some of these options can be invoked either by clicking on the appropriate icons 
or by pressing multiple keystrokes. See the Tools → Customize Keystrokes menu.
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Number of Lines in Roll-Up Mode
You can set up the maximum number of lines of captions you would like to see on the 
video screen at any given time (typically 3). Go to the menu option  Caption  → Live 
Caption Options and choose for Roll-Up 3 Lines. 

Tip     Make sure the Display column shows Roll-Up mode (not Pop-
On or Paint-On). To change the mode, click on the Display header to 
highlight the column. Right-click anywhere on the column except the 
header and choose a mode. 

Caption Length
Each line of text in the Work Area equals one caption line of up to 32 characters. You 
can choose to display less than 32 characters on a line if you so desire. If you choose an 
indentation other than 0, the length is reduced by that amount from 32. In other words, if 
you choose an indentation of 4, the maximum length allowable is 28.

Indentation
You may also choose the desired amount of indentation (i.e., the left margin). You may 
choose the icon  to do the same.

Fast Indentation
If you want to change the indentation on the fly, you may also do so by invoking any one 
of the 6 preset positions.

Roll-Up One Blank Line
This menu item sends one blank caption  line to  the video resulting in rolling up the 
existing caption on the video by one line. This option can also be used to clear captions 
on the video by invoking it several times to roll up existing captions of more than one 

line. You may choose the icon  to do the same.

Font Height… 
The font height of the text seen on the CaptionMaker screen by the captioner in the Live 
Caption Mode can be changed. The choices are 9-point through 24-point type. A larger 
font is easier to read. This font size is only for the captioner, the font height of captioned 
text seen on the television by home viewers is fixed. The font comes from the television 
set and it is a standard font for all television sets. 
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Send Option…

Line/Word Sending
You may send the text to the closed caption encoder using either of the two options:

• Send after each word
• Send after each line

For each option you may also choose a time delay. If the Time delay box is not checked, 
Send after each word option sends a word as soon as you press the space character. Send 
after each line option sends a line as soon as a line in completed and the cursor goes to 
the next line. You do not have any control to fix any word or line after the word or the 
line is sent to the encoder.

On the other hand, if you check the Time Delay box and set the delay time to any time 
between 0 and 10 seconds, you have time to fix any word or words that are not yet sent to 
the encoder. 

Highlight Sent Live Caption Words/Lines
If you check this box, the words and lines, which were already sent out to the encoder, 
will show in different color.
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Timer Settings
There are two time-out settings – one for flush last word and the other for closing the 
caption device.

Flush Last Word After…
When you type words on the live caption screen, after you put a space, CaptionMaker 
knows that you completed a word and it sends the word out to the encoder. But after 
typing a word if the cursor is still touching the last letter of the word, CaptionMaker does 
not send the word to the encoder, because it thinks that word is not complete yet. So the 
last word is never sent out.

Putting  a  value  of  1  or  2  seconds  to  “Flush  Last  Word  After...”,  you  can  tell 
CaptionMaker to flush the last word even if the cursor is still touch the last letter of the 
word. This is particularly useful if you are using a speech recognition software to input 
the text. After you are done inputting the text with a speech recognition software, the 
cursor always stays attached to the last word.

Close Caption Device After…
If you are switching between two computers sending caption data to the same encoder via 
an A-B switch, to accomplish two speakers or for any other reasons, it is important that 
after one computer done sending caption data to the encoder, the encoder device must be 
closed, so the other computer can send caption data to he encoder. You may put a value 
of 2 to 3 seconds for “Close Caption Device After...” option, so the encoder is closed 
after 2 to 3 seconds to accept data from the other computer.

When you resume sending caption data from the first computer again, CaptionMaker will 
automatically open the device.

You will need to know about a few more options related to live captioning, which are 
described below. They are related to the vertical  position and clear captions from the 
video screen and converting upper and lower case text into all upper case. You also need 
to know the status window, which shows some basic chosen parameters.

Vertical Position
You may caption at  the top or the bottom of the screen.  Choose the desired vertical 
position from the Attribute → Vertical Position menu or from the icons on the Ancillary 
Toolbar. You may choose Top (Vertical position =1), Bottom (Vertical position =15) or 
any position 1 through 4 or 12 through 15. Roll-Up captions cannot be displayed with 
base line starting from lines 5 through 11.

Click on the icon  to place the captions at the top of the screen.
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Click on the icon  to place the captions at the bottom of the screen.

Click on the icons  to move the base row of Roll-Up captions up or down by one 
line.

Clear Caption
You may clear the caption on the video monitor by choosing Caption → Clear Caption 

menu option or, clicking on the icon  on the Ancillary Toolbar.

Convert to uppercase
You may convert upper and lower case text to all uppercase captions by checking the box 
Convert to uppercase option from the Caption → Properties → General Tab menu.

Status Window
At the bottom right side of the screen, a small window displays the default settings of the 
vertical (V) position, left indentation (L) and the choice of Lines for Roll-Up (R) mode. 
The default status is as follows:

V15L00R3
V15 indicates the vertical position is 15 which the bottom of the screen
L00 indicates the left indentation is 0.
R3 indicates Roll-Up 3 Line display mode.

Configure Encoder/Decoder
See “Chapter 2: Hardware Installation” to make sure you are properly connected to the 
Encoder/Decoder.

Modem Setup 
If you are captioning from a remote location, you have to make sure that your modem is 
properly connected. See “Chapter 2: Hardware Installation” for details.

Install Software for Text Entry 
See the next section, “Realtime Captioning Using a Steno Machine” for details.
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Realtime Captioning Using a Steno Machine
The CaptionMaker has been designed to accept text input from any one of the following 
devices,  and then  send the  input  text,  line  by line,  to  the  caption  device  to  produce 
captions:

Steno Machine running realtime court reporting software. 

Speech recognition software.

Standard computer keyboard with or without speed typing software.

This section will describe exactly how the CaptionMaker interfaces to a steno machine 
running any Windows realtime court reporting software.

Note:    CaptionMaker  works  with  any  Windows  realtime  steno 
software as long as the text from the steno software is inserted to 
the keyboard buffer. 

A Windows steno software  must be run in conjunction with CaptionMaker. Check the 
Steno software manual for details on:

• Installing a steno software in the computer. 
• Which steno machine models you can use.
• Built-in and user dictionaries. 
• Importing dictionaries from other court reporting systems.

Live Captioning in Action
Make sure that the Live Caption mode (inside the Caption menu) is checked. Type a short 
line of text on the computer keyboard and send the line by pressing the  [+] key on the 
computer keyboard near the keypad area. If all the connections are correct, you will see 
the  line  of  text  appear  as  captions  on  the  television screen,  which  indicates  that  the 
CaptionMaker software is working.

To verify that both the CaptionMaker and the steno software are running fine together, 
type a few words on the steno machine and the text will appear on the computer screen. 
As the text being typed exceeds the caption length chosen, the text will wrap around on 
the computer screen and go out to the caption device to produce one line of captions on 
the television screen.  
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Assigning Shortcut Keys from the Steno Machine
You can assign keystrokes to your desired keys for any one of the Live Caption options 
using  Customize  Keystrokes under  the  Tools  menu.  Here  is  a  list  of  recommended 
keystrokes for some realtime captioning options.

Keystroke Option
Ctrl+T Top
Ctrl+B Bottom
Ctrl+K Clear captions
Ctrl+R Roll up 1 blank line
Ctrl+ ↑ Move up 1 line
Ctrl+ ↓ Move down 1 line
Ctrl+0 Left Indent 0
Ctrl+1 Left Indent 4
Ctrl+2 Left Indent 8
Ctrl+3 Left Indent 12
Ctrl+4 Left Indent 16
Ctrl+5 Left Indent 20

After you assign the proper keystrokes inside the CaptionMaker, you may assign shortcut 
keys to your steno keyboard to invoke any of those options. Consult the steno software 
manual for instructions.

Live Mode Encoder Transparency
To invoke this option, click on the item to “Close Device” inside the Caption Menu.

When the caption device is closed, the caption encoder will be commanded to go into 
“transparent mode” to allow all existing caption data to pass through the caption encoder 
in  tact.  During  Live  caption  encoding,  closing  the  caption  device  allows  upstream 
captions to pass through the caption encoder during commercials. Note that the caption 
encoder is automatically re-opened and re-initialized by CaptionMaker when you send 
any  caption  data  to  the  caption  encoder  (continue  typing  in  live  mode,  select  “send 
caption” or “clear caption”, etc.).

Instantly Switching Between Realtime and Live Display 
Captioning

If you are captioning programs such as TV news, where you must caption some portions 
live and have text for other portions in advance, the CaptionMaker will enhance your 
captioning capability. 
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To provide an example of how this works, this section will walk you through the process 
of captioning  a  TV news program,  illustrating  how easy it  is  to  switch between live 
captioning and captioning with prepared text. Note that pre-recorded portions should be 
ready for use prior to live broadcast. 

The following chart  and text  provide an example of switching between Live Caption 
(Realtime) and Live Display (Post Caption). Live Display is used for segments that have 
been entered prior to airtime.

Type of Segment Type of Captioning To Use
Live report from field Realtime caption

Pre-recorded segment Live Display
Weather Realtime caption

Pre-recorded segment Live Display
Late breaking news story Realtime caption

Pre-recorded segment Live Display

The procedure is simple. Import or enter any text available prior to the news program. 
Whenever  there  is  a  live  segment,  enter  text  into  the  steno  machine  for  realtime 
captioning. When you reach a segment of pre-recorded text, click on the desired caption 
and  press  a  pre-assigned  key  on  your  steno  machine  (to  mimic  the  [+] key  on  the 
computer  keyboard)  to  output  the  line  of  text  as  captions.  When  the  segment  with 
prepared text is finished, resume realtime captioning on your steno machine.

You will know the segment is finished when the text segment ends and the Talent begins 
another segment of live speaking. Note that the position of the cursor when ending one 
segment is exactly at the position to begin captioning the next prepared segment.

A typical file will look like the following. 
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Notice the file has been created with the prepared text. The text in Red (gray) indicates 
the place where you enter text  from the steno machine  or from a speech recognition 
system. The blank rows send a blank line of caption in between the Live Display and 
Live Caption modes.

To send a row of text (or blank line), simply press the [+] key from the keyboard or from 
the Steno Writer.

Realtime Captioning N  ot   Using a Steno Machine
Since it is impossible to type as fast as words are spoken, realtime captioning can only be 
done  properly by using  a  steno machine,  which  can  be  quite  costly.  For  low-budget 
situations, there are two possible alternatives solutions that are acceptable in some cases.

Budget Realtime Captioning with Speed Typing 
Software 

There are a few software packages on the market designed to enhance your typing speed. 
If your typing speed is around 70 wpm, you can increase your typing speed to 150 wpm 
or so after a few months’ practice. It works like macrotyping in some word processors. 
For example, you program this software so that every time you type “ys” and then press 
the space bar, it will replace “ys” with “Yours Sincerely”. Many secretaries at lawyers’ 
offices use this software to enhance their typing speed.

If you take this route, you can type most of the words of a live event even if the speaker 
talks fast. CaptionMaker will simply send the words at the same speed you type.

Contact CPC for information on speed typing software.

Budget Realtime Captioning with Speech Recognition 
Software

The  CaptionMaker  is  designed  for  live  realtime  captioning  using  speech  recognition 
software.

There are several software packages available, such as Naturally Speaking (English and 
Spanish) and ViaVoice (English), which can convert speech to text fairly well after you 
train  the software to  your  voice.  The more  you  train  it,  the  better  it  gets.  The  main 
problem with these software packages is that they do not recognize a new voice, only the 
one they have been trained for.

With the aid of this software, if you can act somewhat like an interpreter who typically 
translates from one language to other for a live event, you can do live captioning fairly 

http://www.nuance.com/viavoice/pro/
http://www.digitalriver.com/v2.0-img/operations/scansoft/site/html/dragon/Preferred_9.htm
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well. You do not have to translate, you just have to listen to the words from different 
speakers and repeat the words out loud, because the speech recognition software only 
recognizes your voice. 

If you are regularly a speaker for live events, you could train speech recognition software 
to your voice and then caption live using CaptionMaker software.

First, run the speech recognition software and train the system to your voice. The more 
you train, better it understands you. 

Next, minimize the speech recognition software and open the CaptionMaker software and 
speak. The text of your speech will appear inside the CaptionMaker screen. As soon as a 
line of text exceeds the Total number of characters per line you have chosen, the text will 
wrap around on the screen, and the line will go out to the encoder and appear on the 
video as captions.

You may also press the  [+] key to send an unfinished line at any moment if you want to.

This function is available in only the Roll-Up display mode. Set the proper left and right 
margins and the maximum number of rows for Roll-Up captions. As you type the text, as 
soon as the text  wraps around to the next row, the text  is  automatically sent  out for 
captions. You may also press the  [+] key any time to send the text in the current row.

Languages supported
Naturally Speaking is available in multiple languages such as, English, Spanish, French, 
German. ViaVoice is available only in English 

Realtime Captioning with Naturally Speaking
To use Dragon Naturally Speaking versions 7 and up with CaptionMaker, it is necessary 
to  execute  an  utility  software  called  DnsIniFix.  This  utility  will  find  the  Naturally 
Speaking ini files on your computer and add an entry to them for CaptionMaker. The 
utility software DnsIniFix.exe is available from
www.cpcweb.com/download/cmplete_software_downloads.htm#Utilities

Accuracy & delay
Naturally Speaking software analyzes a complete sentence or a phrase until you pause 
talking  and  gives  better  accuracy  compared  to  ViaVoice.  Since  Naturally  Speaking 
analyzes the text before showing it on the screen, if you use it for live captioning, the 
captions might be delayed by a few seconds. For transcription purposes, the delay does 
not matter.  So Naturally speaking is better  than ViaVoice from the accuracy point of 
view.

http://www.cpcweb.com/download/cmplete_software_downloads.htm#Utilities
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Captioning Video from Remote Location
If you are captioning a video generated at a remote location, you need to connect your 
computer  to  the  encoder  located  at  the  remote  location  via  a  telephone  line  using  a 
modem attached to your computer. The encoder must have a built-in modem or a modem 
attached to it. If you have a Norpak encoder, you may also connect the encoder via a 
LAN or via internet. See Hardware Installation chapter for the details.

Modem
If you are using an external modem, you should see the name of the external modem 
appearing in the Modem Settings windows. You must have the external modem

Powered on.
Connected to the computer via a serial cable. 
Must have been recognized by Windows when you power the computer on.

Whether you have an internal modem built into your computer or an external modem 
attached to the computer, the process of choosing the modem is the same. You need to 
select both the caption device (encoder) and the modem.

First choose the caption device (encoder) 
Then click on the Configure button inside the Caption Device dialog box. 
Check the box Connect via modem using inside the Caption Device Settings 
dialog box below and select your modem. 

LAN and Internet

If you are using a Norpak encoder, you can connect the encoder via a LAN connection or 
via an internet connection as long as the encoder is associated to an IP address.

Click on Connect via Local Area Network (LAN) radio button. Type the IP address and 
Connection IP Port.
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C h a p t e r  8
M e n u s

File Menu
New
Creates an entirely new file. If you have a file open, it will give you the opportunity to 
save the currently open file, before it will create a new file. The CaptionMaker cannot 
support two files open at once.

Open/Save/Save As 
The Open/Save/Save As options handle only Windows CaptionMaker files. To open and 
save any other kind of file, you must use Import/Export/Merge options.

Saving files in a non-CaptionMaker file format (e.g., text or Word file) will still set the 
name of the file as "Untitled". Also when you open a non-CaptionMaker file and if you 
have the Auto Save option on, CaptionMaker will prompt you to save the file under the 
name untitled.cap in CaptionMaker format every few minutes (according to the AutoSave 
time interval). 

Note  After you open a non-CaptionMaker file, you must save the file 
in CaptionMaker file format (.cap) once to stop the AutoSave dialog 
box from popping up every few minutes.

Insert File
You may insert a file (Text, Word, CaptionMaker or any of the allowed files) to the 
existing document that is already open in the Work Area.

Import/Export Files
The CaptionMaker can Import/Export the following file groups, each of which contains 
numerous file types:
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• Word Processor (including text file)
• Caption Formatted
• DVD/DV2000/Webcast Subtitle
• DV
• NLE
• HD

For details, check the chapter 3: Importing and Exporting Files.

Auto Save
Offers the option of saving the file automatically, including the time interval (in minutes) 
desired. You can choose one option or both.

Automatically save the document every [xx] minutes
Automatically save to a backup file every [xx] minutes

The first option automatically saves the file every [xx] minutes. If you choose this option 
it would not be possible to revert to a much earlier version if needed.

The second check box offers the option of only saving automatically to a separate backup 
file with an extension BAK. This option can be advantageous because it both ensures that 
the file is saved periodically, but also makes it possible to revert to a much earlier version 
if needed.

If you open a .bak file, you must resave the file under a different name with cap extension 
before start working with the file.

Merge Import 
The option import for merge files helps translate the first language a video is subtitled in 
to additional languages and replace the "number markers" at the start of designated lines 
with time code values from the base file. The base file is the original file with time code 
assigned to key points in the text. See the “Import/Export for Merge Files” section of 
Chapter 3 for a more complete explanation.

Merge Export
The option export for merge file helps to translate the first language a video is subtitled 
into additional languages and replace the "number markers" at  the start of designated 
lines with time code values from the base file. The base file is the original file with time 
code assigned to key points in the text. See the section Import/Export for Merge Files of 
Chapter 3 for a more complete explanation.
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Default File Folder
This option allows you to set up a default folder/directory where the CaptionMaker will 
look for files when you run the software. It is a good idea to create a folder to keep all the 
caption data files and assign that folder as a default folder to open files from and save 
files to.

Print
Sends the Work Area (any selected Visible Columns) to the printer.

Print Preview
Lets you see how the Work Area will print to the screen. It is a useful option for quickly 
looking through pages of text before printing.

Print Setup
Brings up a standard Windows Print Setup dialog box in which you may select a printer, 
paper, and orientation options. 

Page Setup
The Page Setup dialog box offers a chance to decide on printing margins and options. 
Also choose which columns you want to print by clicking, on the Print Column button.

Note: If you print the vertical and horizontal lines, it takes a long time 
to print a document. Try not to print the vertical and horizontal lines 
if you can live without them. 

Exit
Closes the CaptionMaker program.
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Edit Menu

Undo
This command will undo your last action. The computer maintains a deep stack of past 
actions.  If  there  is  nothing  that can  be  undone,  nothing  will  happen.  The  keyboard 
shortcut for Undo is [Ctrl] + Z.

Redo
If you have undone too many actions, this will redo those actions. The keyboard shortcut 
for Redo is [Ctrl] + Y.

Cut
Takes the selected text and puts it onto the clipboard. Unlike Copy, it does not preserve 
the text selected. The keyboard shortcut for Cut is [Ctrl] + X.

Copy
Takes the currently selected text or graphic and temporarily copies it onto the Clipboard. 
The keyboard shortcut for Copy is [Ctrl] + C.

Paste
Takes  whatever  is  on  the  clipboard  and puts  it  into  the  Work Area.  Preserves  some 
formatting (color, font), but not all of it. The keyboard shortcut for Paste is [Ctrl] + V.

View Menu
Visible Columns
This option allows you to select which columns you would like to be visible in the Work 
Area, such as Start Time, Duration, Justification, etc.
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Full Screen Spreadsheet
You may switch between two different views of the CaptionMaker screen: Preview video 
screen with a few lines of caption/subtitle text or full view of caption/subtitle text with no 
video screen. To access these two views, click on View → Full Screen Spreadsheet.

Pop-Up Preview Window
When you are in the Full Screen Spreadsheet view, you may pop up the video Preview 
Window to see the video on the computer screen. You may move the Pop-Up Window by 
clicking on the top bar of the window and dragging to the desired location.

Anchor Current Row
You may anchor the current row to the 3rd row so you can always see a few rows of text 
below the current cursor location. This is very important in non-Full Screen View where 
you can see only 6 rows of text. If you do not anchor, you won’t be able to see any text 
below the row you’re working on. 

You may set the anchoring for four different situations.

Anchor in Edit mode
When this option is checked, anchoring would be in effect in the Edit mode.

Note   If you are annoyed by rows jumping up and down while you 
are pushing/pulling words between rows, turn this option off. 

Anchor on Send Caption/Subtitle
When this option is checked, anchoring would be in effect while you send captions or 
subtitles using the [+] key.

Anchor in AutoSync/AutoPreviewSync
When this option is checked, anchoring would be in effect in the Auto Sync and Auto 
Preview Sync modes. This option is always checked as a default. 

Anchor in Live Mode
When this option is checked, anchoring would be in effect in the Live Caption mode.
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Main Toolbar
The main toolbar  has a variety  of buttons.  They are  Open, Save,  Print,  Spell  Check, 
Undo,  Redo,  AutoSync,  AutoPreviewSync,  Left  Justify,  Center  Justify,  Right  Justify, 
Bold, Italic, Underline, Text Color, Final Check, Customize Key Strokes. 

Ancillary Toolbar
The ancillary toolbar contains all the items on the right side of the Operations Center 
except the ones related to time code. 

VTR Toolbar
The VTR toolbar  has a variety of buttons, including Play,  Pause,  Stop,  Rewind, Fast 
Forward,  Seek  TC,  Shuttle  Rewind,  Shuttle  Forward,  Decrement/Increment  Shuttle 
Speed, Advance 1 frame reverse/forward. 

Note   Both the Ancillary and VTR may be invoked when you are 
using the full screen view. Removing the check next to the toolbar 
menu item will hide the toolbar. When you rest the mouse cursor on 
top  of  a  toolbar  icon,  a  tool  tip  will  show  the  name of  the  icon. 
Descriptions  of  the  icons  can  be  found  in  this  chapter  and  in 
“Chapter 9: Icons”.

Status Bar
The status bar sits at the very bottom of the screen. Hiding it by removing the checkmark 
on its menu item may give you a bit more room in the Work Area to view lines of text. It 
contains some relevant information about default  settings of caption/subtitle hardware, 
video and time code type (NTSC/PAL), and status of CapsLock and NumLock keys. It 
also shows whether the time code is Non-Drop (N) or Drop (D) frame just before NTSC/
PAL.

Attribute Menu
Display Mode
The  Display Mode menu item opens a submenu that offers the following options for 
caption appearance: Pop-On, Paint-On, Roll-Up, Block Roll-Up.
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Pop-On
Pop-On mode pops 1 to 4 lines of captions or subtitles onto the screen simultaneously. It 
is the most often used mode for subtitling, and is considered to be the “classiest” mode 
for closed captioning. It is virtually impossible to use the Pop-On mode without using 
time code or the PC System Timer. The technical reason for this is that it  takes time 
(roughly 1/60th of a second) to process each character of a caption line. Only when this 
processing has been completed will the caption line be put onto the screen. Since this 
delay  is  variable  (because  the  number  of  characters  in  each  cell  varies)  it  is  almost 
impossible  for  a  person  to  compensate  for  this  delay.  The  CaptionMaker  software 
precisely compensates for this delay when used with time code or the PC System Timer.

Paint-On
In this mode, the characters are painted on the screen one after another, from left to right, 
so that the screen looks like the output of a human typist. When the first word of the next 
caption appears, the entire previous caption is erased.

Roll-Up
The Roll-up mode provides for captions to scroll up from the bottom of the screen one 
line  at  a  time.  Two to  four  lines  normally  appear  on  the  screen  at  any  given  time. 
Television news is a frequent user of Roll-Up captioning (often in conjunction with a 
teleprompter that generates captions, such as the CPC-2000).

Block Roll-Up
The Block Roll-up mode is a combination of the Paint-On and Roll-Up modes. Two to 
four lines of captions are scrolled onto the screen from the bottom. When the next caption 
appears, one line of caption disappears from the top.

Pass Through Captioning
You can  choose  the  Pass  Through mode  for  a  segment  of  the  video  which  as  been 
previously captioned. This mode lets the captions previously existing on the video pass 
through.

Right-click on the cell under Display Mode  and choose Pass Through mode for the time 
codes for which you want to let the existing captions pass through the encoder. Then 
resume captioning at  the time code you want to stop Pass Through. In the following 
example,  existing captions from the video will  pass through the encoder at time code 
01:03:35:13 and the CaptionMaker will start captioning again at time code 01:04:15:18

01:03:31:08 Pop-On NOW I'M AT THE
RIGHT OF THE SCREEN,

01:03:33:07 Pop-On SO MY CAPTIONS
APPEAR AT THE RIGHT.

01:03:35:13 Pass Through
01:04:15:18 Pop-On NOW I AM GOING OFF-SCREEN.
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Text Color
Choose the color of the text from one of eight colors: default (black), blue, cyan, green, 
magenta, red, yellow, white, and black. 

Background Color
Pick the color of the background for the text from one of eight colors: black, blue, cyan, 
magenta, red, yellow, white, and green. The default is white. Be careful not to make your 
text color and your background color the same.

Background Translucency
In connection with the Chyron PC Codi Card, Codi, MagniCoder Pro, and DV2000, you 
may change the transparency level of the background by sliding the slide bar from 0 to 
255, with 0 being completely transparent, and 255 being solid.

Background Type
Choose the background for the generated captions or subtitles. The options for this setting 
are: normal background, black box, fill row, transparent, and translucent. The default is 
black box for captioning, and transparent for subtitling.

Bold/Flash  
Makes the selected text bold. Bold text can only be used for subtitling. Flashing text can 
only be used for captioning. 

Flashing Captions    If  you are see captions  are flashing and you 
really do not want to have them flashing, make sure the caption text 
is not bold. Bolding makes captions to flash. 

Italic
Makes  the  selected  text  italic.  Italics  are  used  to  indicate  off-screen  speakers  in 
captioning or untranslatable words in subtitling. 
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Underline
Underlines the selected text. 

Position and Justification
The three Justification and Position menu items offer nine options altogether. You can 
select whether you would like text at the left side, center, or right side of the screen; and 
then further select whether, in that position, you would like the caption to Left Justify, 
Center Justify, or Right Justify.

Note: You will not see any change of position or justification of the 
text on the Work Area. Here the formatting will only be shown via the 
listed options in the various position and justification columns. The 
actual  position  and  justification  can  be  viewed  on  the  Preview 
Window.

Horizontal Justification
There are three possible horizontal justifications:
Left
Center
Right

Horizontal Position
In captioning, there are 32 possible horizontal positions. They are numbered 1 through 
32. “1” also means L (left). The menu offers four choices.
Left
Center
Right
Other

To change horizontal position, you have three choices:
Use the mouse to move the caption in the Preview Window. The caption will snap to the 
nearest valid screen position.
Type a number from 1 to 32 in the Horizontal Position column for the appropriate row. 
The computer will not let you enter an invalid number.
Right-click the mouse on the Horizontal Position cell for the appropriate row. Select the 
general position or Other numeric value 1 to 32 for the horizontal position.
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Vertical Position
In captioning, there are 15 possible vertical positions. They are numbered 1-15. 
The menu offers four choices.
Top
Center
Bottom
Other

To change a vertical position, you have three choices:
Use the mouse to move the caption in the Preview Window. The caption will snap to the 
nearest valid screen position.
Type a number from 1 to 15 in the Vertical Position column for the appropriate row. The 
computer will not let you enter an invalid number.
Right-click the mouse on the Vertical Position cell for the appropriate row. Select the 
general position or Other numeric value for the vertical position.

All nine combinations of Horizontal positions and justifications can also be accessed via 
the following three icons on the toolbar. 

       Justification 
The toolbar buttons for left, center and right contain a blue L, a green C, and a red R at 
the top of the button, respectively. See chapter 4 for details.

Insert Music Symbol
Inserts a music symbol (the quarter note) into the caption text. The CaptionMaker shows 
the music symbol in the Preview Window but not in the Work Area. We use the section 
mark (§) to represent the music symbol in the work area. When this character is sent to 
the caption device it  produces the music symbol. You have two choices. Just put one 
music symbol, or add a pair of music symbols at the beginning and at the end of a line. If 
you choose multiple cells and choose this option, it will add a pair of music symbols for 
all the captions being highlighted.

Format Menu
Select Row
Move to a specific row by simply typing the row number in the Select Caption/Subtitle 
Record dialog box. You may also simply click the mouse on a row in the Work Area to 
select it.
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Insert Row(s) 
Adds a new row to the Work Area in the row above the one currently selected. This can 
also be done using the Insert Row(s) button in the Operations Center. Hint: If you need to 
insert a row at the very bottom, click at the end of the last cell and use the Split Row 
command or button to do so.

Delete Row(s) 
Removes the currently selected row in the Work Area.  This can also be done using the 
Delete Row(s) button in the Operations Center.

Split Row(s)
This will split the selected cell into two cells at cursor’s current position. Another way to 
do this is to click on the Split Row(s) button in the Operations Center.

Merge Rows
This will merge all selected cells into a single cell. The same task can be done using the 
Merge Row(s) button in the Operations Center.

Erase Blank Rows
This function will remove all blank rows in the Work Area that do not contain time code 
or text. 

Reformat Rows
Selecting this menu item will open a Reformat Rows dialog box offering reformatting 
options for line-break standards, settings for the number of characters per line and lines 
per  cell.  For  example,  one  might  decide  that  a  file  in  multi-line  format  needs  to  be 
changed to Roll-Up mode; Reformat Rows offers a way to change the file format to one 
line per row. Suppose you have 4 captions as the following. 

1 B C NOW THE ROLL-UP MODE.
2 B C THIS MODE IS NORMALLY

USED FOR TV NEWS PROGRAMS.
3 B C CAPTION LINES ROLL UP

FROM THE SCREEN BOTTOM
4 B C ONE LINE AT A TIME.

.
If you choose this option and the following settings:
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Number of characters per line =26 and 
Lines per cell = 1, then you will get the following:

1 B C NOW THE ROLL-UP MODE.
2 B C THIS MODE IS NORMALLY
3 USED FOR TV NEWS PROGRAMS.
4 B C CAPTION LINES ROLL UP
5 FROM THE SCREEN BOTTOM.
6 B C ONE LINE AT A TIME.

Reformat Caption(s) to Roll-up
If you have a block of captions or the entire file created for Pop-on or Paint-on captions 
with more than one line of text in each cell, you can convert the block or the entire file to 
Roll-up captions containing only one line of text in each cell. This option will maintain 
the existing time codes assigned to  the file  distributing the allocated  time for a  pop-
on/paint-on caption to multiple lines broken up for Roll-up captions. Just highlight the 
block of caption or the entire file and invoke the option. 

Reformat Caption(s) to Pop-on
If you have a block of captions or the entire file created for Roll-up captions, you can 
convert  the  block  or  the  entire  file  to  Pop-on or  Paint-on  captions.  This  option  will 
maintain the existing time codes assigned to the file distributing the allocated time to 
multiple  lines  combined  for  Pop-on or  Paint-on captions.  Just  highlight  the  block  of 
caption or the entire file and invoke the option.

Square Up Text Block
Squares up the text in the currently selected Work Area row, making the lines within a 
row closer to the same length.

Compress Text (C)
Selecting the Compress Text menu item, or clicking on the Compress Text icon in any 
Work Area row, reduces the margins for the current cell. This is one of the commands, 
which can be used to manipulate text into a more readable and stylistically acceptable 
format. For instance, imagine you are starting out with a cell, which appears like this:

I’M AT THE LEFT OF THE 
SCREEN.
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You  can  then  use  the  Compress  Text  command  to  make  text  appear  this  way:

I’M AT THE LEFT OF 
THE SCREEN.

Or keep compressing until the text appears in its most narrow shape:

I’M AT
THE LEFT
OF THE
SCREEN.

One constraint is that you cannot have more than 4 lines per caption block.

Expand Text (E) 
Selecting the Expand Text menu item, or clicking on the Expand Text icon in any desired 
row of the Work Area, increases the margins within a cell and decreases the number of 
lines. It is the reverse of the Compress Text function.  If you begin with a narrow or 
compressed caption, selecting or clicking an Expand Text command will manipulate the 
text into fewer rows that are wider. 

Alternate Break (A) 
Clicking on the  Alternate Break menu item, or clicking on the Alternate Break icon in 
any Work Area row, will toggle between possible line breaks. Sometimes you may have 
to use this command several times to get a caption to square up.

Upper/Lower Case
If you click on this option, the following dialog box opens up
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If  you  check  the  Global  Options box  for  in  the  Upper/Lower  Case dialog  box, 
captions/subtitles will automatically be sent in upper case without actually changing the 
case of text in the Work Area. 
 
On the other hand, you can change the case of the text in the Work Area to one of the 
three options described at the bottom of the dialog box. You may highlight some or all of 
the text in the Work Area and select these options to change the case of the selected text. 
This way captions/subtitles can appear exactly the way they do in the Work Area.

Pull First Word
Selecting the Pull First Word menu item, or clicking on its icon in any row of the Work 
Area, will take the first word from the cell below the selected row and move it to the end 
of the current cell.

Push Last Word 
If you select this menu item or a Push Last Word icon in a specific Work Area row, the 
CaptionMaker will take the last word from the current cell and move it to the beginning 
of the next cell. This is the opposite of the Pull First Word command. Note: If you push 
all the text out of a cell, you will get a blank cell, which must then be deleted using the 
Delete Row(s) command.
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Caption
Depending on the default hardware selected, you will find this menu item either Caption 
or Subtitle,  but  not  both.  Depending on the heading  you will  see some of the menu 
options are not available.

Send Lines
This menu item performs the same function as the keypad plus [+] key, to send the line 
with the cursor to the caption/subtitle device. If the  button is pressed it will also read 
the time cue (from the time code reader or the PC System Timer) and put the time stamp 
under the Start column.

Clear Caption 
This menu item sends one blank caption to the video resulting in clearing any existing 
caption on the video.

AutoSync 

After you have associated a time stamp with each row, AutoSync  will automatically 
output the text on each row, according to the time stamp, to the caption device. This is an 
automatic process driven by the time code or the PC System Timer.

If you have selected a caption device, captions will be sent to the caption device and you 
can record the captioned video onto a blank tape. 

Virtual Encoder If you do not have a device attached to the computer, 
choose “Virtual Encoder” as your device. So CaptionMaker will not 
send any data to the encoder via serial port and you would not get 
any communication errors.

Drop Frame NTSC/PAL     If the time code formats on your work tape 
and master tape are different, you may covert them between NTSC 
and  PAL  and  also  between  drop  frame  and  non-drop  frame.  See 
“Convert Time Code” later in this chapter for details. To convert time 
codes from one  to  another  (PAL  and NTSC or  drop to  non-drop) 
highlight the time codes and use this option to convert them.
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Final  AutoSync  Note  that  the  cursor  is  not  needed  to  be  on  a 
specific place in the text in order to start AutoSync. In fact, if you 
rewind  or  fast-forward  the  VCR  while  AutoSync  is  on,  the 
CaptionMaker will read the time code and pick up AutoSync from any 
place in the file.

AutoPreviewSync 

After  you  have  associated  a  time  stamp  with  each  row,  AutoPreviewSync   will 
automatically  output  the  text  on  each  and  every  row  according  to  the  time  stamp 
associated with each row. This is a totally automatic process driven by the time code or 
the PC System Timer. If you do have the video on the computer screen using the video 
capture card, this step will allow you to check the positioning and the timing of each 
caption without using a captioning device.

After you invoke this option,  you may click on the  Full  Screen View icon   in the 
Operations Control Area to enlarge the screen.

Note   If you are preparing a caption/subtitle file and do not have a 
caption or subtitle device attached to your system, you may check 
the positioning and timing of your file by invoking this option instead 
of using AutoSync.

AutoSync Error Checking
If this  option  Caption > AutoSync Error Checking is checked, CaptionMaker will  go 
through the whole file and make sure there is no missing time codes or the time codes not 
in  ascending  order  before  starting  AutoSync.  It  is  a  good  idea  to  have  this  option 
checked. That way for a long video you do not have to wait for long time until the error is 
caught and AutoSync stops at that point.
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Final Checking 
This will  check for many common errors with the file.  It  is  typically invoked before 
AutoSync. When you invoke this option you will see a dialog box (see chapter 4) where 
you  may  choose  options  related  to  time  code  tolerance,  reading  speed  of  captions, 
maximum  characters  per  line,  unacceptable  characters  for  captioning,  etc.  You  can 
choose any single item or combination of desired items.

Timing Errors Settings
When you caption a video, it is very important that you conform to maximum WMP for 
caption, depending on your audience.  Similarly,  it  is customary not to have a Pop-on 
caption covering a shot change. And finally, if you do not give enough time for a Pop-on 
caption to build-up, the caption would not appear at the desired time you assigned. For 
Pop-on captions, it takes about a second for every 50 characters of text. If the time code 
of previous caption is less than 1 second for a caption of 50 characters, the caption will 
appear little later than the assigned time code. To check all these errors on the fly, you 
can invoke the option under Caption> Timing Error Settings menu. You can check any 
one of the following items and assign different colors for each error in the dialog box See 
Chapter 4).

Preview Options

Display Preview Image
Puts the caption/subtitle in the Preview Window. For DVD, you should click on the Pop-
On Preview Window  button in the Operations Center to see exactly how an image 
will appear. 

Highlight Rows During AutoSync
When checked, the current row in the Work Area being sent to the captioning/subtitling 
device (during both manual and AutoSync operations) is highlighted.

Blinking AutoSync Status
When checked, the CaptionMaker will place a flashing green indicator near the upper 
center of the screen when AutoSync is in operation.

Caution    These  three  functions  need  quite  a  bit  of  computer 
processing time. If you are using a slow computer and notice some 
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delay in the appearance of captions during AutoSync, you may turn 
one or all of these functions off.

Preview Image Matches Line Sent
If this option is checked, the Preview Window and video monitor will show the same text 
when you press the [+] key. Otherwise the text on the video monitor will always lag one 
row behind the selected row on the computer screen. This happens for a logical reason. 

Suppose you are on row 2. The text on the Preview Window and also in the Work Area 
shows row 2. Now suppose you press the [+] key to send the caption/subtitle out to the 
external video monitor. After you press the [+] key, you will see the following:

Row 2 on the Video monitor, but
Row 3 in the Work Area and also
Row 3 in the Preview Window.

Since the cursor is in Row 3, that’s why the Preview Window also shows Row 3. And 
you can drag and drop the text anywhere on the Preview Window.

But to some users it appears confusing. Even though at first it may appear so,  do not  
check this box. See the reason below. 

If  you  work  only  with  the  Preview  Window  (with  video),  you  would  not  have  any  
confusion. There is no need for having an external monitor other than to check the final  
caption/subtitles in AutoSync mode. In that mode, both screens will match.

Caution    If this option is checked, you won’t be able to drag and 
drop the text on the Preview Window. After you press the [+] key, the 
text has already been sent to the video monitor via a caption/subtitle 
device. It cannot be repositioned. 

Live Caption
This feature will allow you caption a non-scripted, live presentation, by entering dialog as 
it is spoken in the Roll-Up mode. If you check this option and set the caption to Roll-Up 
mode, you are ready to caption a live show in real time. You can caption a live show in 
one of the following ways.

1. Realtime Captioning software using a steno machine (for best results).
2. Budget realtime captioning using speed-typing software to enhance typing speed.
3. Budget realtime captioning using speech recognition software. 
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If  you  try  to  enter  text  into  a  computer  keyboard  as  fast  as  possible,  you  have  to 
summarize what is being said to keep up with the speaker. The result is the poorest of all 
these methods. See Chapter 7 for suggestions on how to caption live events.

Live Caption Properties 

Roll-Up Mode
You may choose 2 to 4 lines of Roll-Up mode from this option.

Vertical Position: Top Caption
If this option is checked, the captions will appear at the top of the screen.

Vertical Position: Bottom Caption
If this option is checked, the captions will appear at the bottom of the screen.

Caption Length
Maximum number of characters  allowed per line is 32. You may choose any caption 
length from 12 to 32 from this option.

Left Indentation 
This option allows you to set the left margin. Sometimes you may need to access this 
option quickly on the fly. There is an icon on the Realtime toolbar to activate this option. 
You may also assign a keystroke from the Tools menu to access this option either from 
the keyboard or from the steno machine. 

Fast Indent
This option allows you to set the left margin to preset values. The default keystrokes for 
preset  left  margins are as follows. Of course,  you can change the keystrokes  to your 
desired keys using Customize Keystrokes under the Tools menu.

Keystroke    Left Indent
Ctrl+0 0
Ctrl+1 4
Ctrl+2 8
Ctrl+3 12
Ctrl+4 16
Ctrl+5 20
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Roll Up 1 Line 
This menu item sends one blank caption line to the video,  resulting in rolling up the 
existing caption on the video by one line. If you are using Roll-Up captions, this option 
can also be used to clear captions on the video by invoking it several times to roll up 
existing captions of more than one line.

Send Options…
You can choose whether to send the words to the encoder as soon as it is entered or have 
a delay of few words.

You can also choose a couple of time-out options to flush the last word and close the 
encoder device. For details, check the chapter 7: Live Captioning.

WebTV Crossover Link 
A TV Crossover Link allows a viewer watching television programs using a WebTV box 
to click on an i icon on their television screen and immediately be linked to a Web site 
associated with the content of the program they are watching. See details in Chapter 6.

V-Chip Ratings 
The broadcaster or program producer can use the CaptionMaker software to insert V-
Chip ratings onto line 21 of the video using a closed caption encoder. 

When a home viewer watches a program with V-Chip information, their TV’s V-Chip 
reads the broadcasted V-Chip rating information and either displays the program (with 
the rating visible) or blocks out the program if the rating exceeds the home television’s 
customized settings. This way parents can block programs that are not suitable for their 
children. See details in Chapter 6.

Wink Trigger 
Wink is a free, easy-to-use service that allows you to interact with the television shows 
and advertisements.

When an  icon appears on your screen, you know that the program you're watching has 
been enhanced with Wink. Simply press a button on your remote control and you can 
reply to free offers, buy products, get sports scores and updated weather, participate in 
games, and more while continuing to watch the program. See details in Chapter 6.
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Profiles
For  live  captioning,  it  option  is  very  helpful.  You  might  set  up  your  choices  for 
captioning parameters for one job different from other. You can easily change the setup 
by choosing a particular profile. If there are a number of users who use this software with 
a number of different parameters or you use the software for different vendors, you can 
save different profiles under different names. When you chose a particular profile, the 
software will bring up the choices under that profile. 

Device 
The  CaptionMaker supports a variety of captioning and subtitling devices.  When you 
click  on  this  item,  a  dialog  box  will  appear.  First  choose  your  device  (e.g.,  Smart 
Encoder, Link Encoders, etc.).

Then you choose the Configuration and the Caption Properties. For basic functions, the 
default settings are fine. You may need to consult the hardware device manual.  Also 
check Chapter 2 for more information.

Captioning Video On-Site
If you are captioning a video on-site, You choose Connect Via RS232 serial port from the 
configuration menu below.

Captioning Video from Remote Location
If you are captioning a video generated at a remote location, you need to connect your 
computer  to  the  encoder  located  at  the  remote  location  via  a  telephone  line  using  a 
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modem attached to your computer. The encoder must have a built-in modem or a modem 
attached to it. Choose Connect via Modem using… Then select the modem from the list 
box.

Device Settings (Configuration)

Captioning Via LAN
If you use Norpak’s TES3 or TES5 encoder with LAN connections, you may choose 
Connect Via Local Area network (LAN)

If you are using an external modem, you should see the name of the external modem 
appearing in the Modem Settings windows. You must have the external modem

Powered on.
Connected to the computer via a serial cable. 
Must have been recognized by Windows when you power the computer on.
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Whether you have an internal modem built into your computer or an external modem 
attached to the computer, the process of choosing the modem is the same. You need to 
select both the caption device (encoder) and the modem.

First choose the caption device (encoder) as described above. 
Then click on the Connect button inside the Caption Device dialog box. 
Check the box Connect via modem using inside the Caption Device Settings 
dialog box below and select your modem. 

Caption Properties

Control Tab
Over the years, decoders have evolved through three different sets of standards:

1. TeleCap I   TeleCap I decoders were produced by the National Captioning 
Institute (NCI) during the period 1980 to 1983. These decoders cannot recognize:

(a) Paint-on mode,
(b) Centering, and
(c) Captions without blinking between them.

2. TeleCap II   TeleCap II decoders were manufactured by NCI during the period 
1984 to 1994. These decoders cannot handle:

(a) Captioning near the center of the screen,
(b) Color captioning, and 
(c) Field 2 and EDS captioning.

3. EIA 608   This is the current standard (as of 1999), which was formulated by 
the Electronics Industries Association (EIA) in 1994 and does not have any of the 
above limitations. New television sets with built-in decoders follow this standard.

 
When you  select  a  particular  value  for  compatibility,  the  program will  not  send any 
characters  or  attributes  that  are  not  allowed  by  that  compatibility,  as  incompatible 
characters can cause a TeleCap I or TeleCap II to display garbage characters. But this 
does not remove the characters in your Work Area. 

Channel/Field
With older,  external  TeleCap  I  and II  decoders,  there  are  only 2 caption  and 2 text 
channels  available,  but  technical  reasons  precluded  the  use of  the  second channel  in 
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practice. With the new EIA 608 standard, it is possible to put two sets of captions on one 
video.

Currently, if you want to caption a video in Spanish and in English, you must be using 
encoder equipment that is capable of changing Lines and Channels. You need only create 
one file, but you must run the AutoSync process twice, once for each language, due to 
speed limitations of the encoder.
Duplicate control codes: Normally leave this choice unchecked. There is no need to send 
the control codes twice. 

General Tab
Display Type: Chooses which mode (Pop-On, Paint-On, Roll-Up or Block Roll-Up) will 
be used for all subsequently created rows in the Work Area. This does not go back and 
reformat choices you have already made. If you want to reformat a block of captions, 
select the rows and then right-click on the Display column. For detail see section 
Attribute > Display Mode option. 
Blanking Frames: Set the blanking frame between two subtitles. The default is 2 frames.
Uppercase Option: Allows you to send all characters to the caption device as uppercase.

Color Tab
With this option you choose the default foreground and background colors for captioning. 
You can choose if the background is to be opaque (black background), translucent (lets 
you see some video through) or transparent (lets you see the video through). You have 
the  flexibility  to  change  these  defaults  on  row by  row,  using  the  options  under  the 
Attribute menu. Note: Not all caption decoders have color capability.

Initialize Device 
Initializes the device. In case you power off or change the caption/subtitle device in the 
middle of a session, you can click on the device to ensure proper initialization of the 
device. 

Close Device
This operation closes the caption/subtitle device. If your device is a CC encoder, it will 
free up the encoder. If a video with pre-recorder captions pass through the encoder, when 
the device is closed, the captions will pass through. This might be very helpful when you 
are captioning a live broadcast and the TV station airs some commercials with existing 
captions. If the device is not closed, the existing captions from the video will be stripped 
off. 
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Set Caption Margins
Default  caption  margins  are  all  zero.  With  this  setting,  you  have  a  maximum of  32 
characters in a row and 15 possible rows. Unless you are quite advanced in captioning, it 
is better to leave all the margins as zero. If you make margins other than zero, you will 
limit the number of rows and maximum allowable characters per row.

Retrieve Captions
Retrieve Captions allows you to retrieve captions, along with time code and positioning 
information, from a previously captioned video, and store them in a file. 

The  Retrieve  Captions  command  has  been  implemented  for  the  HubCap  and  Link 
Encoder.  This  option  is  available  under  Caption → Retrieve  Captions menu.  After 
retrieving the captions, you may use the file for the following purposes:
To generate a DVD caption file.
To generate a DVD subtitle file.
To reinsert captions onto time-compressed video.
To reinsert captions to a new, edited version of a previously captioned video. Of course, 
you need to edit the caption file to match the newly edited video.

Before retrieving captions, make sure to turn the AutoSave option off. Or first save the 
blank screen to a file name before retrieving captions. Otherwise you will be asked to 
save the file every few minutes during the retrieval process.

If you chose to retrieve time codes also, connect the time code to the time code device.

After retrieving caption data, run a final check to check the integrity of the data before 
you use the file for any other purpose.

Dial Modem
If you are captioning from a remote location, you need to connect your modem to the 
encoder via a telephone line. Connect a telephone line to the modem and click on this 
option. You will see the following screen:
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Type the telephone number including area code. Click on Dial to connect your modem to 
the remote Encoder. 

Hang up Modem
When you like to hang up the phone line, click on this option.

Subtitle

Check Caption Menu for more details Since captioning and subtitling 
devices are used in a similar fashion, most Subtitle menu items are 
the  same  as  those  under  the  Caption  menu.  Check  the  previous 
section for details of duplicate items. Menu items with instructions 
specific to subtitling are listed in this section.
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Send Lines
This menu item performs the same function as the keypad plus [+] key, to send the line 
with the cursor to the subtitle device. If the  button is pressed it will also read the time 
cue (from the time code reader or the PC System Timer) and put the time stamp under the 
Start column.

Clear Subtitle 
This menu item sends one blank subtitle to the video resulting in clearing any existing 
subtitle on the video.

AutoSync 

After you have associated a time stamp with each row, AutoSync will automatically 
output the text on each and every row according to the time stamp to the subtitle device. 
This is an automatic process driven by the time code or the PC System Timer.

If you have selected a subtitle device, subtitles will be sent to the subtitle device and you 
can record the subtitled video on to a blank tape. See “AutoSync” in the Caption Menu 
section above for more information.

AutoPreviewSync 

After  you  have  associated  a  time  stamp  with  each  row,  AutoPreviewSync   will 
automatically output the text in each and every row according to the time stamp. This is 
an automatic process driven by the time code or the PC System Timer. If you do have the 
video on the computer screen using video capture card, this step will allow you to check 
the positioning and the timing of each subtitle without using a subtitling device.

After you invoke this option,  you may click on the  Full  Screen View icon   in the 
Operations Control Area to enlarge the screen.

See “AutoPreviewSync” in the Caption Menu section above for more information.
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AutoSync Properties

Display Preview Image
Puts the subtitle in the Preview Window. For DVD, you should click on the Pop-On 
Preview Window  button in the Operations Center to see exactly how an image will 
appear. 

Highlight Rows During AutoSync
When checked, the current  row in the Work Area being sent to the subtitling device 
(during both manual and AutoSync operations) is highlighted.

Blinking AutoSync Status
When checked, the CaptionMaker will place a flashing green indicator near the upper 
center of the screen when AutoSync is in operation.

Caution    The above three functions use quite a bit  of computer 
processing power. If you are using a slow computer and notice delay 
in the appearance of subtitles during the AutoSync process, you may 
turn off one or all of these functions.

Final Checking 
This will  check for many common errors with the file.  It  is  typically invoked before 
AutoSync. When you invoke this option you will see a dialog box where you may choose 
options related to time code tolerance, speed of subtitles, length of subtitles, etc. For more 
details  see  the  information  on final  checking  in  the captioning  section  earlier  in  this 
chapter.

Device
CaptionMaker supports a variety of captioning and subtitling devices. When you click on 
this item, a dialog box will appear.  First you choose your device (e.g.,  Chyron Codi, 
MagniCoder Pro, or Sonic Solutions).

Then choose the configuration and the subtitle properties. For basic functions, the default 
settings are fine.  You may need to consult  the hardware device manual.   Also check 
Chapter 2 for more information.
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Initialize Device 
Initializes the device. In case you power off or change the subtitle in the middle of a 
session, you can click on the device to ensure proper initialization of the device. 

Subtitle Properties

General Tab
Display Type: Set the default display type (for subtitles this is typically Pop-On).
Blanking Frames: Set the blanking frame between two subtitles. The default is 2 frames.
Uppercase Option: Allows you to send all characters to the subtitle device as uppercase

If you choose Chyron Codi or PC-Codi as a device, you will also see the following tabs 
under the Properties dialog box.

Control Tab
Mode: Selects between NTSC and PAL video standards. NTSC is the U.S. standard.
Alignment: Shifts the subtitles horizontally. If the subtitles which is supposed to appear 
centered on the screen 

Fonts Tab
These are fonts for the Subtitle Devices. If you are subtitling with a DVD Authoring 
System, such as the DVD-2000 or a ChromaKey System, such as the MagniCoder Pro, 
you will not need to use this tab. 

This  tab  associates  up  to  8  Codi  fonts  to  be  downloaded  into  your  Codi  character 
generator. When you click the Upload Fonts button, the computer will only upload the 
fonts to the Codi that have changed since you last downloaded fonts. (it can look at the 
Codi and see the names of fonts currently in the Codi’s memory.)  The computer will 
remember your Codi font associations and preferred directories whenever you run the 
CaptionMaker program.

Colors Tab
There are 7 subtitle default colors, and a color picker that allows you to mix red, green 
and blue to choose from over 16 million colors. The computer will remember the default 
colors from session to session.



Chapter 8: Menus 223

Set Codi Font
If you are using a Chyron Codi as your subtitling device, you can set the default fonts 
using this option. See details in Chapter 5 on subtitling.

Time Code
Start Time Code Reader 
Will start displaying timing information from the time code reader, video playback or the 
PC System Timer. 

Pause Time Code Reader
Pauses displayed timing information from the time code reader, video payback or the PC 
System Timer. 

Time Code/Video Mode
You should set the Time code/Video mode to one of the two options:

NTSC (30 frames/sec) – US Standard
PAL/SECAM  (25 frames/sec)

It is extremely important to make the right choice for the video and the caption/subtitle 
hardware you use. 

Mark In Time Code
When time code or PC System Timer is running, you can read the timing information by 
pressing the [F4] key or by invoking this option. Unlike the Send Line function (or the 
[+] key) this function does not send the text to the caption/subtitle device. This function 
should be used only when you are interested in reading the timing information.

Auto Advance on Mark In 
This function should be checked normally.   The only reason to uncheck this function 
would be if you wanted to assign a time code to an individual row without the software 
automatically moving the cursor to the next row, so that you may get the time code a 
number of times in order to make sure it is precise.
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System Timer Start Time
If you are using the PC System Timer, it will let you choose the start time (the default is 
00:00:00:00). This option is very useful to test-AutoSync a video when time code is not 
available and you can simulate time code using the PC System Timer.

Set System Timer to Start Time
This option resets the PC System Timer to the same time as the time stamp on the current 
row. This option is extremely important to time-stamp a video with the PC System Timer. 
After resetting the PC System Timer, the action of pressing the [+] key to read time code 
or invoking AutoSync, makes the PC System Timer start running at that instant. See the 
section on timecoding with PC system timer in chapter 4 .

Blank Frames
When a new caption/subtitle replaces the previous one in Pop-On subtitling, a blink-like 
action takes places. There is a short interval where no caption or subtitle is on the screen. 
The standard interval that is commonly used is 2 to 6 frames. The default value is 2.

Tips: To access most of the functions under the time code menu, you may 
right click on any cell under the Header Start column. A pop up menu will 
come up. Some of the options like rippling time code require you highlight 
a number of cells before you invoke these options.

Ripple Time Code 
This feature will  change the time code within the currently selected block, or from a 
selected row to the end of a file. There are two uses of this function:

Adjusting time cue to rectify human reaction time during manual time stamping (see Step 
4b in Chapter 4)
Fixing the difference between the time codes on your work tape and the actual master 
tape that you will be using to AutoSync the video to produce the final captioned or 
subtitled copy. 

If you have a VHS work tape without time code, you should lay down time code on the 
tape by using a time code generator. You should consult the manual that came with your 
time code generator to see how this is done. It is very improbable that the time code on 
the work tape will match the time code on the master. 



Chapter 8: Menus 225

Suppose the time code of the first caption/subtitle on the work tape is 00:01:08:21 and the 
time code on the master tape is 01:03:24:04. Click on the Start header to highlight all the 
time codes. Right-click on any highlighted cell. A dialog box will pop up. 

Enter the master time code 01:00:02:17 and click OK. You will notice that the time code 
of each and every row will change by adding the difference of the two time codes. These 
new time codes will look like as if you had used the master tape to get all the time codes

Convert Time Code 
This is an advanced feature. You will need to use this option only when the time code 
formats  on your  work tape and master  tape  are  different.  This  feature  allows you to 
change  time  codes  between  NTSC,  PAL/SECAM and  FILM and  also  between  drop 
frame and non-drop frame. You have the following choices. 

NTSC Drop frame  (29.97 fps)
NTSC Non-drop frame (30 fps) 
PAL/SECAM (25 fps)
FILM (24 fps)

For your information:
The CaptionMaker software treats PC System timer as drop frame
NTSC time code can be either drop frame or non drop frame
PAL time code for all practical purposes is non-drop frame
Drop frame time codes usually have a semicolon marker in between seconds and frames 
(e.g., 01:30:25;22). On the other hand drop frame time code is displayed as 01:30:25:22

If you have a one hour video tape starting at 00:00:00:00 time code, the last time code on 
the video after you run the tape for one hour according to the time on the wall clock will 
be as follows:
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01:00:00:00 for drop frame time code 
00:59:56:12 for non-drop frame time code

To  convert  time  codes  from  one  to  another  (PAL and  NTSC  or  drop  to  non-drop) 
highlight the time codes you would like to convert and use this option to convert them.

Stretch/Shrink Time Code
This option might be very useful when you work with a digital video or a tape (work 
copy) and do all the timecoding and then need to match the time coded file with another 
copy of the video (master copy), which may have a slightly different code at the end of 
the video. One reason it could happen is due to drop frame/no drop frame issue. To match 
the time code of the caption file with the video, make sure the first time code of the 
caption file matches with the master copy. Then choose this option and enter the last time 
code from the mater copy. This option will stretch or shrink all the time codes in the 
caption file to match the master copy. 

In  most  situations,  you  should  have  the  box  for  “Master  time  code  is  drop  frame” 
checked.

Reading Speed
If you are subtitling videos for young children, you must keep in mind that they do not 
read as fast as older children or adults. Also, persons reading captions or subtitles in a 
non-native  language  may  not  be  capable  of  reading  rapidly.  This  option  has  two 
functions:

To check the average reading speed for a block of highlighted rows. You need to assign 
time codes for all the highlighted rows. This option does not change the actual time 
codes.
To assign the desired reading speed to a block of highlighted rows. You need to assign 
time code for only the first row of the block. In this case the reading speed of each and 
every row is going to be exactly the reading speed you assigned. This option does change 
the actual time codes.

Depending on your choice, highlight a number of rows and right-click on any highlighted 
time code cell to choose this option. A dialog box will open.
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You may just check the average reading speed or you may enter a specific reading speed 
and click OK. 

Fill-In Time Code
This feature will assign a time code to selected rows if a time code is set for the first and 
last line of the selected rows. This can be used when a person is speaking for a long 
period of time (a lecture or speech) at a fairly steady rate. This feature can save time 
when subtitling a video, since it does not require you to enter a time code for each row. 
Select a segment of the video needing time codes. Then do the following:

1. Assign a time code to the first row of text needing time code to be filled in.
2. Find the last line of the segment and assign the time code to it.
3. Highlight the block of text.
4. Then choose the Fill-In Time code option from the menu bar or by right-

clicking on any of the highlighted cells. A dialog box will open.

The CaptionMaker will  fill  in the time codes and give you an average WPM reading 
speed for the block of text. 

Note two important issues.
1. If you have time codes assigned to some key points on the video where the time 

codes must be your assigned values and like to fill-in all time codes in between 
the assigned time codes, you should choose the second radio button.

2. You would also like to check the box: Force a Minimum Cell Duration of to 20 
to 30 frames or so, so captions with a single or a few words, would not end up 
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with a duration of less than 20 frames or so to accommodate the same WMP for 
all captions.

Time Code Reader Properties

Reader Tab
This dialog box is used to choose one of the several time code readers or the PC System 
Timer. You can also change the display rate of the time code. Using a reasonably fast 
computer, the display rate should probably be left at the default value of Fast Update.

Color Tab
Changes the color of the time code display on the screen, but has no effect on any aspect 
of the appearance of the final captioned or subtitled video.
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VTR Control 
With this option you can control a VTR using  Sony BVU-800 protocol machines and 
Panasonic AG5700 series devices.  For Sony BVU compatible machines, you would need 
a special  RS-232 to RS422 converter  cable.  It is available  from CPC at a reasonable 
price.

If you are using a digital video, obviously you do not need any interface.

All options available in the menu under the VTR Control at the top of the screen are also 
available via the VTR Control icons on the top right side of the screen. Each option is 
self-explanatory. 

Make sure you choose the proper baud rate and other parameters under the VTR Control  
→ Properties → Configure menu. If you do not get the desired result, you may change 
the delay values under the VTR Control → Properties menu.

Play
Plays the VTR.

Stop
Stops the VTR.

Pause
Pauses the VTR. 

Rewind
Moves the VTR backward, rapidly.

Fast Forward
Moves the VTR forward, rapidly.

Variable Fast Forward/Rewind
There are a number of options to rewind and fast-forward the video at variable steps. You 
can assign the keyboard to access these functions too. To assign keyboard, go to Tools > 
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Customize Keystrokes. If you like to assign the keys from the keypad, you must have 
NumLock On.

Properties
Sets the interface information for the VTR control.  Also sets the speeds at which the 
controls will function.

DV Menu

Encode Captions/Subtitles
You can encode closed captions and burn subtitles to a DV (.mov and .avi) video. 

• DV (720x480) MOV
• DV (720x480) AVI

Retrieve Captions
You can retrieve captions from any one of the following videos as long as the video 
contains closed captions
.

• DV (720x480) MOV
• DV (720x480) AVI

Print DV Video to Tape
You can transfer a captioned DV video via Firewire to a MiniDV, DVCAM or DVCPRO 
tape. You can also dump a captioned DV video to an analog tape such as VHS or BetaSP 
using a digital to analog converter such as Sony DVMC-DA1 and DA2 or a captioned 
compatible DV deck, which retains caption. 

Capture DV Video
You can capture a DV video (720x480) via firewire. This function allows you to receive 
a DV video via fire wire (IEEE 1394) and create a DV AVI file. Video may be captured 
from Firewire devices such as the Sony DVMC-DA1/DA2 or a camcorder or a DV deck.
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NLE Menu

Encode Captions/Subtitles
• 720x486 MOV
• 720x486 AVI
• Mpeg2 (720x480) video

You can export a blank video (720x486) file with encoded closed captions to be merged 
to the original video using an NLE system. 

You can also export a blank video (720x486) with subtitles, which can be merged to the 
original video using an NLE system.

Retrieve Captions
You can retrieve captions from any one of the following videos as long as the video 
contains closed captions.

• Mpeg2 (720x480) video (for DVD)

HD Menu

Encode Captions/Subtitles
CaptionMaker-HD Enterprise can currently encode closed captions for the following 
MPEG formats:

• DVD Closed Captions (*.m2v)
• DVD Style Closed Captions (*.mpg)
• ATSC DTV 608 Closed Captions (*.mpg)
• CCube/LSI DVx 608 Linear Closed Captions (*.mpg)
• CCube/LSI DVx 608 Temporal Closed Captions (*.mpg)
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Tools 
Spelling
Activates CaptionMaker’s built-in spell check starting from the cursor point. Also it can 
check  highlighted  rows  of  text.  It  can  check  spelling  in  English,  Spanish,  French, 
German, and Portuguese. When the spell check finds words it does not recognize, it will 
display a dialog box with the following fields. (To escape from the Spell check function 
just press the Esc key.) 

Not in Dictionary
This is a word that the spellchecker cannot find in its dictionary, or in any supplemental 
dictionary supplied by the user. If you wish, you can change the contents of this field by 
moving the mouse to the field and clicking on it. This offers an opportunity to correct a 
misspelled word or typo. Or you can type in variations of a word you don’t know how to 
spell, which will change the list of words that the computer suggests.

Change 
This option will change the spelling of the word in your text when you click the Change 
button on the right side of the screen. You can also click on this field and enter the text of 
a word you would like to use instead of the misspelled word.

Language
The CaptionMaker can check the spelling in 5 different languages; this list box allows 
you to choose among them. They are English, Spanish, French, German and Portuguese.

Suggestions
The computer lists words that are guesses for what you intended to write. If you click on 
a word twice, it will be inserted into the text and the spellchecker will continue.

You can also add words to the spelling dictionary by clicking the Add button if the word 
is spelled properly, but is not in the dictionary. When you add a word to the dictionary 
the spelling checker creates a simple text file. The format for the name of the dictionary 
is  USRDICXX.TLX,  where  XX  is  the  language  (FR  for  French,  AM  for  English 
(American), GE for German, PB for Portuguese (Brazilian), and SP for Spanish). The 
user  spelling  dictionaries  are  stored  in  C:\WINDOWS\SYSTEM folder.  They  are  not 
created until you add something to the user dictionary. 

If  you  accidentally  add  a  misspelled  word  to  the  dictionary,  you  can  open  the  user 
dictionary file in the notepad (though they have an extension of *.tlx, and they can be 
edited with Notepad or Wordpad if you click on the file and tell the computer to associate 
Notepad with the *.tlx extension). Now you can delete the entire line containing the word 
and the computer will recognize the word as incorrectly spelled in the future. 
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Tip  If you uninstall CaptionMaker software you will loose any new 
dictionary entries. Before uninstalling the software, you may copy 
the files ssceam.tlx and ssceam2.clx (for English dictionary) from C:\
ProgramFiles\CPC\CaptionMaker to a different folder. If you reinstall 
the CaptionMaker software again, you may copy these two files back 
to the same folder. For other languages there are corresponding files 
ending with the two character abbreviation of the language (e.g., sp: 
Spanish, etc.)

Automatic Match Text with Audio 
CaptionMaker software can now automatically break and accurately time closed captions 
at the click of button. There is a service fee for this function. This automates the labor-
intensive job of having a captioner listen to the audio, manually break the text into 
captions, and then synchronize the captions with the dialogue.

With CaptionSync automated captioning software from Automatic Sync Technologies, 
the captioner connects to the internet and uploads the script and the corresponding audio 
file to a file server. Within minutes, a time stamped script file can be downloaded on the 
computer.

This  service  starts  at  $65 per  one  hour  file.  You can  buy this  service  by contacting 
Automatic  Sync Technologies directly at  510-582-3437 or  kevin@automaticsync.com  .   
For more info please check www.automaticsync.com

To automatically synchronize caption dialog with the audio portion of a video choose 
Auto Match Text with Audio from the CaptionMaker Special Pull Down menu. You will 
be presented with a window that controls the uploading of your caption dialog and an 
audio file of that dialog to a remote host for processing. This window also controls the 
downloading the synchronized text file. 

To upload files for automatic synchronization you must prepare a dialog file and an audio 
MP3 file. The text file should be a plain text file that ends with the “.txt” suffix. The text 
file should consist of the entire spoken dialog in the video that is being synchronized. 
The audio file needs to be an MP3 audio file that is 16 bit 44.1 KHz and 32 Kbps. 

Find Shot Changes

http://www.automaticsync.com/
mailto:sales@cpcweb.com
mailto:sales@cpcweb.com
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You can find the shot changes in any video (wmv, avi, mov, mpeg, m2v etc.). It is a good 
idea not to have a shot change inside the duration of any caption in Pop-on mode.

After you open caption file with the appropriate video file, to find the shot changes, click 
on Tool > Find Shot Changes.

It will take a while depending on the length of the video to find the locations of all the 
shot changes. When you save the caption file, the shot change information will be saved 
in the .cap file. So when you open the .cap file again later, you do not need to find shot 
changes again.
 
After finding the shot changes, when you play the video, the next shot change indicator 
appears right below the Time code display in HH:MM:SS:FF format. Next shot change 
display color becomes RED when it is less than 10 seconds from the next shot change.

You can also click the two buttons ( ) next to the time code display area to move 
to the previous and next shot change locations.

Customize Key Strokes
Most of the menu items and commands can also be accessed via keyboard. We encourage 
you to customize the keyboard to your choice. CPC has some default keyboard settings, 
but those may not be your choice. You can use the software much more effectively with a 
proper combination of mouse use and keyboard shortcuts. 

When you invoke this function, the following dialog box will appear. 
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Suppose you would like to assign the keystroke to move up a caption by one line. Slide 
the scroll bar down and double-click on the Vertical Position – Move Up 1 Line. The next 
dialog box will open up.

Keypad  Keys   To  assign any key on the keypad,  you  must  have 
NumLock On.

Suppose you  would like  to  use  Ctrl and [ArrowUp] key combination  to  invoke this 
option. Simply press the Ctrl and [ArrowUp] keys together and it will show on the screen 
as Ctrl+Up. From now on you may use Ctrl+Up to invoke this option until you change it.



236 CaptionMaker for Windows

Tip    If you are running CaptionMaker on more than one computer 
and you like to copy the Customize Keystrokes from one computer 
to another, you need to copy the file CapKeyMap.dat from the folder 
C:\ProgramFiles\CPC\CaptionMaker from your computer to the same 
folder in the other computer. 

Help

Help Topics
Calls up this help system, which is “context sensitive”. If you are in a dialog box and 
press [F1], the appropriate topic will appear in the help window.

About CaptionMaker 
Displays the Copyright notice and contact information for CPC. 

Version Information 
You can check the version information which list all the release information with new 
functions and bug fixes.

Upgrade License
You can upgrade your CPC software from any level to a higher level (i.e., CaptionMaker-
Classic to CaptionMaker-NLE) over the internet. You do not need to send the USB or the 
parallel hardware key via mail to be replaced. We will upgrade the key via internet. 

Check Chapter 2: Software Installation for more details.
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C h a p t e r  9
I c o n s  an d  B u t t o n s

Main Toolbar Buttons
These include standard and format buttons, including Open, Save, Print,  Spell Check, 
Undo,  Redo,  Cut,  Copy,  Paste,  Left,  Center,  Right,  Bold,  Italic,  Underline,  and Font 
Color. Additional icon pertinent to captioning and subtitling are the following: 

 Full Screen Spreadsheet
This button is used to switch between two screens, one with video, one without video. In 
one view you will see the video (or blue) screen on the top left corner, in the other view 
you will see the spreadsheet full-screen, giving more area to work on.

 AutoSync
This button is used to AutoSync captions or subtitles with the video passing through an 
external encoder or character generator device. 

 AutoPreviewSync
This button is used to AutoSync  captions or subtitles  with the video on the computer 
screen. This is a great option to use when you are working with time code but do not have 
an external closed caption encoder or subtitling device with which to view the caption or 
subtitles as they AutoSync. If you are creating DVD, DV-2000 or Webcasting files, you 
must use this option as a final step. 
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 Final Checking
This button is used to check the integrity of the file – ascending order of time code, 
illegal  caption characters,  etc. It  catches most  errors. Use it  as the final  step prior to 
recording captions or subtitles on tape.

 Customize Key Strokes 
This options allows you to assign different strokes for most of the options available via 
menu and mouse clicks. See Chapter 8: Menus for details.

Ancillary Toolbar Buttons
This toolbar contains all other icons that are not in the Main Toolbar and VTR Toolbar. 
When  you  use  the  Full  Screen  Spreadsheet  view  and  do  not  see  the  icons  in  the 
Operations  Center,  you  must  display  this  toolbar.  It  also  contains  additional  icons 
pertinent to caption positioning and live captioning.  The commands for the following 
icons also reside in the Live Caption Options under the Caption Menu.

 Live Caption
Click on this icon to go to Live Caption mode. If the button is depressed, Live Caption 
mode is in effect.

 Roll-Up 1 Blank Line
To insert a blank line to the caption, you may invoke this function. This function can be 
used repeatedly 2 or 3 times to clear the existing 2 or 3 line captions on the screen.

 Indentation
You may also choose the desired amount of indentation (i.e., the left margin).

If you would like to change the indentation on the fly, you may also do so by invoking 
any one of the 6 preset Fast Indentation positions. There is no icon for this option. This 
option is available under Live Caption Options under the Caption Menu.
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 Vertical Position - Top
You may caption at the top or the bottom of the screen. If this icon is depressed, the 
caption/subtitle default position is set to the top of the screen.

 Vertical Position - Bottom
You may caption at the top or the bottom of the screen. If this icon is depressed, the 
caption/subtitle default position is set to the bottom of the screen.

 Move Up 1 Line
Just as you can move a caption/subtitle by dragging it with a mouse, you may also do the 
same by clicking on this icon one line at a time from the bottom of the screen to the top. 

 Move Down 1 Line
Just as you can move a caption/subtitle by dragging it with a mouse, you may also do the 
same by clicking on this icon one line at a time from the top of the screen to the bottom. 

VTR Toolbar Buttons
These buttons are used to control VTRs. These buttons are used to play, pause, rewind, 
and fast forward at different speeds. If you use the buttons a couple of times, the 
meanings of the buttons will be clear. See “Chapter 8: Menus” for details.

Operations Center Buttons
There are two views of the Operations Center buttons located at the top right corner of 
the screen.
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VTR Controls view Miscellaneous Controls view

If you are not using  VTR controls,  you may choose the  Miscellaneous Control view, 
which shows some of the additional position control buttons among others not available 
in the Main Toolbar.

    Image Font Button
This button is used to select the Windows TrueType font used for subtitling. The font you 
choose  with  proper  kerning,  scaling  and  spacing  is  exactly  what  will  be  used  for 
subtitling with MagniCoder Pro, DVD and DV2000. Regarding subtitling with the Codi, 
this font is used just for visual purposes on the computer screen. The size of the font used 
here must be similar to the size of the font used inside the Codi.

Image Font Button General
This  allows  you  to  select  any  Windows  TrueType® font  and  modify  it  for  use  in 
subtitling. You can add a border around the edge of any font’s characters. The default is 
one pixel of border.

Character Kerning
Character kerning is used to alter the amount of space between characters on the same 
line.  Decrease the amount  of kerning to bring characters  closer together;  increase the 
amount of kerning to pull them apart. You will often want negative kerning to bring the 
Windows characters together to create compact subtitles.

Character Scaling
This option allows you to increase or decrease the size of characters. Because TrueType 
fonts  are  mathematical  representations,  it  is  seldom a  good  idea  to  use  this  kind  of 
scaling; instead, change the point size of the font.

Line Pixel Spacing
This option controls the space between two lines of subtitles.
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Space (Blank) Character Width
This allows you to increase or decrease the size of the space between two words created 
by the spacebar. 

Note: You can enter a positive or negative numbers to the last four 
items. There are default values associated for each of these items. 
Positive  and  negative  values  simply  increase  or  decrease  those 
values.

    Image Colors

Video Preview Background
This option is accessible under the Video Control button. Using the color picker, you can 
choose the Video Preview Background.

Background Type 
Found under the Image Colors button, this allows you to pick a background for captions 
and subtitles and to select the level of translucency, if applicable. 

Default Caption/Subtitle Color
Found under the Image Colors button, this allows you to pick colors for the attribute, 
border, foreground (text), and background.

    Margins/Padding
Permits the adjustment of left, right, top and bottom subtitle margins, and pads for them.

    Pop-Up Preview Window
For captioning, this screen is same size as the Preview Window screen. For subtitling, 
this Pop-Up screen is almost full size.

In the Full Screen Spreadsheet view, if you need to see the video, you may invoke this 
option.
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If  you  are  subtitling  with Windows fonts (either  using a ChromaKey device  such as 
MagniCoder Pro or creating files for DVD or DV2000), it is important to see how your 
fonts will look at the appropriate resolution and size. This button will display a full-size 
image on your screen.

    Video Control
You must  have  a  video  capture  device  (such  as  an  ATI  card  or  Pinnacle  DVC-80) 
installed in the computer to invoke this option. This button  brings up a dialog box to 
configure the video on the Preview Window. You must  check the box to  enable  the 
video, and also check the box to render text. 

Click on the Source button and make sure the video source (Composite or Component) 
you feed into the device is right.

Edit/AutoSync/AutoPreviewSync/Live Mode
This is a display area that shows when AutoSync,  AutoPreviewSync or Live Mode is 
active. If none of these modes is active, it shows Edit.

Row Operations Buttons
    Insert Row(s)

Inserts a row above the current row. If you have selected multiple rows, it will create 
multiple blank rows above the uppermost highlighted row.

     Delete Row(s)
Deletes the current row or highlighted multiple rows.

    Split Row
Splits the highlighted row into two rows. The precise location of the split is based on the 
location of the cursor.

    Merge Rows
Merges two or more adjacent, highlighted rows into one row.
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    Select Row
Allows you to type in a row number and change the focus to that row.

VTR Control 

These buttons are used to control VTRs -- play, pause, rewind and fast-forward at 
different speeds. If you use the buttons a couple of times, the meanings of the buttons 
will be clear. See “Chapter 8: Menus” for details.

Foot Pedal Controller
You can control (play, pause, fast forward, rewind etc.) a digital video file using vPedal 
foot  pedal  controller  (www.vPedal.com).  One  interesting  feature  of  the  vPedal  foot 
controller is the "release back" function which is available under VTR Control >> vPedal 
menu option. Release back time is user selectable.

Once the Play button on the VTR Control) is first clicked, you will be able to use the 
Pause function on the pedal to toggle between Play and Pause but the first time you play 
the video, you must start it manually by clicking the mouse on the Play button.

Misc Control
If you choose the Misc. Control, you will see a few additional position controls. Most 
of these buttons are available in the Ancillary Toolbar. 

http://www.vPedal.com/
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Time Code Buttons

 Time Code Display
Displays time code when you click on Time Code → Start Time Code option or click on 
the play  button. 

 In and Out Buttons
Two buttons next to the time code display: “In” and “Out”. The “In” tool button is a 
shortcut to the “Send Caption/Subtitle Line(s)” menu, and the “Out” tool button is a 
shortcut to the “Send Caption/Subtitle Erase” menu.

 Shot Changes – Previous and Next
Click on the arrow left and right button to move the previous and next shot changes after 
you get the shot change information from the digital video from the NLE > Find shot 
changes menu.

   Mark Time Code on Send Caption
When  this button  is  depressed  (lighter  colored)  it  means  that  whenever  you  hit  the 
keyboard  [+]  key,  you will  mark  a  time code (from the time code reader  or the PC 
System Timer)  as  well  as  send a  caption  or  subtitle.  If  you  are  sending  captions  or 
subtitles manually (not using time code) you should not have this button in the depressed 
position.

   Time Code Properties
Invokes the time code properties dialog box, which is also accessible from the menu.
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